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Answers to Common Questions

Following are the most common questions asked about Scan/US. Reviewing this list may save you a
phone call. Each question is followed by the word Answer in green text. Click this underlined word to
get the answer to the question.

General

1  Why do | need to use groups? Answer

2 Whatis a session file? Answer

3 How do | add more QuickPaths into my session files?  Answer

4 Why does Florida's label show up in the Gulf? Can | change its position permanently?  Answer
Study Areas

5 What's the difference between creating a study area and zooming in?  Answer

6 When | save my study areas, where is the saved file? Answer

7 How do | send a study area definition to a colleague?  Answer
Features

8 Why are there several counties and states layers listed in the "Features Directory"?  Answer

9 Why are MicroGrids not shown in some areas? Answer

10 Why does the Interstate Highways feature look so crude in small study areas? Answer

11 Why do some ZIP code centroids have so many different ZIP codes associated with them?
Answer

12 Why do some ZIP codes show zero population?  Answer

13 How do | change the way a feature looks so it has a different line style, fill colors, or symbols?
Answer

Features--Loading
14  Why do | get this "Loading into layer suspended at 16,000 objects" message? Answer

15 How do I load ZIP codes (or another feature) just for Orange county (or another area) when some
of the surrounding counties are also showing in my current map?  Answer

16 How do | control and change the automatic loading of features?  Answer
Objects
17 How do | select an object in the map? Answer

18 How do I find a particular object--among the hundreds that are currently displayed in my map?
Answer

19 Can I type in a ZIP code and have Scan/US go there directly?  Answer
Data

20 How do | get my own data into Scan/US for analysis? How can | link in a Customer Information
File? Answer

21 Can | import my existing cartography files into Scan/US?  Answer
22 How do | add those pound-signs (#) into my database keys in Excel?  Answer
23 Why do the Race numbers add up to more than 100%?  Answer

24 Why are there no figures for Am. Indians in the Key Demographics datalist when they are
included in the Basic Demographics datalist?  Answer






Using groups are important

Q: Why do | need to use groups?

At the simplest level, groups are Scan/US' way of doing multiple selections. Whenever you want to
perform a particular operation on more than one object at a time, you should use Scan/US' grouping
capability to select all those objects. You can use groups to differentiate one person's sales territory from
another, to highlight a particular area of the map by having it drawn differently, or to tell Scan/US to
analyze only a subset of the area currently shown in the map. Understanding groups is crucial to getting
the most out of Scan/US because it is central to many Scan/US command options.

See Also

About groups
Working with groups



Saving study areas

Q: How do | save what | currently have on the screen?

To come back to the same study area you currently have open, use the "Save Study Area..." command in
the Map menu. Saving a study area actually saves just the centroid coordinate and the extents of your
study area (i.e., 40 miles vertical by 60 miles horizontal centered at such and such latitude/longitude).

No other information, including views of the study area, is saved. This approach has the advantage of
requiring minimal additional storage space for saving your study areas. The disadvantage is that your
text annotations cannot be saved.

However, this means that when you open the saved study area in a subsequent session, it may not look
exactly the same as when you saved it. This is because Scan/US recreates a study area using a
feature's autoload instructions and display settings contained in the current session file (.GDS file). If
you want Scan/US to reload all of the map features you have in the map, you should modify the autoload
settings of all the currently loaded features. You do this by changing the "Autoload" and "Visibility..."
options in the Attributes menu of the "Features Directory." If you want Scan/US to reload features with
your changes to their display attributes, change them using the object and label buttons in the "Features
Directory." Then save your changes with the "Save Directory" command in the Features menu of the

'Features Directory."

A benefit of this approach is that your customized settings will apply to all similarly sized study areas you
create in the future. So if you always use MicroGrids and Census Tracts in study areas smaller than 50
miles, you can simply make that change once in your session file for them to always autoload together in
any study area smaller than 50 miles.

The other save commands in Scan/US allow you to save objects and session files. The "Save" command
saves created objects to an ASCI| file along with their display information. The "Copy Session" task
allows you to copy the current session file with a new file name. The session file determines the initial

contents of the "Features Directory” for a session and which data are automatically loaded for a feature.

See Also

Saving a study area

Changing the "Features Directory"
About session files

Study Area Manager... (Map menu



About session files

Q: What is a session file?

All files with a .GDS extension (such as SCANUS.GDS or TUTORIAL.GDS) are initialization files which
are used by Scan/US at startup along with SCANUS.INI. A session file contains five types of information:

Study area definitions

Feature declarations

Data file declarations

QuickPaths to your data directories

Recently used study areas list, maintained by Scan/US during a session.
Essentially, the session file controls:

. the amount of geography and data initially available for a session
. how your maps look
. the automatic loading of features and data into a study area

Scan/US allows you to have more than one session file so that you can customize each one for a specific
client, project, or task. For example, a consultant can create different session file for each client. Since
each session file can have its own QuickPath definitions, the consultant can store files for each client in
different directories and conveniently access them with the QuickPaths. A network administrator or PC
support person can customize session files to suit the needs and access rights of different users. The
possibilities are endless!

To create a session file, start by copying the current one with the "Copy Session" task in the Tasks menu.
Next, update the file. Except for the 'recently used study areas list' Scan/US maintains, you can update
the file with the following commands:

. Study area definitions with "Save Study Area..." and "Study Area Manager..."

. Feature declarations and autoloading with "Autoload" in the Attributes menu in the "Features
Directory"

. Feature display with the object and label buttons in the "Features Directory"

. Data file declarations with the "Autoload" option in the "Data Center"

. QuickPaths to your data directories with "Preferences..."

Except for "Features Directory...," each command automatically updates the session file. To save your
feature changes, choose "Save Directory" from the Features menu in the "Features Directory."

See Also

Working with map features
Changing the map display
Copying and modifying a session file



Adding QuickPaths to a session file

Q: How do | add more QuickPaths into my session files?

In this release of Scan/US, you will need to manually insert your QuickPath definitions into your session
files. To add a QuickPath, open up your session file (such as SCANUS.GDS) with NOTEPAD or another
TEXT editor (do not use word processors!). The session files follow the Windows .INI file format
conventions. You will find the [QuickPaths] section at the very beginning of the file. Just add your
QuickPath definitions to the end of the section. The format is simple:

Your caption= full DOS pathname of your directory

The QuickPaths are just a simple way of giving your own name to a specific DOS directory pathname.
So instead of "G:\DEPTS\FINANCE\USERS\MICHAEL", you can simply refer to it as "My data files".
This would look like:

My data files=G:\DEPTS\FINANCE\USERS\MICHAEL

The obvious benefits of this approach is that you can attach much more human names to your DOS
directories, and the ability to hop around directories and drives in a single, time-saving list!

See Also
Creating session files



Changing a label's position

Q: Why does Florida's label show up in the Gulf? Can | change its position permanently?

Florida's label shows up in the Gulf because labels are placed at the centroid of its object. Scan/US
calculates the centroid as the center of the smallest rectangle that can wholly contain the given object
("Least Square" method). That's why the labels for some objects appear outside the actual object.

You can move labels in Select--Label submode =

# but this move is valid only for the duration of your Scan/US session. If you quit and restart Scan/US,
the label will again show up in its original position.

See Also
Select--Label submode



Study area maps vs. Zoomed in maps

Q: What's the difference between creating a study area and zooming in?

Some users confuse the "New Study Area..." command with the "Zoom In" command. The "Zoom In"
command will only magnify what you already have in the current study area. For example, if you are at
the opening United States map and zoom in to the state of Wyoming, you will only see the state of
Wyoming in the zoom window. However, you are still in the United States study area.

If you add, remove, or change a feature while zoomed in, you're telling Scan/US to complete these
operations for the ENTIRE United States! Not just the zoomed in portion. For example, if you tried to
load MicroGrids while zoomed into Wyoming, you're telling Scan/US to load the feature for all of the
United States. And you would get an error message.

To work with a map of a specific region, what you really want to do is to frame a smaller area whose
boundaries meet your needs and use the "New Study Area" command to create a new map.

To tell the difference between a zoomed view and a study area, look for scroll bars--these are only
displayed in a zoom window

See Also

Frame--New Study Area submode
Frame--Zoom submode

Creating small study areas



Study area definitions

Q: When | save my study areas, where is the saved file?

When you save a study area, the study area definition is added to the [Study Areas] section of the current
session file (files with the .GDS extension, usually found in your \SCANUS home directory). The
contents of a study area are saved in .SSA files also in your home directory.

A study area definition consists of a descriptive caption (the name you've given to the study area), the
centroid coordinate and the extents of your study area (i.e., 40 miles vertical by 60 miles horizontal
centered at such and such latitude/longitude). It will look something like:

My study area=(41/08,73/22) V 40 m H 60 m

The contents of a study area are only saved when you choose the "Study area definition and map
features" or "All views of study area" options in the "Save Study Area" dialog.

See Also
About session files
Save Study Area... (Map menu

Study area naming conventions



Sending a study area definition to a colleague

Q: How do | send a study area definition to a colleague?

To send a study area definition to a colleague, simply copy the line that contains the definition, save it in a
text file, and send the text file to your colleague. Your colleague will then need to insert that line of text
into his/her session file. (Or, you can simply read off the line to your colleague over the phone & have
him/her type it in).

See Also
About session files



Feature file resolution

Q: Why are there several counties and states layers listed in the "Features Directory"?

The different county and state files listed in the "Features Directory" contain different levels of detail. The
numbers next to their names indicate the amount of detail in that file. For example, "Counties, 1:400T"
means that county file uses a scale of 1 to 400,000--1 inch equals 400,000 inches.

Scan/US automatically loads the less detailed files into large study areas, and as you drill down to smaller
and smaller study areas, swaps them for the more detailed files which are necessary for a better looking
presentation.

See Also
Features Directory... (Map menu
About features



Reading a grid feature map

Q: Why are MicroGrids not shown in some areas?

MicroGrids are shown only in areas where people live. For example, you won't find any MicroGrids
inside national forests, in industrial complexes, etc. The benefit you get is a more detailed picture of the
actual population distribution and location across the landscape.

See Also
Getting Started
"Reading a grid feature map"



Displaying Interstate Highways

Q: Why does the Interstate Highways feature look so crude in small study areas?

The Interstate Highways included in the base package is a 1:2,000,000 scale file--1 inch equals 2 million
inches. While it is suitable for use in large areas, we do not recommend using it in study areas below 50
miles. Due to the low resolution of this file, you will begin to see inaccurate representations in small
study areas, such as a mall showing up on the left side of the interstate instead of the right.

If you need higher resolution roads, add TIGER streets to the study area. You will get an accurate
presentation in study areas smaller than 10 miles.

See Also
Scan/US Geography



Geographic and Point ZIP codes

Q: Why do some ZIP code centroids have so many different ZIP codes associated with them?

There are essentially two different kinds of ZIP codes: "geographic ZIPs" and "point ZIPs."  Geographic
ZIPs are the ones that actually cover known territory, and have a residential population.

Point ZIPs identified by a "(b)" suffix indicate stations that have only P.O. boxes. The "(u)" suffix indicates
a zip code assigned to a single organization, or a single department within an organization.

Because point zips do not have a residential population, they are associated with the geographic ZIP
code in which they are found. As a result, multiple ZIP codes are attached to a single centroid.

Note A three-digit code between 0-300 indicates an area that was provided for total land cover but is 'not
a delivery area' (nada) designated by the Postal Service. These areas do not usually have a residential
population.



Point ZIP codes

Q: Why do some ZIP codes show zero population?

There are essentially two different kinds of ZIP Codes: "geographic ZIPs" and "point ZIPs."  Geographic
ZIPs are the ones that actually cover known territory, and have a residential population.

Point ZIPs identified by a "(b)" suffix indicate stations that have only P.O. boxes. The "(u)" suffix indicates
a zip code assigned to a single organization, or a single department within an organization.

Because point ZIPs do not actually cover residential territory, they have zero populations assigned to
them.

Note A three-digit code between 0-300 indicates an area that was provided for total land cover but is 'not
a delivery area' (nada) designated by the Postal Service. These areas do not usually have a residential
population.



Changing a feature's display attributes

Q: How do | change the way a feature looks so it has a different line style, fill colors, or
symbols?

When features are listed in the "New Map Features," "Map Features," and "Features Directory" dialogs,
they are preceded by object and label buttons which show a sample of their current display attributes.
Clicking the button opens a selector dialog in which you can choose new attributes.

@ Opens the "Area Fill Selector" dialog from which you can define borders, colors, and patterns for
area objects.

Opens the "Symbol Selector” dialog from which you can choose a symbol shape and its colors to

disilay location objects.

Opens the "Line Style Selector" dialog from which you can choose a line style, width, and color for
line objects.

If you modify a feature's display attributes, remember to check the feature order, and if necessary change
it, to ensure that the rendering of one feature does not obscure another.

Displays the "Label Style Selector" dialog from which you can define a format, font, and style for
object labels.

The window shade on either the object or label button tells Scan/US to hide all the objects or all
the labels on the feature layer. Shift-Click displays the shade; clicking on the shade redisplays the object
or label sample.

A feature's preset display attributes are shown in the "Features Directory." Modifying the features in the
directory changes the initial presentation of features in subsequent study areas created during a session.
Saving your changes in the directory updates the session (.GDS) file that was loaded at start-up and your
changes will be in effect for future sessions.

The "New Map Features" dialog lets you modify the features for a study area when it is created; the "Map
Features" dialog, after the study area is created.

See Also
Using selector dialogs
About session files
Features Directory... (Map menu

Map Features... (Map menu)

'New Map Features" dialog



Loading limits for objects

Q: Why do | get this "Loading into layer suspended at 16,000 objects” message?

You can load a maximum of 16,000 objects into any map layer in Scan/US. Most commonly, you will
encounter this maximum if you try to load MicroGrids or Block groups into a very large study area such as
an entire state or multi-state region.

Loading such geography into very large study areas provides too much detail and does not help you
examine the data. You should create a new, smaller study area to examine the data at a local level.

Some users get this message because they confuse creating a new study area with zooming into an
area. The "Zoom In" command only magnifies what you already have in the current study area. For
example, if you are at the opening United States map and zoom in to the state of Wyoming, you will only
see the state of Wyoming in the zoom window. However, you are still in the United States study area.

If you try to load MicroGrids while in this zoomed view, you're telling Scan/US to load it for the ENTIRE
United States! What you really want to do is to frame a smaller area and use the "New Study Area"
command to drill down to a more local level before using detailed data such as the MicroGrids.

To tell the difference between a zoomed view and a study area, look scroll bars--these are displayed only
in zoom windows. Scrolling is like using the window as a magnifying glass over the entire study area.

See Also
Adding features to a study area
Frame mode
Framing an area

Creating small study areas




Hiding objects

Q: How do I load ZIP codes (or another feature) just for Orange county (or another area) when
some of the surrounding counties are also showing in my current map?

When you load a feature, Scan/US retrieves ALL objects that fall within a study area. There is no way to
force it to do a partial retrieval.

You can, however, achieve the effect you desire by hiding the unwanted objects using the "Object
Manager." Just select all the unwanted objects, such as ZIP codes outside of Orange county, and turn
off their visibility settings.

Or, if you are interested in limiting your thematic analysis to a subset of the objects currently loaded, you
can group the objects of interest and select the "Analyze grouped objects in grouping" option in the "View
Variables" or "New Thematic" dialogs.

See Also
Select--Object submode
Object Manager... (Objects menu
View Variables... (Map menu

Turning object visibility on /off
Working with thematic views




Controlling feature autoloading

Q: How do | control and change the automatic loading of features?

Feature autoloading is controlled by the session file (.GDS files such as SCANUS.GDS). You can
change autoload settings with the "Autoload" and "Visibility..." options in the Features menu of the
"Features Directory."

To stop something from autoloading, toggle the "Autoload" setting off (no check mark). To make
something load automatically, toggle the "Autoload" setting on (check marked).

To make something load automatically only in a certain range, open the "Feature Visibility" dialog to set
the range (such as load only in study areas sized between 500 miles and 1000 miles).

See Also
About session files

Features menu in "Features Directory"”
"Feature Visibility" dialog



Selecting objects on the map

Q: How do | select an object in the map?

To select objects in the map, you must first activate Select--click the Select mode # button in the ToolPad.
The Select mode has three submodes which allow you to select either objects, labels or thematic
graphics. The Select--Object submode

= is always preselected when you enter the Select mode. Clicking once on an object selects it.

Tip Double-clicking on an object opens the "QuickLook" window to display data for that object.

When you have multiple layers in your map--such as MicroGrids, Zip codes, and tracts--only objects on
the active layer can be selected. You can activate the desired layer by choosing it from the window layer
box. Then, click on the desired object.

Or, you can traverse the layers by Shift-clicking in the same position on the map; the object on each
successive layer is selected. The name of the selected layer is shown in the window layer box. Once
you are on a desired layer, Ctrl-click to select objects that layer.

See Also

Select--Object submode
Working with objects



Finding an object

Q: How do I find a particular object--among the hundreds that are currently displayed in my map?

You can use the Find feature in "Object Manager™ to select the desired object in the list. Next, choose
the "Show Object" command in the Action menu to select the object in the map. However, if you have a
crowded map, you may have trouble seeing the selection rectangle around the object. In this case, you
can do one of the following:

. Use the "Assign to group” command from the Action menu to make it stand out.
If groups are present on the layer, the object is added to the active group unless you choose create
a new group before choosing the command.

. Zoom in.

See Also
Object Manager... (Objects menu
Finding an object on the map
Grouping by list selection
Zooming into the study area



Finding a zip code

Q: Canltype in a ZIP code and have Scan/US go there directly?
No, this feature will be added to a future release of Scan/US.

Scan/US is currently designed to operate on only the objects that fall within the currently defined study
area. Because ZIP codes are fairly detailed local-level data, you will need to create a study area smaller
than 100 miles before ZIP codes are autoloaded. Once they are loaded, you can use the Find feature in
"Object Manager" to select the ZIP code of interest.

See Also
Creating small study areas
Object Manager... (Objects menu
Finding an object on the map




Importing user data into Scan/US
Using your own data

Q: How do | get my own data into Scan/US for analysis? How can | link in a Customer
Information File?

The critical element in your data files is to have a unique object key for each record. This key
matches the data with the geographic object to which it pertains. You have object keys that match
your data to standard geography such as ZIP codes or census tracts. Or, you can have your own
unique keys that identify your store or branch office locations.

Object key format
Object keys have a required format in Scan/US.

. All object keys must be formatted as TEXT.
This means numeric keys, such as ZIP codes, must begin with a pound sign (#) if you are using
Excel or any other spreadsheet. In dBASE-compatible applications, you must define the object
key field as a TEXT or CHARACTER field.

. Census tract and block group IDs must be preceded by their state and county codes. These
make the IDs unique.
. For best performance, sort your database by object keys in ascending order.

For an example of object key format, see the STATES.XLS file in \SCANUS\USERDATA, or
GRDTUTOR.XLS or PCROUTES.XLS in the \SCANUS\TUTORIAL subdirectory.

Tip Scan/US also accepts an object caption, an optional, but longer and more descriptive name for
an object. The caption does not replace the key in your data files. Including captions helps you
identify and track data records.

Matching your data to standard geography
If you have data that match into an existing Scan/US geography (feature), all you have to do is match the
Scan/US object keys. To get a list of Scan/US keys, you've got these options:

. Use the starter files we've provided.
These files contain the object keys in the required format for different features. The keys are
stored in text (.CSV) files in the \SCANUS\STARTERS subdirectory. You can import these keys
into either Excel or a dBASE-compatible database. See About starter files for more information.

. In Scan/US, use the "Copy List..." or "Object Manager..." commands to select a list of objects and
copy their keys to the clipboard.

Matching your data to your geography

For your own geographic data, such as sales territories or service areas (i.e. polygon objects), you can
create your own keys. Again, all keys must be in TEXT format. The object key column must be the first
one in the file.

If you are importing locations, Scan/US allows you to create a point data file which contains both the
geographic description of each location and data for each one. Scan/US expects the columns or fields in
this order:

. Objects keys in a column named KEY.
The object key column must be the first one in the file unless you identify a different object key
column when loading the data.

. In point data files, location coordinates must be in decimal format in columns named LATITUDE
and LONGITUDE. See also Converting to decimal degrees.
These names are required for location coordinates; case does not matter.

. Data describing the locations in the remaining columns.
Note for Excel files You must select the entire range of cells containing column headings, object keys,
captions, and data and define them as a database. Not doing so will give you erratic results.



Note for ASCII files The column headings must be the first row in the file. Save the file with a .DAT
extension so Scan/US can load it.

Summarizing your data in Scan/US

When Scan/US summarizes data from the product database--for groups or data from other layers--it
accesses built-in information to accumulate each data item. For example, count variables are totaled,
and statistic variables averaged or weight-averaged. For user data files, Scan/US automatically totals all
variables.

If you want Scan/US to summarize your data, distinguishing between count and statistic variables, and
providing percent views or weighted averages, you must tell Scan/US how to handle each variable.

For Excel files, you can add the necessary information to a column heading. For dBASE and delimited
ASCII text files, you must create a datalist description file. See the following topics:

Structure of Excel data item names
Datalist Description File Structure

Examining your data

You can look at your data in two ways: either locationally, or aggregated into an existing geography.
For example, if your data file contains customer addresses, you can display each customer as point on
the map--assuming you have their latitude/longitude coordinates. (See Scan/US Geocoder for more
information)

Or, you can aggregate your customer data and view it as "in this ZIP code, we have 567 customers, and
they accounted for $xxxx dollars in sales." Looking at your data in this aggregated view can give you
more information when you have a large database of customers. Remember, one of the key advantages
of visual data analysis is in data reduction. By reducing clutter, you can more easily spot the patterns
and anomalies hiding in your data. When in doubt, opt for data aggregation first.

See Also
Using your own data
Preparing Excel files
Preparing dBASE files
Preparing delimited ASCII text files
About geocoding



Importing user feature files

Q: Can |l import my existing cartography files into Scan/US?

Yes, if you export them into one of our ASCII formats. For location features, they need to be put into
our .LOC format. For polygons, you need to put them into our .PGN format. Polylines need to be in
our .PLN format. Ring objects can be put into our .BUF format.

See Also
Using your own data

Reference Manual
"Appendix A: File formats"



Adding pound signs to Excel keys

Q: How do | add those pound signs (#) into my database keys in Excel?
The following steps show you an easy way:
1 Create another blank column next to the key column.
2 Create a formula in the cell next to the first cell containing your keys: ="#"&CELLREF.
Be sure to substitute the actual cell reference for the string CELLREF (such as B2).
3 From the Edit menu, choose "Fill Down" to propagate the formula down the column.

4 Copy all cells containing the newly created keys and paste them into the original key column.--
From the Edit menu, choose "Paste Special" with the "Values only" option selected.

5 Delete the column containing the formulas.
Deleting the formulas creates a smaller file, and is therefore faster to load.



Race vs. Ethnicity

Q: Why do the Race numbers add up to more than 100%?

Actually, they don't. Do not confuse the variable Hispanic with Race. The Census Bureau does not put
Hispanic into the Race category. That's why it doesn't appear in the Pop. by Race array in Scan/US.
The Hispanic designation was a separate question on the Census questionnaire. If you are adding up
the percents shown in Scan/US for the Race category, do not include the Hispanic numbers since this is
equivalent to adding some people twice. For a more detailed explanation, please refer to pages 11 and
12 of the User's Guide.

See Also
User's Guide
"Using Demographics for Business Success"



Finding Am. Indians in the Key Demographics datalist

Q: Why are there no figures for Am. Indians in the Key Demographics datalist when they are
included in the Basic Demographics datalist?

In this abbreviated data file, we chose to aggregate the Am. Indian numbers into the Other category.



Product Support
Scan/US Bulletin Board System

Scan/US, Inc. offers a variety of support options for registered Scan/US users. Please be sure to send in
your registration card to access support services. (Note: the working model is a demo version of
Scan/US and is not supported.)

When you have a question about Scan/US, you can find answers in:

the Answers to Common Questions

the on-line information topics

the README files that came with your product disks

the "User's Guide" and "Reference Manual”

If you cannot find the answer, contact Scan/US Technical Support at (310) 820-2531. You receive free
support for 90 days starting with your first call. Please have your serial number ready.

You can receive extended service and support, available as a 12-month paid subscription, after the 90-
day period. To order the support plan that best meets your needs and budget, please call Customer
Service at (800) 272-2687 from 6:00 A.M. to 6:00 P.M. (Pacific time) Monday through Friday.

Priority Support--300.00/year

. Toll free, 800 number access to support services

. Priority access to support technicians

. 40 percent discount off the price of major new upgrades of Scan/US software released during the
support contract period

. Free minor software updates, sent automatically

Basic Support--150.00/year

. Regular toll number (1-310-820-2531) access to support services

. 25 percent discount off the price of major new upgrades of Scan/US software released during the

support contract period
. Free minor software updates, sent upon request



Product Database

See also Scan/US Third-Party Data
To order or get more information, please call 1-800-272-2687.

Scan/US Geocoder NEW!
Fact Sheet
Scan/US Geocoder Licenses

Scan/US Geography

Geography
Guide to Scan/US Regions and TCAs

Scan/US Data Products
"94/'99 Census Update

'94/'99 General Census Update
'94/'99 Household Income by Age of Householder

'93 Consumer Spending (CS) Potential

Overview
CS1_ Grocery--Food CS8 Sporting Goods
CS2 Grocery--General Merchandise CS9 Food Away from Home
CS3 Clothing & Footwear CS10 Entertainment
CS4 Home Furnishings/Equipment CS11_Personal Care Products & Services
CS5 Home Electronics CS12 Pet Services & Products
CS6 _Auto Aftermarket CS13 Miscellaneous Retail Services

CS7 Specialty Store Merchandise

'93 Business Data
'93 Retail Stores and Sales

93 Employees, Establishments, and Payroll

93 Establishments by Size and Industry

93 Establishments by Type of Business

93 Floor Space by Type of Business
Daytime Maketplace NEW!

'90 Detailed Census Data

'90 Race, Ancestry, Language
'90 Housing Stock

90 Work Status and Employment

90 Household Income by Age of Householder
'90 Population by Sex, by Age

'90 Census Data

90 Key Demographics
‘90 Income and Education

'93 Basic Demographics

1980 Census Benchmark NEW!



Scan/US Third-Party Data

Product Database
To order or get more information, please call 1-800-272-2687.

We've carefully selected only the best of brand-name data products for use with Scan/US. Combined
with our demographic, consumer, and business data, you can make Scan/US your resource center for
data.

CACI Marketing Systems

90 Census Demographics
'94/'99 Demographic Update

Claritas
PRIZM 62 lifestyle clusters

Demographics USA from Market Statistics
City Edition
County Edition
Z|P Edition



The display window

About windows
Parts of the Scan/US screen

Activating a window
Renaming a window

Closing a window

Hiding and unhiding windows
Tiling windows



About windows

Each study area map is created in its own window. The window is preset to be maximized unless you
clear the "Maximize" option in the "New Study Area" dialog. When a window is not maximized, you can
move and resize it like any other window.

A view created with the "New Thematic..." command is also shown in its own window. The window size
is the same as its associated study area window.

A window can be closed like any other. Note that closing a study area window automatically closes all its
associated view windows.

Operations in Scan/US apply to the active window. When multiple windows are open, you can:

Activate a window by choosing its hame from the bottom of the Window menu.

Backup from the current study area window to its parent study area window.

Limit the number of available windows by closing or hiding them.
Tile windows to display them next to each other.




Parts of the Scan/US screen

Map 2
3 4
5 B
1 Title bar Displays the window name. Also displays help messages when the "HelpLine"

command is toggled on.

2 Menu bar Select commands from the different menus.

Status bar Displays system messages from Scan/US. Most often you will see the latitude and
longitude coordinates of the location the cursor is pointing to.

Window layer box Displays the current layer on the map. Activate another layer by choosing it
from the list.

Toolpad These buttons activate the cursor with different functions or modes. Each mode allows
you to perform a different set of operations on the map such as selecting, creating or grouping
objects.

Display area Displays the map in the active window.



Activating a window

To activate a window, do one of the following:

. Choose its name from the bottom of the Window menu.
If the windows are not maximized, click on the desired window.
. To activate the parent study area window, choose "Backup" from the window menu.



Renaming a window

Follow these steps to rename a study area or view window.
1 From the Map menu, choose "Map Features...."
2 Click inside the map name text box to slect the current name.
3 Type a new name and press Enter.

See Also

Study area naming conventions
Thematic view naming conventions
Map Features... (Map menu)



Closing a window

Double-click on its control icon |E|
Note Closing a study area window automatically closes all its associated view windows.



Hiding and unhiding windows
1 From the Window menu, choose "Hide..." or "Unhide..."

. Optional: If necessary, filter the list of window names.
2 Click on the desired window names.
3 Click "OK."



Tiling windows

To tile all windows
Choose "Tile All" from the Window menu.

To tile selected windows
1 Choose "Tile..." from the Window menu

. Optional: If necessary, filter the list of window names.
2 Click on the desired window names.
3 Click "OK."



Working with study areas
For more detailed information, please see About Study Areas

Using the framing rectangle
Zooming into the study area

Creating study areas

Framing an area

Selecting an object to create a study area
Creating a study area of a zoomed-in view
Using a group to create a study area
Using an address to create a study area
Creating small study areas

Managing study areas

Saving a study area

Loading a study area

Autolooading a study area

Autoloading a study area as the opening map
Deleting a study area



About study areas
Working with study areas

When you first start Scan/US, the preset opening map of the United States is displayed, showing the
locations of major cities. The 48 continental states and Washington, D.C. comprise the largest study
area within which you can analyze data. A study area defines the boundaries of the geographic area
available for analysis and is anchored at a latitude and longitude coordinate at its center. In the opening
map, the entire continental United States is the study area.

Hawaii, listed at the bottom of the Map menu, is also provided as study areas. The continental United
States and Hawaii are zone maps.--You can define study areas within their boundaries, but no other study
area can contain them. Other study areas opened at start-up are listed at the bottom of the Window
menu.

Most likely you will create your own study areas that meet the range of your data. For example, if all
your sales offices were in California, you would need a study area that contained only the state of
California. Or, if you produced the yellow pages for the phone company, your study area would contain
your clients neighborhoods within a city.

You can create a study area by framing its boundaries in Frame--New Study Area submode, or by
selecting an object then choosing the "New Study Area..." command in the Map menu. When you select
an object, the study area includes a preset buffer of three miles around the object. You may the change

the buffer size to include more or less area as desired in the "Features Directory."

You can also create study areas of object definitions copied to the clipboard with the Copy Objects...
command or with Scan/US Geocoder.

From each study area you can create one or more smaller ones. The number of study areas you can
open during a Scan/US session is limited only by the amount of memory on your computer.  You can
also create thematic views, maps which analyze the data in the study area, with the "View Variables..."
and "New Thematic..." commands. All the views of a study area remain tied to it. Closing a study area
automatically closes all its view windows.

You can save a study area and its views with the "Save Study Area..." command. The Study Area
Manager... command lets you reload a previously saved study area, define a different opening map, and
tell Scan/US which study areas to automatically load at start-up in future sessions. You can also print a
study area map and its views using the "QuickPrint" and "Print..." commands.




Using the framing rectangle

To move the framing rectangle
Moving the framing rectangle is just like moving a window.

1 Position the cursor inside the framing rectangle.
2 Drag the cursor from inside the framing rectangle to a new position.

To resize the framing rectangle
Resizing the framing rectangle is just like stretching a window.

1 Position the cursor on any edge or corner of the framing rectangle.
2 Drag the edge or corner to its new position.

To change the framing rectangle's display attributes
You can change the rectangle's color and width.

1 Activate Frame mode ».

2 Click the right mouse button to display a popup toolbox.

3 Click a down arrow button to display a selection of colors or widths (in pixels)
4 Choose the desired color or width.

See Also

Working with study areas
Framing an area
Zooming into the study area



Zooming into the study area

Follow these steps to get a close-up look at a portion of the current map. You are not creating a new
study area.

1 Activate Frame--Zoom In submode.
[E[E:

2 Position the cursor at the center of interest and drag outward to a position that approximates the
desired boundaries.

A framing rectangle is displayed showing you the boundaries. The vertical and horizontal extents
are displayed in the status bar as you draw the rectangle.

3 Release the cursor button to finish framing.
Note To redraw the boundaries, click outside the framing rectangle to remove it, and start again.
4 Double-click inside the framing rectangle

The selected area is magnified. Note the scroll bars in the zoom window. When you scroll, the
window is like a magnifying glass that you are looking through and can move to anywhere within the
current map.

. Optional: Scroll until the desired area is in view, or zoom in further, repeating the previous steps.
Tip If you choose "Save Study Area..." while zoomed in, the entire study area-- along with the zoom
window--is saved.

See Also

Working with study areas
Using the framing rectangle
Creating a study area of a zoomed-in view



Framing an area
1 Activate Frame--New Study Area submode.

Fli=

2 Position the cursor at the center of interest and drag outward to a position that approximates the
desired boundaries.

A framing rectangle is displayed showing you the boundaries. The vertical and horizontal extents
are displayed in the status bar as you draw the rectangle.

3 Release the cursor button to finish framing.

Note To redraw the boundaries, click outside the framing rectangle to remove it, and start again.
4 Double-click inside the framing rectangle

5 In the "New Study Area" dialog, activate the "Frame" button.

5 Click "OK."

See Also
Working with study areas
Using the framing rectangle
New Study Area... (Map menu)




Selecting an object to create a study area

The following procedure shows you one method for selecting objects. See "Selecting an object" for other
methods.

1 Activate Select--Object submode‘ ﬁj

2 Activate the layer containing the object.
From the windows layer list box, choose the desired feature.

3 Select the object by clicking on it.
4 From the Map menu, choose "New Study Area...."

=
5 Activate the "Object" button I==2

6 Click "OK" in the dialog.
The new study area is created. It includes a three-mile buffer surrounding the rectangle which
highlighted the object.

See Also
Help
Framing an area
Selecting an object
Working with study areas

User's Guide
"Creating study areas"



Creating a study area of a zoomed-in view
1 Zoom into a study area. See Zooming into the study area
2 From the Map menu, choose "New Study Area..."

3 Activate the "Copy" button @

4 Click "OK" in the dialog.
Only the zoomed-in portion is used to create the new study area. Note the absence of the zoom

window in the new study area.

See Also
Help
Framing an area

Selecting an object

New Study Area vs. Zoom modes
Working with study areas




Using a group to create a study area

1 Create a group. See Working with groups

2 From the Objects menu, choose "Copy Objects..."
3 Choose the "Objects in groups" option and select the group from the drop-down list.
4 From the Map menu, choose "New Study Area..."

&
5 Activate the "Parcel" button =2
6 Click "OK."
See Also
Help

Working with study areas

Working with groups
Copy Objects... (Objects menu

New Study Area... (Map menu



Using an address to create a study area

This procedure uses the "QuickFind" capability in Scan/US Geocoder in which the coordinates assigned
to a single address are automatically copied to the clipboard.

1 In Scan/US Geocoder, use "QuickFind" to geocode the desired address.
2 Switch to Scan/US.

3 From the Map menu, choose "New Study Area..."

4 Activate the "Parcel" button =

5 Click "OK."
See Also
Help

Working with study areas
New Study Area... (Map menu

Scan/US Geocoder On-line Information
"QuickFind" dialog
"Geocoding a single address and seeing it in Scan/US"



Creating small study areas

Here are some tips for creating small study areas:

. You can draw a framing rectangle of any size to create a study area. If the framing rectangle is
so small you cannot double-click inside it to open the New Study Area dialog, choose the New Study
Area... command from the Map menu.

. In a large study area, such as the United States, drawing the tiniest rectangle will have extents of
20 to 40 miles. To create even smaller study areas, you can zoom in before defining the study area
boundaries.

. In the "New Study Area" dialog, enter the desired extents.

See Also
Help
Zooming into the study area
Framing an area
Selecting an object to create a study area
Working with study areas

New Study Area vs. Zoom
New Study Area... (Map menu)

User's Guide
"Creating study areas"



Saving a study area
1 From the Map menu, choose "Save Study Area...."
2 Optional: Rename the study area.
3 Select the desired save option.
Tip "All views of study area" saves the most information.
4 Click "OK." to update the session file and close the dialog.

See Also

Loading a study area
Save Study Area... (Map menu
Study area naming conventions

Working with study areas
About session files



Loading a study area

You can load a previously saved study area definition. A loaded study area can be activated by choosing
its name from the bottom of the Window menu.

1 From the Map menu, choose "Study Area Manager...."

The absence of an icon indicates a study area definition that has not been loaded into a window.
2 Select a study area name.
3 Click the "Load" button.

The study area is loaded into its own window and the E=l icon precedes the study area name.

4 Click "Close" to update the session file and close the dialog.

See Also

Saving a study area

Working with study areas
Study Area Manager... (Map menu

About session files



Autoloading a study area

You can tell Scan/US which study areas to load into their own windows at start-up.
To autoload a saved study area
1 From the Map menu, choose "Study Area Manager...."
The absence of an icon indicates a study area definition that has not been loaded into a window.
2 Select a study area name.
3 Click the "Autoload" option.

The autoload B icon precedes the study area name. The icon is grayed if the study area has not
been loaded into a window.

4 Click "Close" to update the session file and close the dialog.
5 Restart Scan/US.
To autoload a study area that has not been saved
1 From the bottom of the Window menu, choose the desired study area.
2 From the Map menu, choose "Save Study Area..."
3 Click the "Autoload" option.

. Optional: Rename the study area.
4 Click "OK" to save your entries.

5 Restart Scan/US.

See Also

Autoloading a study area as the opening map

Working with study areas
Study Area Manager... (Map menu

Save Study Area... (Map menu)
About session files




Autoloading a study area as the opening map

Only saved study area definition can be defined as the opening map.
1 From the Map menu, choose "Study Area Manager...."
2 Select a study area name.
3 Click the "First Map" option.

The Bl icon precedes the study area name. The icon is grayed if the study area has not been
loaded into a window.
4 Click "Close" to update the session file and close the dialog.

5 Restart Scan/US.

See Also

Saving a study area

Working with study areas
Study Area Manager... (Map menu

About session files



Deleting a study area

Only saved study area definition can be deleted.
1 From the Map menu, choose "Study Area Manager...."
2 Select a study area name.
3 Click the "Delete" button.
Ared line is drawn through the name. Click the name to unmark it.
4 Click "Close" to update the session file and close the dialog.

Note If you delete a study area currently loaded into a window, it remains open until you close it.
Note You cannot delete an opening map until you have selected another map as the opening map.

See Also

Saving a study area
Autoloading a study area as the opening map

Working with study areas
Study Area Manager... (Map menu

About session files






Working with map features

For detailed information about features, please read About Features
To change a feature's display attributes, please see Changing the map display

Adding features to a study area

Changing the layer order of features

Hiding features in a study area

Deleting features in a study area

Renaming features in a study area

Changing features in the "Features Directory"
Adding features to the "Features Directory"
Automatically loading features



About features

Working with map features

Working with study areas
Features Directory... (Map menu

Map Features... (Map menu)
New Study Area... (Map menu)

Features are representations of the geography in a study area, for example, states, counties, or census
tracts. Objects are instances of a feature, for example, California is an object represented in the states
feature, and Cheap Seats Video is an object in a user-defined video competitors feature.

Scan/US provides four representations to display a feature and its objects:

. Polygons, any space having boundaries, can display features such as states, counties, or census
tracts.

. Lines display roads or highways and indicate their direction.

. Points indicate locations like hospitals, shopping malls, or cities.

. Buffer areas, a feature set devoted to editable objects you create, such as ring areas, corridors,

or grid areas. Currently, only ring areas are available.

For file formats, see Appendix A in your Reference Manual.
Three directories for features

When you create a study area, you will notice that:

. Features are automatically loaded.
. Features have preset display attributes such as fills, borders, symbols, and labels.
. Features are ordered so that the display attributes of one does not obscure another in the map.

Scan/US has preset the features set, their display attributes, and order so that you immediately have an
easy-to-read map that is ready for analysis. You can modify the preset values in three dialogs--"Features
Directory," "New Map Features," and "Map Features."

The preset values are shown in the "Features Directory." Modifying the features in the directory changes
the initial presentation of features in subsequent study areas created during a session. Saving your
changes in the directory updates the session (.GDS) file that was loaded at start-up and your changes will
be in effect for future sessions.

The "New Map Features" dialog lets you modify the features for a study area when it is created; the "Map
Features" dialog, after the study area is created.

In each of these dialogs you can add , remove, and hide features, and change their display attributes and
order.

Ordering feature layers
When you create a study area, features are automatically loaded according to the size of the study area
and in the order of the features list in the "Features Directory."

Scan/US loads each feature in the study area onto a separate layer on the map. Alayer is like a
transparency that contains all the objects of a feature. Scan/US draws the layers according to the
following rule: The feature at the bottom of the list in the "Map Features" (or "New Map Features") dialog
is drawn first so it becomes the bottom layer on the map; the top feature on the list becomes the top layer
on the map.

Keep this rule in mind when modifying the display attributes of features or changing their order. For
example, if objects on the Counties layer are drawn first with a border, and next the States layer is drawn
with a color fill, the objects on the Counties layer would not be visible on the map. They are all covered
by the States objects. By changing the order so that the States layer is drawn first and next the Counties
layer, you would be able to see the objects of both layers in the map. Or, instead of changing layer order,
changing the display attributes of the States layer so that its objects are shown only with borders is
another way to see objects of both layers on the map.

Because layer ordering and the display attributes both control the display of features on the map, a



recommended method is to first add all the features to the list, next review the rendering to see if the
objects on one layer might obscure another, then change either the display attributes or the layer order so
that all objects are visible on the map.



Adding feature layers

When you click the "Add features" button in the "New Map Features" dialog or "Map Features" dialog, the
"Features Directory" dialog is opened for you to select additional features for the study area. If the
desired feature is not in the directory, you can add the feature to the directory, then add the feature to the
study area.

To aid your selection of features, Scan/US indicates with two visibility icons [

(@] whether or not a feature is recommended for loading within the size of the current study area. Each
feature has a preset visibility range for its objects and labels. When you open the "Features Directory,"
each range is compared to the vertical extent of the current study area. If the vertical extent is within
range, an indicator is present. The absence of an indicator means the vertical extent is out of range.
Generally, the larger the study area, the less detailed features are visible. For example, a study area of a
city would easily show its census tracts and zip centroids, or grid data, but in a study area of several
states, these features may provide too much detail. Scan/US is shipped with preset visibility ranges for
all its features, however, you can change the visibility range of any feature by modifying its feature
definition in the "Features Directory."

You can add as many features to the study area as youd like, limited only by the amount of memory on
your computer. Adding features is also limited to 16,000 objects on a layer. If you have chosen a
feature that exceeds this limit, Scan/US warns you.

Note The absence of visibility indicators does not prevent you from adding a feature to a study area but
lets you know that displaying the feature may exceed the 16,000 limit or provide too much detail. For
example, Counties is displayed without indicators in the features directory for the United States. But
when you add Counties to the map, they are easily displayed and may be helpful for a data analysis.



Adding features to a study area

1 From the Map menu, select "Map Features..."

2 Click on "Add Features" to display the "Features Directory".
3 Click on the desired feature name.

4 Do one of the following:

Click this To position the feature
button
"Add" Adds the feature to the top of the features list

in the "Map Features" dialog.

"Insert" Inserts the feature above the one currently
selected in the "Map Features" dialog.

Shortcut: Drag-and-drop the feature from the "Features Directory” to the map, or to the Map
Features" dialog.

. Optional: Repeat steps 3 and 4 for to add more features

5 Click "Update" in the "Map Features" dialog.
Tip You can drag-and-drop features from window to window when one or more windows are tiled
and Select--Object submode is active.

See Also
Help
Working with map features
Features Directory... (Map menu

Adding features to the "Features Directory"”

User's Guide
"Working with map features"



Changing layer order in a study area
1 From the Map menu, choose "Map Features..."
2 Click on a feature and drag to its new position.

If you dragged upward, the selected feature will precede the feature it covers; if you dragged
downward, the selected feature will follow it.

. Optional: Repeat step 2 until the layers are in the desired order.
3 Click "Update" in the dialog.
See Also

Help

Working with map features
Map Features... (Map menu)

User's Guide
"Working with map features"



Hiding features in a study area

1 From the Map menu, choose "Map Features..."

2 Find the feature you want hidden.

3 Shift-Click on the object button or the label button without a window shade.
A shade is shown to indicate hiding.
Note Clicking on the shade removes it.

4 Click "Update" in the dialog.

See Also
Help
Working with map features
Map Features... (Map menu)
Changing the map display

User's Guide
"Working with map features"



Deleting features in a study area

1 From the Map menu, choose "Map Features..."

2 Click the right mouse button on the feature you want to delete.
A popup of commands is displayed.

3 Click on "Delete Feature" in the popup.

4 Click "Update" to redraw the map without the feature.

See Also
Help
Working with map features
Map Features... (Map menu)
Changing the map display

User's Guide
"Working with map features"



Renaming features in a study area

1 From the Map menu, choose "Map Features..."

2 Click the right mouse button on the feature you want to rename.
A popup of commands is displayed.

3 Click on "Rename" in the popup.

4 |n the edit box, type a new name and click the 'okay’ button.

See Also
Help
Working with map features
Map Features... (Map menu)
Changing the map display

User's Guide
"Working with map features"



Changing the "Features Directory™

To open the "Features Directory,” do one of the following:

. Choose "Features Directory..." from the Map menu.

. Click the "Add features" button in the "New Map Features" dialog when creating a study area
. Click the "Add features" button in the "Map Features" dialog after the study area has been
created.

To change layer order
Shift-Click to select a feature and drag-and-drop to its new position.

To delete a feature
1 Select a feature by clicking on it.

2 Choose "Delete Feature" from the Features menu.
3 Confirm or cancel the deletion.

To rename a feature
1 Select a feature by clicking on it.

2 Choose "Rename Feature" from the Attributes menu.
3 In the edit box, type the new name and click the 'okay’ # button.

To save the directory
Choose "Save Directory" from the Features menu.

See Also
Help

Working with map features
Features Directory... (Map menu

User's Guide
"Working with map features"



Adding features to the "Features" Directory"

To open the "Features Directory,” do one of the following:

. Choose "Features Directory..." from the Map menu.

. When creating a study area, click the "Add features" button in the "New Map Features" dialog.
. After the study area has been created, click the "Add features" button in the "Map Features"
dialog.

To add a feature to the directory
1 From the Features menu, choose "Add Feature..."

Select the directory containing the desired feature file.

Select a file type to filter the list.

Select the file name from the list.

Enter a feature caption.

For user features only, select the name of the column or field containing the object keys.
For user features only, select the name of the column or field containing the object captions.
Click "OK."

The "Features Directory" lists the new feature by its caption. User features are shown with the edit
[& icon next to them.
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Note While a point data file is loaded as a feature, its attribute data cannot be loaded onto other layers.

See Also
QuickPaths vs. Directories
Working with map features

Working with study areas
Features Directory... (Map menu)




Automatically loading features
1 Add the desired feature to the "Features Directory."

See Adding features to the "Features" Directory"
2 Select the feature in the directory

. Optional: From the Attributes menu, choose "Visibility..." to define the size of the study area into
which the feature will be loaded.
If you do not define a visibility range, the feature will be autoloaded into all study areas.

3 From the Attributes menu, choose "Autoload."

Tip Choosing "Save Directory" from the Features menu updates the session file so that the feature
is autoloaded in future sessions.

Note While a point data file is loaded as a feature, its attribute data cannot be loaded onto other
layers.

See Also
"Feature Visibility" dialog
Attributes menu in "Features Directory”
Features menu in "Features Directory"”
Working with map features



Working with objects
For detailed information on objects, please see About objects.

Selecting an object

Finding an object on the map
Turning object visibility on /off
Saving created objects

Creating objects
Creating a new layer
Creating location objects
Creating line objects
Creating polygon objects
Creating area objects
Creating sectors

Editing objects
Editing a location object
Editing a line object
Editing a polygon object
Editing a ring area
Editing a sector



About objects
Working with objects

An object is an instance of a feature on a layer, for example, California on the states layer, and Dallas on
the Places 500T+ layer. An objects attributes include:

A rendering which represents it as an polygon, line, point, or ring area on a layer.

An object key, a unique identifier such as 06 for California on the states layer.

An object caption, a text string often used as a label such as California.

A thematic graphic, indicating an analysis of the objects data in a thematic view.

Changing a features rendering lets you modify attributes for an entire class of objects; changing a groups
rendering, for a subset of objects. For one or more individual objects, you can toggle the visibility of the
attributes.

Objects also have data which you can analyze in a thematic view or view in "QuickLook."

For more information, see the User's Guide--on changing display attributes, see "Changing the map
display;" analyzing data, see "Creating thematic views;" viewing data, see "Working with data."

Controlling object visibility

Toggling the visibility for one or more selected objects allows you to focus an analysis on a particular set
of objects. For example, to clearly present your data on a map, you can focus attention on points of
particular interest; turn off the object rendering and labels outside the area of interest, or hide thematic
charts to highlight data that needs emphasis.

You control visibility by choosing "Object Manager..." from the Objects menu. A list of all objects on the
current layer is displayed; preceding each object name are three icons, one for each visibility
characteristic:

. Indicates object visibility
. Indicates label visibility
i Indicates thematic chart visibility

You can hide an objects rendering or label, or both at the same time. However, a thematic chart can be
shown only when its object is also visible.

The Select menu in the "Object Manager" gives you different options for selecting objects in the list. The
Action menu provides options to locate an object on the map, assign objects to a group when Group
mode is active, and to copy the keys and captions of selected objects to the clipboard.

Note When objects or labels are turned off in the "Object Manager," selecting "Show Labels" or "Show
Objects" from the layer popup in the "Map Features" dialog does not display them. Object visibility
settings override layer visibility settings.

Selecting objects

You can select an object on the map using the Toolpad, in Select--Object and Group--By Selection
submodes. Or, if you know an objects name, but not its location, select its name from a list in the "Object
Manager."

When an object is selected, you can complete various operations in Scan/US.--All three methods allow
you to zoom in, create a study area of the selected object, copy the object, or view its data in
"QuickLook." But you can also group the object selected in the "Object Manager," and in "Group--By
Selection submode.

Creating objects

You can create objects of every type--polygons, lines, points, and ring areas, each type on its own
'editable' layer. The objects you create can be rendered and analyzed like other features in the
Scan/US product database. For example, you can plot your competitors locations then analyze their
trade areas.

Unlike the Scan/US features, created objects can also be edited. For example, you can change the
shape of a line or polygon object, or move and resize a ring area. You can save created objects with the



"Save" or "Save As..." command, then reload them as a feature in future sessions. You can also load
data for the feature and analyze it in a thematic view.

Copying objects

Copying the objects keys and captions is a helpful way to start data files or to prepare existing files that
can be loaded into Scan/US. Scan/US requires that data files have object keys to match to objects on a
feature so that the data can be loaded and read. You can copy an object list using the "Object
Manager..." and "Copy List" commands. See Using Your Own Data section for more information.

You can also copy objects to paste them onto an editable layer, or to group other objects.

Grouping objects

You can classify the objects on a layer into subsets. Each subset/group is rendered the same way and

can be treated as single unit. For example, you can create groups that reflect a division of territories, or
group all the counties within Texas to limit the analysis to those counties. For a complete discussion of

groups and grouping methods, see "Working with groups.”



Selecting an object

You can select an object on the map using Select--Object and Group--By Selection submodes. A
selected object is highlighted by a gray rectangle, and its layer becomes the active one.

To select an object in Select--Object submode
1 Activate Select--Object submode.

2 Click on an object on the active layer.
OR

Shift-Click to select an object in the same position on each successive layer. Ctrl-Click selects
additional objects in other positions on a successive layer.

To select an object in Group--By Selection submode
1 Activate Group--By Selection submode.
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2 Click on an object on the active layer.

To select an object using "Object Manager"
Sometimes an object is so small it's easier to select its name from a list first.

1 Activate the desired layer from the window's layer box.

3 | Places 10-50T |*]

2 From the Objects menu, choose "Object Manager..."

3 Select the object's name from the list.
4 From the Action menu in the dialog, choose "Show Object."
A gray rectangle highlights the object.

Tip If you cannot see the object on the map, choose "Zoom In" from the Map menu. Or, choose
"Assign to Group" from the Action menu instead.

See Also
Working with objects
Select--Object submode

Group--By Selection submode
Object Manager... (Objects menu

Window layer box




Finding an object on the map

When you dont know an objects location, the "Object Manager" can help you find it and select it.
1 Activate the desired layer from the window's layer list box.

2 From the Objects menu, choose "Object Manager..."
3 Select the objects name from the list.
4 From the Action menu in the dialog, choose "Show Object."
A gray rectangle highlights the object.
Tip If you cannot see the object on the map, choose "Zoom In" from the Map menu.

To find objects in the list
1 In the "Find" text box, type an entry and press Enter.

For example, you can enter Ar on the states layer to locate Arizona and Arkansas. The first match
found is outlined in red. The "Find Next" button is activated if there are more matching names.

2 Click the "Find Next" E button to view all the matching names.

Each matching name is highlighted in red.
To find multiple objects on the map
1 Shift-Click to select multiple objects in sequence; Ctrl-Click to select multiple objects not in
sequence.

2 From the Groups menu, choose "New Group...."

3 From the Action menu in the "Object Manager," choose "Assign to Group."
The selected objects are grouped and shown in a different rendering.

Tip If you do not need to retain the group, remove it in the "Group Manager."

See Also

Working with objects
Window layer box
Object Manager... (Objects menu

New Group... (Groups menu)

Group Manager... (Groups menu



Turning object visibility on /off

1 Activate the desired layer from the window's layer list box.

2 From the Objects menu, choose "Object Manager..."
3 Select the object name(s) from the list:

Click to select a single object; Shift-Click to select multiple objects in sequence; Ctrl-Click to select
multiple objects not in sequence.

You can also choose an option from the Select menu.

3 Click the @ button to turn off the visibility, or
# {0 turn on visibility.
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See Also
Working with objects
Window layer box
Object Manager... (Objects menu

About objects




Saving created objects

To save the objects for the first time
1 From the Objects menu, choose "Save As..."

2 Choose a directory to store the file.
3 Type a name for the file.
4 Click "OK."

To save changes to existing objects
From the Objects menu, choose "Save."

To save changes to existing objects in a new file
Like saving objects for the first time, except enter a new file name.

See Also

Working with objects
QuickPaths vs. Directories



Creating objects



Creating a new layer
1 From the Objects menu, choose "New Layer..." and the desired object type option.
OR
Activate Edit mode and the desired object submode.

2 Name the layer.

3 Choose object and label display attributes, if desired.
4 Define a different radius, if desired.

5 Click "OK."

See Also
Working with objects
New Layer... (Objects menu
Edit mode



Creating location objects

1 Create a new locations layer.
OR
Activate an existing locations layer.
2 Click on the desired position on the layer.
A symbol and object key are displayed for each location.

See Also

Working with objects
Creating a new layer



Creating line objects
1 Create a new lines layer.
OR
Activate an existing lines layer.
2 Click and drag from one point to the next.
Aline is drawn between each point which is marked by a handle.

See Also

Working with objects
Creating a new layer



Creating polygon objects

1 Create a new polygons layer.
OR
Activate an existing polygons layer.
2 Click and drag from one point to the next.

Aline is drawn between each point which is marked by a handle. Scan/US draws a line between
the first and last point to close the polygon.

See Also

Working with objects
Creating a new layer



Creating area objects

1 Create a new polygons layer.
OR
Activate an existing polygons layer.

2 Create aring area by clicking on its center.
The ring area's radius is the value defined in the "New Layer" dialog.
OR
Click and drag outward to the desired radius.

Aring is displayed with handles at its four compass points. A sector handle is shown above the
north handle.

See Also

Working with objects
Creating a new layer



Creating sectors
To create the first sector
1 Select a ring area object
2 Shift-Click to select the sector handle, just above the north handle, and drag clockwise to the
desired angle.
Aline is drawn from the center to the sector position, and a sector handle displayed.

To create additional sectors
Shift-Drag from any sector handle.

See Also

Working with objects
Editing a ring area



Editing objects



Editing a location object

To move the point
Drag it to a new location.

To delete a point
1 Click the right mouse button to display the popup of commands.

2 Choose "Delete" from the popup.

To rename an object
1 Click the right mouse button to display the popup of commands.

2 Choose "Rename" from the popup.
3 Enter a new name in the dialog and click the 'okay' » button.

See Also
Working with objects




Editing a line object
When you select a line object, a handle marks each point.

To move a point
Drag its handle to a new location.

To extend the line
1 Shift-Click on an end point handle.

2 Drag to additional points.

To add a point
1 Click the right mouse button to display a popup of commands.

2 Choose the option from the popup.
3 Click the desired position on the line.

To delete a point
1 Select its handle.

2 Click the right mouse button to display the popup of commands.
3 Choose "Delete" from the popup.

To rename the object
1 Click the right mouse button to display a popup of commands.

2 Choose the "Rename" option.
3 Enter a new name in the dialog and click the 'okay' = button.

See Also
Working with objects



Editing a polygon object
When you select a polygon object, a handle marks each point.

To move a point
Drag its handle to a new location.

To add a point
1 Click the right mouse button to display a popup of commands.

2 Choose the option from the popup.
3 Click the desired position on the polygon.

To delete a point
1 Select its handle.

2 Click the right mouse button to display the popup of commands.
3 Choose "Delete" from the popup.

To rename the object
1 Click the right mouse button to display a popup of commands.

2 Choose the "Rename" option.
3 Enter a new name in the dialog and click the 'okay' ® button.

See Also
Working with objects



Editing a ring area

When you select a ring area object, a handle marks each compass point.

above the north handle.

To move a ring area
Drag from inside the ring area to a new position.

To resize aring area
Select a handle and drag it to a new position.

Dragging inward makes the ring smaller; outward, bigger.

To add a band
Drag from the center of the ring area to the desired radius.

A handle marks each compass point on the band.

To delete the ring area
1 Click the right mouse button to display the popup of commands.

2 Choose "Delete" from the popup.

To rename the object
1 Click the right mouse button to display a popup of commands.

2 Choose the "Rename" option.
3 Enter a new name in the dialog and click the 'okay' = button.

See Also
Working with objects

A sector handle is shown just



Editing a sector
1 Select a ring area.
Sector handles are placed just beyond where the sector lines intersect the outermost ring.
2 Reposition a sector line by dragging a sector handle.

See Also
Working with objects



Working with groups

For more detailed information on groups, please see About groups

Point-and-click-operations in Group mode

Groupings
Creating a new grouping
Activating a grouping
Renaming a grouping
Deleting a grouping
Hiding a grouping

Creating groups from the Toolpad
Grouping by selecting objects
Grouping by drawing a ring around objects
Grouping by drawing a polygon around objects

Creating groups with menu commands
Grouping by an object definition
Grouping by list selection
Grouping by a variable's stratification
Hot linking group assignments from Excel
Copying and pasting group assignments
Saving and reloading group assignments

Modifying groups
Activating a group
Changing group assignments
Hiding, deleting, renaming groups
Changing group rendering
Unlinking group assignments



About groups

Working with groups
Groups menu

Creating groups is a way to classify objects on a layer into distinct subsets. Objects assigned to a
group/subset can be rendered the same way, and in general, selected to be operated on as a unit. For
example, you can copy, paste, hide or show groups on a layer.

A classification of objects into groups is called a grouping. Because objects can be classified any
number of ways, you can define any number of groupings on the layer.

Groupings are available in all views of a study area. This allows you to analyze a grouping in a different
way in each view. You can create as many groupings as desired, limited only by the amount of memory
on your computer. However, only one grouping can be active at a time on any given layer.

If no groupings are present, the objects on a layer initially belong to a preset 'unassigned' group. This
group can be handled like any group you create, except that it cannot be deleted or hidden. Some
Scan/US operations apply only to objects assigned to groups you create.

Why are groups important

Grouping objects is a powerful feature in Scan/US. As a fundamental tool for handling multiple objects,
grouping is a first step in territory analysis, or limiting an analysis to a specific region. For example, you
can examine sales across territories by creating a group for each territory, such as California,
Washington, and Oregon in the western region/group, then look at the group's data in "QuickLook." In a
study area of Texas, you could limit the analysis to only Texas counties by grouping them, and hiding the
outlying counties beyond the Texas border. Another example is to group all your competing stores within
a certain trade area and analyze their market penetration.

The objects in groupings are not limited to the study area in which the groups are originally created. For
example, you can create a Sales grouping in which Group1 contained ZIP codes whose total sales are
above $3000, Group2 above $5000, and Group3, above $10,000. Suppose you created and saved this
Sales grouping in a study area of California. You could load this grouping in a study area of New York,
and add to each group the New York ZIP codes with similar total sales. This way you have a single
grouping to track your total sales across ZIP code areas. As an added plus, you could load the saved
grouping file into a spreadsheet to get a list of all the ZIP code areas--across study areas--in the different
sales categories.

Creating groups
Scan/US provides several methods to create groups. Three methods are provided from the Toolpad
using point-and-click operations on the map; additional methods from commands and dialogs.

When you create a group, the New Grouping dialog is opened if a grouping is not present on the layer.
The New Group dialog is opened if no groups are present in the grouping. If a grouping is active, the
objects you select are automatically assigned to the current group.

To start a new group assignment, choose the New Group... command before assigning objects to a new
group. To start a new grouping, choose the New Grouping... command.

Objects retain their group assignments until you change or remove them. Using the "Groupings..."
command, you can save, reload, rename, and delete groupings on a layer. You can also export group
assignments using the "Copy Groups..." command. In the "Group Manager" dialog, you can delete,
rename, hide or show groups. When several groupings are present, you activate a grouping by choosing
its name from the bottom of the Groups menu or from the Group Manager dialog.

Displaying groups
Groups are displayed according to a preset palette. If you have created several groups, some group

renderings may be the same. The number of elements in the palette determines how many groups will
have unique renderings before they are repeated.

When you create groups, they are rendered according to the palette selected in the New Grouping dialog.



If the number of groups in a grouping exceeds the number of palette elements, then some groups are
rendered the same way. You can solve this problem by choosing new display attributes in the New
Group dialog when creating the group, choosing new display attributes in the Group Manager, or by
selecting a new palette in the Group Manager.

The preset palette for grouping area objects is _GroupFill which Scan/US provides and has 16 elements.

(All the built-in Scan/US palettes begin with an underscore.) For point objects, the preset palette is
_GroupSymbols which has six elements. You can change the preset palette in the "Palette Selector.”



Point-and-click operations in Group mode
Groups are created and managed with point-and-click operations in Group mode.

In any submode:

. Clicking the 'undo’
* button reverses the group assignment just created.
. Shift-Clicking an object in a group activates the group.

* By Selection submode supports the following:

. Clicking on an unselected object selects it. Clicking the okay

» button assigns the selected object to the active group.

. Clicking on a selected object deselects it.

. Double-clicking on an unselected object assigns it to the active group in one step.

. Dragging an unselected object to an object in a group assigns the unselected object to the group.
. Shift-dragging from a grouped object to an object in another group assigns all objects in the first
group to the second group. The second group becomes the active group.

. When several point objects coincide in the same position, Ctrl-Click selects each subsequent
object under the cursor. Click the 'okay’

* button to assign the selected object to the active group.

*+ [n By Ring submode, you position the cursor and drag outward to display a ring. Drag inward to
make the ring smaller. When you release the cursor, all object centroids that fall within the ring are
assigned to the same group.

* |n By Polygon submode, you drag the cursor to draw a polygon. When you release the cursor, all
object centroids that fall within the polygon are assigned to the same group.

Note that the ring or polygon you draw to group objects is automatically sent to the clipboard when the
group is created. You can use the ring or polygon definition to group objects on another layer by
immediately activating the layer and choosing the Group By Object command after creating the group.
Activating an editable layer and choosing Paste Objects places the ring or polygon as an object on the
layer.

See Also

About groups
Working with groups



Creating a new grouping
1 From the Groups menu, choose "New Grouping..."
2 Type a new name or accept the proposed name.
. Optional: Click the "Palette" button to change the preset rendering Scan/US assigns to groups.

See Also
Grouping naming conventions
Changing group rendering
New Grouping... (Groups menu)

Palettes... (Options menu
Working with groups



Activating a grouping

Do one of the following:

. Choose the grouping name from the bottom of the Groups menu.
. From the Groups menu, choose "Groupings..." and select the desired grouping.
. From the Groups menu, choose "Group Manager..." and select the desired grouping from the

grouping caption box.

See Also
Working with groups



Renaming a grouping
From the "Groupings" dialog
1 From the Groups menu, choose "Groupings..."
2 Click on the name of the desired grouping.
3 Click the "Rename" button.
A text box is opened with 'okay' # and 'undo'

* buttons.
4 Type a new name and click the 'okay' button

From the "Group Manager"
1 From the Groups menu, choose "Group Manager..."
2 Click inside the grouping name text box to highlight the name.
3 Type a new name and press Enter.

Note If you rename a previously saved grouping from the "Group Manager," Scan/US copies the
grouping and assigns it the new name. The new grouping becomes the active one. Saved
groupings should be renamed from the "Groupings" dialog.

See Also
Working with groups
Groupings... (Groups menu
Group Manager... (Groups menu



Deleting a grouping
1 From the Groups menu, choose "Groupings..."
2 Click on the name of the desired grouping.
3 Click the "Delete" button.
Scan/US asks you to confirm deleting the grouping from the layer.
4 Click "OK" to delete the grouping.

. If the grouping has been saved, Scan/US also asks you to confirm deleting the saved group
information from your hard disk.
Do one of the following:

Click this To Do This

OK Remove the saved information. You will not
be able to load the grouping in other study
areas or in subsequent sessions.

Cancel Keep the saved information for future use.

See Also

Working with groups
Groupings... (Groups menu

Clear groups (Groups menu)



Hiding a grouping

. From the Groups menu, choose "Clear Groups."
The grouping is removed from the display but still loaded on the layer.

See Also

Deleting a grouping
Hiding, deleting, renaming groups
Working with groups



Grouping by selecting objects

1 From the Toolpad activate the Group--By Selection submode.

From the Groups menu, choose "New Grouping..."

Assign a name to the grouping or use the preset one and click "OK."
From the Groups menu, choose "New Group..."

Assign a name to the grouping or use the preset one and click "OK."
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Click on an object.

Tip When several point objects coincide in the same position, Ctrl-Click selects each subsequent
object under the cursor.

7 Confirm your selection by clicking on the 'okay' » button.

Shortcut: Double-click to select and confirm in one step.
Note If you change your mind about an object, click on the Undo = button immediately after
confirming it.
See Also

Point-and-click operations in Group mode
New Group... (Groups menu

New Grouping... (Groups menu)
Working with groups




Grouping from the Toolpad



Grouping by drawing a ring around objects
1 From the Toolpad activate the Group--By Ring submode.

From the Groups menu, choose "New Grouping...."

Assign a name to the grouping or use the preset one and click "OK.".
From the Groups menu, choose "New Group...."

Assign a name to the grouping or use the preset one and click "OK.".
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Position the cursor at the center of the group area and drag outward.
Aring is displayed, and all objects whose centroids fall within the ring are grouped.
Note Click the "Undo" # button to reverse the group assignments just created.

See Also
Point-and-click operations in Group mode
New Group... (Groups menu
New Grouping... (Groups menu

Working with groups



Grouping by drawing a polygon around objects

1 From the Toolpad, activate the Group--By Polygon submode.

From the Groups menu, choose "New Grouping...."

Assign a name to the grouping or use the preset one and click "OK.".
From the Groups menu, choose "New Group...."

Assign a name and click "OK.".
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Drag the cursor around the objects you want to group.
A polygon is displayed, and all objects whose centroids are within the polygon are grouped.
Note Click the 'Undo' #® button to reverse the assignments just created.

See Also
Point-and-click operations in Group mode
New Group... (Groups menu
New Grouping... (Groups menu

Working with groups



Grouping from commands and dialogs



Grouping by an object definition

You can group object on a target layer by overlaying them with a spatial objectdefinition from another
layer.

1 Activate Select--Object mode.

2 Select the object whose boundaries you want to group by.

Tip If a single click doesn't select the object, it is not on the active layer. You can Shift-Click
through the layers until the object is selected.

From the Objects menu, choose "Copy Objects..."
Choose the desired object set.
Click "OK."

Using the window's layer list box, activate the layer whose objects you will group.
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7 From the Groups menu, choose "Group by Object."
Note If groups are not present; you are prompted to name a grouping and a group.

Note If groups are present, the objects are added to the active group, unless you choose "New
Group..." before choosing "Group by Object."

See Also
Window layer box
Copy Objects... (Objects menu
Group by Object (Groups menu)
New Group... (Groups menu
New Grouping... (Groups menu

Working with groups



Grouping by list selection

1 Activate the desired layer from the windows layer list box.

2 From the Objects menu, choose "Object Manager..."
3 Select the object name(s) from the list.

Click to select a single object name; Shift-Click to select multiple names in sequence; Ctrl-Click to
select multiple names not in sequence.

4 From the Action menu in the dialog, choose "Assign to Group."
Note If groups are not present; you are prompted to name a grouping and a group.

Note If groups are present, the objects are added to the active group, unless you choose "New
Group..." before choosing "Assign to Group."

See Also

Window layer box

Object Manager... (Objects menu
New Group... (Groups menu)
New Grouping... (Groups menu)
Working with groups



Grouping by a variable's stratification

Objects can also be grouped according to strata ranges defined for a specific variable in a thematic view.
One group is created for each stratum. The groups are stored in a grouping whose preset name is the
variable name. You do not need to create a thematic view for the groups to be created.

To create the groups
1 From the Map menu, choose "View Variables..."

2 Choose the variable to group objects by.

3 Click the "Strata Manager" button. afihs

Define the desired strata ranges for the variable.

Click the "Save as Groups" button.

Click "OK" in the "New Grouping" dialog.

Click "Cancel" in the "Strata Manager" dialog.

Click "Cancel" in the "View Variables" dialog.
Note Because a thematic analysis using a fill color or pattern and a grouping cannot be displayed
at the same time in the same window, you must hide the thematic analysis before displaying the

grouping.
To display the groups
From the Groups menu, choose the grouping name.
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See Also
View Variables... (Map menu
“Strata Manager" dialog
Modifying a variable's stratification
Hide Thematic & Show Thematic (Views menu)

New Grouping... (Groups menu)

Working with thematic views
Working with groups




Hot-linking group assignments from Excel

Tip The Scan/US BasePak includes a prepared sample file, GRPBYDDE.XLS, which you can use to
demonstrate the following steps. The file is located in C:\SCANUS\USERDATA unless you defined a
different data directory when you installed the product.

1 Prepare your data so it can be read by Scan/US.

See Preparing Excel group data for linking for more information and the contents of
GRPBYDDE.XLS.

2 Start Excel and Scan/US.

3 In Excel open GRPBYDDE.XLS or your prepared data file.

4 Select the range of cells from the [grouplist] keyword to the last group value item.
The range is A1 to B50 in the sample file.

5 From the Excel Edit menu, choose the "Copy" command.

6 In Scan/US, choose the layer whose objects you want to group from the window layer box.
Using the sample file, activate the states layer.

7 From the Groups menu, choose "Paste Link."
You are prompted to name a grouping for the groups.

8 Change a group's membership

9 Return to Excel and view the changes.

See Also
Help
Changing group assignments
Unlinking group assignments
Working with groups

rouplist arcel

Paste Link (Groups menu)
New Grouping... (Groups menu)

Reference Manual
"Paste Link (Groups menu)"



Preparing Excel group data for linking

To link group assignments, prepare your data in the following way:

. The keyword, [grouplist], must be in the first cell of the first row and first column. If
necessary, insert a row and add the keyword.

. The second cell of the first row must contain the total number of objects.

. All the object keys must be unique and entered as text data in the first column. If the object keys

are numeric, you must add a number sign (#) to precede each one so they are recognized as text. The
object keys should match the objects on the layer and be sorted in ascending order.
The object keys that don't match will not be linked. They will be rendered as unassigned objects.
Grouping objects with unmatched keys does not update the spreadsheet.

. The second column contains the group assignments and must have an entry for every object.
If some objects are not assigned to a group, make sure that they have object keys and have a
group name of 0 (zero entered as a number, not text). Scan/US will recognize them as
unassigned objects and will display them in their original rendering.

See Also
Help
rouplist arcel
Paste Link (Groups menu)
Hot-linking group assignments from Excel
Working with groups

Reference Manual
"Paste Link (Groups menu)"



Copying and pasting group assignments

You can copy group assignments with different commands. The "Copy Groups..." command copies
assignments from the active grouping. The "Copy Variable..." command treats a variable's stratification
in a thematic view as group assignments.

To copy group assignments with "Copy Groups..."
1 Activate the desired grouping.
2 From the Groups menu, choose "Copy Groups..."
3 Choose the groups you want to copy.
This option Does this

Objects in All Groups  Copies the group assignments for all objects.
Objects in Selected Copies the group assignments for objects in

Groups groups you select.
. To select a group, click on its name; Shift-Click to select multiple groups in sequence; Ctrl-Click to
select multiple groups not in sequence.
4 Click "OK."

To copy group assignments with "Copy Variable..."
1 Create a thematic view with the desired variables and stratification.
2 From the Views menu, choose "Copy Variable..."

3 Choose the strata you want to copy.

This option Does this

Objects in All Strata Copies the values for objects in all strata.

Objects in Selected Copies the values for objects in selected strata.

Strata
. To select a strata, click on its name; Shift-Click to select multiple strata in sequence; Ctrl-Click to
select multiple strata not in sequence.
4 Click "OK."

To paste group assignments
1 From the Groups menu, choose "Paste Groups" .
2 If desired, name the new grouping in the dialog, or accept the proposed name.
3 Click "OK."

Tip If a thematic view using a color fill is present, the groups will be obscured. From the Views
menu, choose "Hide Thematic" to hide the view and see the groups.

See Also

New Grouping... (Groups menu)
Activating a grouping
Grouping by a variable's stratification

Working with groups
Copy Groups... (Groups menu

Copy Variable... (Views menu)

Paste Groups (Groups menu)

View Variables... (Map menu




Saving and reloading group assignments

To save group assignments
1 From the Groups menu, choose "Groupings..."
2 Click on the name of the grouping you want to save.
3 Click on the "Save" button.

The icon preceding the name changes to L indicating that the grouping is currently loaded and
saved.

To load saved group assignments
1 From the Groups menu, choose "Groupings..."
2 Choose the "Layer only" option to list only the groupings available for the active layer.
Previously saved groupings are preceded by a disk icon &
3 Click on the name of the desired grouping.
4 Do one of the following:
Click this To Do This
Load Load the grouping onto the layer.

Select Load the grouping and make it the
active one for the layer.

See Also
Working with groups



Activating a group
With any of the following methods, the name of the active group is always shown in the status bar.

. In Group mode, Shift-Click on an object in the desired group.

. In any mode, choose "Group Manager..." from the Groups menu, then click on the desired group.
If all objects on a layer are grouped, using the "Group Manager" is the only way to activate the
'Unassigned' group or another empty group.

. If you are viewing data for groups in "QuickLook," select another group from the "QuickLook"
drop-down list.

See Also

The Toolpad modes

Group Manager... (Groups menu
Point-and-click operations in Group mode
Working with groups



Changing group assignments

Make sure a grouping is active before proceeding.
1 Activate Group--By Selection submode. Note the name of the active group in the status bar.

Optional: Activate a different group, if desired. See Activating a group

Do the following:

Double-click on an object to add it to the active group.

Drag an object to another group.

Shift-drag from an object to assign its entire group to another group.
Note When you Shift-drag, the first group becomes an empty group, and the second group is the
active group. To add objects to the first group, activate it from the "Group Manager."

Note If you Shift-Drag to the 'Unassigned' group, it becomes the active group. Make sure you
activate another group or create a new group before attempting to group more objects.

B N ]

See Also
Point-and-click operations in Group mode
Hiding, deleting, renaming groups
Activating a group
Working with groups



Hiding, deleting, renaming groups

1 From the Groups menu, choose "Group Manager..."

2 Select a group by clicking the right mouse button.

3 Choose a command from the popup.

Choose this

To do this

"Hide Group"

"Delete Group"

"Rename."

To hide a group; the grouped objects are shown

in their original rendering. A shade s shown
next to the group name.

To remove a group name from the dialog; the
objects are shown in their original rendering.

A text box is opened with 'okay' # and 'undo' =
buttons. Type a new name and click the 'okay'
button

See Also

Working with groups



Changing group rendering

Groups are rendered according to a preset palette. You can change a group's rendering before it is
created, when it is created, or after it is created. You can also change the preset palette.

To change a group's rendering before it is created
1 Fom the Groups menu, choose "New Grouping..."

i1

2 Click the "Palette" button in the dialog.

3 Choose another palette.
4 Click "Select." .
5 Click "OK."
To change a group's rendering when it is created
1 From the Groups menu, choose "New Group..."

2 Click the object button in the dialog.

For example, E or

3 Choose another rendering in the selector dialog.
4 Click "Select." .
5 Click "OK."

To change a single group's rendering after it is created
1 From the Groups menu, choose "Group Manager..."

2 Click the object button preceding a group name.
3 Choose another rendering in the selector dialog.
4 Click "Select"

To change multiple groups' rendering after they are created
1 From the Groups menu, choose "Group Manager..."

2 Click the "Palette" button # in the dialog.

3 Choose another palette.
4 Click "Select." .
5 Click "OK."

Starting with the selected group, each subsequent group is assigned a new rendering according to
the selected palette.

To change the preset palette
1 Fom the Options menu, choose "Palettes..."

2 Choose a class of palettes such as AreaFill or Symbols.
3 Choose a palette.
4 Choose the "Set Default--Groups" option.

See Also
New Grouping... (Groups menu)
New Group... (Groups menu
Group Manager... (Groups menu
Palettes... (Options menu
Using selector dialogs
Working with groups







Unlinking group assignments

1 From the Groups menu, choose "Groupings..."
DDE-linked groupings are listed with the DDE icon 1.

2 Click on the name of the desired grouping.

3 Click "Unlink."
Scan/US asks you to confirm unlinking the grouping.

4 Do one of the following:
Click this  To Do This

OK Unlink the file. Subsequent changes to
group assignments will not be shown in the
originating Excel file.

Cancel Retain the DDE link.

See Also

Hot-linking group assignments from Excel

Working with groups
Groupings... (Groups menu



Working with data

For an overview, please read About data and About variables

For procedures and information on geographic data, please read Working with map features and Using
your own geographic data

Loading attribute data

Automatically loading attribute
Activating a different datalist

Viewing selected variables in a datalist
Viewing an object's data

Viewing a group's data

Viewing benchmark data

Aggregating data on other layers
Copying data to the clipboard



About data

Working with data
Using your own data

Data is central to getting the most out of Scan/US. You need two kinds of data: geographic (map) data
and attribute data.

Geographic data describes all the geography you see on a map such as states, cities, counties, zip code
areas, streets, highways, etc. Scan/US provides map data on every level from states to grids. You may
also have map data of your own such as customer addresses, store locations, or district boundaries.
Other terms for map data are 'feature files,' 'boundary files,' or 'geographic data." Scan/US uses 'feature
files.'

Attribute data describes the characteristics of a specific population or market such as a customer profile,
the 1990 census data, the number of sales per territory, the annual consumption of soft drinks, the
favorite foods on college campuses, etc. Scan/US comes with a wide range of data culled from the 1990
census and current year updates. Most likely you also have your own data which you will analyze and
represent in a map in Scan/US. A common term for attribute data are 'data files." Scan/US uses
'datalists' (one word) to describe the attribute contents of a data file. See About variables for more
detailed information on the contents of a data file.

Loading data

Scan/US features and their attribute data are all part of the Scan/US product database and automatically
loaded into Scan/US. Datalists are automatically loaded with a feature when it is added to a study area.
For example, with the States feature, three datalists are loaded: Key Demographics, Basic
Demographics, and Income and Education.

You can load more features via the "Features Directory..." and more attribute data with "Load Data..."

Activating datalists

Although several datalists can be loaded onto a layer, only one can be active at a time. You can activate
another datalist by choosing its name from the bottom of the data menu, or by selecting it from the_"Data
Center." If you need to view data from one or more datalists at the same time, you can build a new
datalist definition that combines variables from other datalists. This capability is provided by clicking the
"New..." button in the "Data Center." Another way is to copy the data from the desired datalists using
"Copy Data...," combine the desired data in another application, then bring it back into Scan/US.

Importing data

Geographic and attribute data that are not part of the Scan/US database must be prepared before
Scan/US can load it. (This is covered in Using your own data.) Once prepared, your features and
datalists can be loaded in the "Add Features to Directory" and "Data Center" dialogs. An "Autoload"
option is provided in both dialogs so you can tell Scan/US to automatically load your data in future
sessions.

Exporting data

Each of the Scan/US copy commands sends a data parcel to the clipboard. A parcel is a structured set
of records or tables. The first record, the header, identifies the parcel in square brackets and describes it
contents. For example, the "Copy Data..." command outputs a [data] parcel containing variables and
their values for a specified object set; the "Copy Groups..." command outputs a [grouplist] parcel listing
object keys and their group assignments.

Data parcels sent to the clipboard can be pasted into other applications so you can modify the data or
analyze it further. If the parcel structure is retained, in most cases, the data can be pasted or linked into
Scan/US.

Here is a brief description of the copy commands to give you an idea of what you can export. For a
complete description, please see their command descriptions

. "Copy CrossReference..." sends a list of objects on the active layer and their corresponding
objects on another layer.



. "Copy Distance..." calculates and sends the distance between one or more source objects to one
or more target objects.

"Copy Groups..." sends a list of objects and their group assignments.

"Copy List" sends a list of object keys.

"Copy Map" send a bitmap image of the active map (not a parcel).

"Copy Objects..." sends a geometric description of selected objects.

"Copy Tour" sends the distance, calculated in Tour mode, between a starting point and one or
more ending points.

. Copy Variable..." sends the stratification and data values of a variable analyzed in a thematic
view.




About variables

Variables are the numeric data items that you see in a datalist. Each object on the layer has a value for
each one of the variables in the datalist. For example in the 1990 census summary data for states, you
would see variables like Total Population (Pop90), Number of Families in Households (Families), or Total
Number of Households (Hh90) for each state.

The abbreviated form is the variable name that Scan/US keeps track of, but when you send data to the
clipboard, the variable name is often followed by a caption that describes it fully. The data you send to
the clipboard can be used in other applications such as Excel in which you can create reports, graphs,
and charts of your data.

Variables which show you "how many" are count variables. All other variables are statistic variables
which show you an average or median; for example, Median Home Value (Value_mdn) and Average
Home Value (Value_avg ).

Scan/US also calculates a percent value for count variables whose base variable is in the same datalist.
For example, Total Household Units is the base variable used to derive a percentage for the count
variable Renter. Scan/US can tell you the number of renter-occupied household units, or the percentage
of renter-occupied household units. Scan/US calculates these 'percent views' when a datalist is selected
for analysis in a thematic view and for viewing data in "QuickLook."

Variables which can be calculated as percentages are preceded by a button which toggles between a
number sign (#) and a percent sign (%). Only those count variables that have a base variable can be
toggled; the number sign means Scan/US will use the count value; the percent sign, the percentage.

Scan/US also provides array variables which are two or more variables of the same type, such as
population count by age groups. The name assigned to the group of array variables is preceded by a
button with a plus sign (+) or minus sign (-); clicking the plus sign (+) expands the array to show you the
list of variables; clicking the minus sign (-) collapses the list. (Note that this is similar to expanding and
collapsing directories in Windows File Manager). All array variables can be used as either count
variables or percentage variables, according to the needs of your data analysis.

Handling data variables in arrays and providing percent views are unique to Scan/US. These two ways
give you more power and flexibility in analyzing your data.

See Also

Using your own attribute data
About data

Working with data
View Variables... (Views menu)




Viewing an object's data
1 Activate the desired layer in the window layer box.
2 Check that data is attached to the layer.
The data i icon is shown next to the layer name in the window layer box.
3 Activate Edit, Select, or Group modes.

4 From the Views menu, choose "QuickLook...."
The "QuickLook" window is opened and displays the selected object's data. If an object is not

i . .
selected, gray blanks are displayed. The "Show Object" 21 button is activated.

5 To select an object and view its data, do one of the following:

. Click on the desired object in the map.
. Click the down arrow button to display a list of objects and click on the desired one.
Note If a group's data is currently displayed, click the "Show Object" button to view an object's data.

See Also

Working with data

The Toolpad modes
QuickLook... (Views menu



Viewing a group's data

Scan/US automatically aggregates the data of each object in a group to create a group summary. For
count variables, you can toggle between a sum and average of the data. You can also see the percent
view of count variables preceded by a number sign (#).

1 Activate the desired layer in the window layer box.
2 Check that data is attached to the layer.

The data = icon is shown next to the layer name in the window layer box.
3 Activate Group mode.

4 Activate a grouping or create a group.
See Working with groups if you need instructions.
5 From the Views menu, choose "QuickLook...."
. Optional: To view the sum or the average of count variables, click the "Sum"

% button or "Average"

g button to toggle values.
Note Percent views are not summed or averaged.

6 To view another group's data, do one of the following:

. In Group mode, Shift-Click on the desired group.
. Click the down arrow button to display a list of groups and click on the desired one.
. Create a new group.

Note If an object's data is currently displayed, click the "Show Group" button to view a group's data

See Also
Working with data
QuicklLook... (Views menu)

Working with groups




Viewing benchmark data

You can compare the data for the currently selected object or group to a U.S. benchmark, a saved
benchmark, or to another object or group.

1 Display data for a selected object or group in "QuickLook."

If you need instructions, see Viewing an objects data or Viewing a groups data
2 Click the "Show Benchmark" button.

=]

All benchmark options are outlined or colored red to help you distinguish them. The data in the
benchmark column duplicates the currently selected object or group. If a group is active and an object
selected, the group's data is shown in the benchmark column, unless a U.S. benchmark is provided.
3 Click a benchmark button to tell Scan/US the type of benchmark, then choose the desired
benchmark from the drop-down list.

i
Click this button to select an object from the drop-down list.

@ Click this button to select a group from the drop-down list.

ﬁl Click this button to select a U.S. benchmark or a previously saved benchmark from the drop-
down list.

(]
Tip Click these buttons to select each item in the list in successive order and view its data.

Tip While the benchmark data is displayed, you can continue selecting objects or groups and compare
their data to the benchmark.

See Also
QuickLook... (Views menu)
Benchmarking in "QuicklLook"
Working with data



Viewing selected variables in a datalist
1 Display data for a selected object or group in "QuickLook."
If you need instructions, see Viewing an objects data or Viewing a groups data
2 Select the desired variables.

Shift-Click to select multiple variables in sequence. Or, click and drag over their names. Citrl-
Click to select multiple variables not in sequence.

3 Hide the unselected variables by clicking the "Contract" button.

=
=
4 To expand the list, click the "Expand" button.
(A
a
Tip If you've selected several variables, you can lengthen the dialog to see them all in one box.
See Also

About variables
Working with data



Activating a different datalist

Although several datalists can be loaded for a layer, only one is active at a time. Loaded datalists are
listed at the bottom of the Data menu. If the number of datalists exceeds the number listed, the "More
datalist..." command is shown and opens the "Data Center."

. Choose the datalist name from the bottom of the Data menu.
OR

1 From the Data menu, choose "Data Center...."

The "Data Center" lists all the datalists loaded onto the layer. The current datalist is shown in red
text and highlighted.

The data icons tell you how the datalist was loaded or created. See the back cover of the User's
Guide or the "Data Center... command.

2 Select the desired file.
3 Click "Select."

Tip If you select a new datalist while the "QuickLook" window is open, data from the new datalist will be
displayed for the currently selected object or group.

Tip Because only one datalist is active at a time, selecting another datalist will remove a thematic
analysis of the current datalist.

See Also
Working with data
Loading attribute data
Automatically loading attribute data



Loading attribute data

1 Using the window layer box, activate the layer to which you will load data.
2 From the Data menu, choose "Load Data...."
3 Select a directories option in the dialog to locate the file.
3 Select a file type to filter the list.
4 Select the file you want to load onto the layer.
A preset datalist name is added to the "Datalist name" edit box.

. Optional: Enter a different datalist name.

5 Type a brief description of the file in the "Caption" edit box.
This description is displayed at the bottom of the Data menu. For example, one of Scan/US' files
is shown as "C90CA: '90 Census Key Summary" in which 'C90CA' is the datalist name and the rest
is the caption.

If you do not enter a caption, Scan/US uses the datalist name.
6 Select the name of the column or field containing the object keys.
If you do not specify a key data item, Scan/US assumes object keys are in the first column or field.
7 Click "OK."
The file is loaded and becomes the active one for the layer.
Note While a point data file is loaded as a feature, its attribute data cannot be loaded onto other layers.

See Also

Working with data

Automatically loading attribute data
Using your own attribute data
Window layer box

QuickPaths vs. Directories

Load Data... (Data menu)

Data Center... (Data menu)



Automatically loading attribute data

1
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Using the window layer box, activate the layer to which you will load data.
From the Data menu, choose "Data Center..."

Click the "File..." button to open the "Load Data" dialog.

Select a directories option in the dialog to locate the file.

Select a file type to filter the list.

Select the file you want to load onto the layer.

A preset datalist name is added to the "Datalist name" edit box.

Optional: Enter a different datalist name.

Type a brief description of the file in the "Caption" edit box.
This description is displayed at the bottom of the Data menu. For example, one of Scan/US' files
is shown as "C90CA: '90 Census Key Summary" in which 'C90CA' is the datalist name and the rest
is the caption.

If you do not enter a caption, Scan/US uses the datalist name.

Select the name of the column or field containing the object keys.

If you do not specify a key data item, Scan/US assumes object keys are in the first column or field.
Click "OK."

The selected file is added to the "Data Center."

10 Check the "Autoload" option.

The autoload icon & is displayed next to the file name. The file will be autoloaded with the
feature when it is added to a study area in the current session and in future sessions.

Tip Check the "Default" option if you want your data to be the first file activated for the feature when it is
added to a study area.

Note

While a point data file is loaded as a feature, its attribute data cannot be loaded onto other layers.

See Also
Working with data

Loading attribute data

Using your own attribute data
Window layer box
QuickPaths vs. Directories
Load Data... (Data menu)
Data Center... (Data menu)



Aggregating data on other layers

This capability allows you to summarize data loaded on another layer for objects on the current layer.

The current layer is considered the target layer, and the other, the source layer. The source layer must
be a finer level of geography than the current layer. For example, MicroGrid data can be summarized for
Zip codes, but zip code data cannot be summarized for census tracts.

1 Activate the target layer from the window layer box.

2 From the Data menu, choose "Data Center..."

3 Click the "Layer..." button to open the "Add Datalist from Layer" dialog.
4 Select the source layer from the drop-down list.

5 Select the desired datalist.

. Optional: Change the caption which will be shown at the bottom of the Data menu.
6 Click "OK."

The selected datalist is added to the "Data Center" and highlighted. The & icon precedes it.
7 Click "Select" to activate the referenced datalist for the layer

Tip The list of objects on the active layer and their corresponding objects on the source layer can be
copied and saved. See the "Copy CrossReference..." command description.

See Also

Working with data
Viewing summarized variables in "QuickLook"



Copying data to the clipboard

To copy data for a single object or group
1 Display data for a selected object or group in "QuickLook."

If you need instructions, see Viewing an objects data or Viewing a groups data

2 Click the "Clipbboard" button.

All variables are sent unless the list is contracted to selected variables. See Viewing selected
variables in a datalist

To copy data for multiple objects or groups
1 Activate the desired layer from the window layer box.
2 From the Data menu, choose "Copy Data...."
3 Choose the datalist containing the variables you want to copy.

You can choose more than one datalist if you elect to send all variables, instead of choosing
specific ones (in the next step.)

4 Choose the variables you want to copy.

Click the arrow button to display a list of variables. Shift-Click to select multiple variables in
sequence; CtriClick to select multiple variable not in sequence. Click the plus (+) button to expand
a list of array variables to copy.

5 Choose an option to indicate the objects for which you want data copied.

. The "Selected Object Only" option is active if you previously selected an object before opening
the dialog.
. "Filtered Objects" is only available in a thematic view that has hidden strata.
. "All Objects" is preselected if you did not previously select an object and if there are no groups on
the current layer.
. "Visible objects" is only available if you changed visibility settings in the "Object Manager."
. "Objects in Groups" is only available if you have created groups on the current layer.
6 Click "OK."
See Also
Working with data
About data

About variables
Copy Data... (Data menu
Copy Variable... (Views menu



Using your own data

For an overview, please see the following topics:

About data
The data environment in Scan/US

Importing user data into Scan/US
Object key formats

Geographic data
For more detailed information, please see Using your own geographic data

Creating a point data file

Adding features to a study area

Adding features to the "Features" Directory"
Automatically loading features

Attribute data
For more detailed information, please see Using your own attribute data.

Exporting object keys from Scan/US
Adding pound signs to Excel object keys

Creating a new data file using a starter file

Setting up an existing data file

Modifying Excel data item names to summarize data
Creating a datalist description file

Loading attribute data

Automatically loading attribute data



The data environment in Scan/US
Using your own data

Making the most of geomarket analysis in Scan/US requires geographic data that shows you where the
markets are on the landscape and attribute data which shows you their characteristics.

Scan/US provides these two types of data in its product database. The geographic data or feature files
contain a representation of different levels of geography such as states, counties, census tracts, zip code
areas, hospitals, major cities, etc. from which you can determine the scope of a market. The attribute
data, mostly culled from the 1990 census and current year updates, is available for each level of
geography, shows you the population, age, race, gender, housing, income, education, occupation, etc. of
these markets.

In addition to the product database, you have your own data of geographic features and attribute data.
Your feature files may show the locations of your stores, potential site selections, franchises, or sales
territories, represent telephone area code regions, or real estate housing divisions--according to the
consumer geography of your market. Your attribute data describes the characteristics of your market: it
may include your customer database; the customer profile within a buffer area surrounding a store; total
sales aggregated by zip code; the distance of different sites to neighborhoods that meet your customer
profile; the income, education, proximity to stores and schools of different housing divisions, etc.

Tip
If you require more data to complete your analyses, please review the Product Database or call us. Our
staff can help you find what you need.

Map and data automation

The product database and your own data are the two sources of data that make up the data environment
in Scan/US. The product database is immediately available from the moment you start a session.--You
can drag-and-drop features (geographic data) from the "Features Directory" whenever you need them.
Attribute data is automatically loaded with each feature, and a specific datalist activated, whenever the
feature is added to a study area.

If your own data is available, you can load geographic data through the "Add Feature to Directory" dialo
and attribute data through the "Data Center" dialog.. You can even tell Scan/US to autoload your data
using the "Autoload" option in the Features menu of the "Features Directory" and in the "Load Data"
dialog.

This information is stored in SCANUS.GDS, or another session file, which Scan/US reads at start-up and
which determines the amount of geography and attribute data available during a session

Using your own maps and data
The ease with which Scan/US accesses your maps and data is unique among data mapping software.
Your efforts are only needed to prepare your files. Please see the following:

. Using your own geographic data
. Using your own attribute data

DDE linking your data

Finally, you can dynamically link your Excel data to Scan/US features through DDE (Dynamic Data
Exchange). This capability allows you to make changes in one product and see them updated in the
other. The "Groups--Paste Link" command shows you the way.

See Also
About session files
Data Center... (Data menu)
Features Directory... (Map menu
Load Data... (Data menu)
Paste Link (Groups menu)






Object key formats

Object keys are critical to attaching user data to maps in Scan/US. Because maps and data are easily
transferred between Scan/US and other applications--which format data in different ways--keep in mind
these few rules to avoid errors.

. Object keys must be unique.
Tip Census tract and block group keys must be preceded by their state and county codes to
make them unique.

. Object keys between maps and their data must be the same.
. A numeric key must be preceded by the number sign, or enclosed in double quotes. For
example, #90025 or 90025.
. Keys can combine letters, numbers, and the underscore (_). For example, LOC001 or LOC_001.
Double quotes are optional.
. Keys containing blanks or special characters, such as an apostrophe, or period, must be
enclosed in double quotes. For example, 1001.99-1.
File format Key format Comments
dBASE (.DBF) Any of the above Keys must be in a CHARACTER field.
Excel (.XLS) Any of the above Automatically removes double quotes from

objects you paste in. You must re-insert the
quotes for loading in Scan/US.

Delimited ASCII text Any of the above If object keys are missing, Scan/US will not load
(.DAT) data files the file.
Delimited ASCII text Any of the above If objects keys are missing, Scan/US will create
(.BUF, them.
LOC, .PLN, .PGN)
map files

See Also

Using your own data

Importing user data into Scan/US
Preparing Excel files

Preparing dBASE files

Preparing delimited ASCII text files



Using your own geographic data
Using your own data

Scan/US automatically loads features in its product database and can access the following geographic
data:

. Scan/US parcels (.CSV, .TXT) which have been output to the clipboard by one of the Scan/US
copy commands. You can paste the clipboard data in another application such as Excel, save it as a text
file, then reload it into Scan/US.

. ASCII text files (.LOC, .PGN, .PLN, .BUF) which are created when you save an editable layer
containing objects you created, or pasted from another layer.

. Point data files (.XLS and .DBF) which contain location coordinates and data describing each
location.

Loading a feature adds it to the "Features Directory." Activating the "Autoload" option for the feature in
the directory, tells Scan/US to automatically load the feature into a study area when it is created. Saving
the directory makes the feature automatically available in future sessions.

Each of these file types is loaded as an editable feature. Any changes you make can be saved with the
"Save" and "Save As..." commands in the Objects menu. Saving a .BNA or .MIF feature generates an
ASCII text file whose extension corresponds to the feature type that was extracted and loaded from the
original file.

See Also
Help
Data parcels
Working with map features

Working with objects
About session files

Reference Manual
"Appendix A: File Formats"



Using your own attribute data
Using your own data

Your data files can be stored in Excel (.XLS), dBASE (.DBF), and ASCII text (.DAT) files. The critical
element in your data files is to have a unique object key in each record. This key matches the data with
the object to which it pertains. Without the object keys, Scan/US cannot attach your data files to any
feature files.

To set up the object keys and prepare your data files, please see the following topics.

Preparing Excel files
Preparing dBASE files
Preparing ASCII text filesPreparing_delimited_ASCII_text_files

Object key formats

Organizing the data

The data must also be collapsed so that only one record can be matched to an object. If one or more
records have the same object key, then Scan/US attaches the first record encountered to the object; the
other records for the object are ignored.

For example, if you want to examine sales figures by state or territory, but your data files contain amounts
purchased per customer and the customer name and address, you would need to collapse and sort the
data, and calculate sales totals per state. Next, you would store these totals in a file containing a column
with the state object keys.

For the best performance, sort the data by object keys in ascending order.

Summarizing the data in Scan/US

When Scan/US summarizes data from its product database--for groups or data from other layers--it
accesses built-in information to accumulate each data item. For example, count variables are totaled,
and statistic variables averaged or weight-averaged. For user data files, Scan/US automatically totals all
variables.

If you want Scan/US to summarize your data, distinguishing between count and statistic variables, and
providing percent views or weighted averages, you must tell Scan/US how to handle each variable.

For Excel files, you can add the necessary information to a column heading. For dBASE and delimited
ASCII text files, you must create a datalist description file. See the following topics:

Structure of Excel data item names

About datalist description files
Datalist Description File Structure

See Also
About starter files
Load Data... (Data menu)
Copy List (Objects menu)

Object Manager... (Objects menu



Preparing Excel files
With a minimum of file preparation, Scan/US directly reads your Excel data files so you don't have to
import them. Your file should meet the following 10 requirements:

1 Excel file limits Scan/US limits the number of rows to 16,000. The number of columns is
determined by how many column headings fit into a 64K memory limit (imposed by Windows). If
the headings are short, you can probably have the maximum 256 columns.

2 Object keys The file must have an object key column that uniquely identifies each record. See
Object key formats

3 All object keys between data files and their maps must be the same.

If the geography is in the Scan/US product database such as ZIP codes or census tracts, you can
copy the object keys from Scan/US. See Exporting object keys from Scan/US and About starter
files for more information.

If the geography is your own such as store locations or branch offices, make sure the object keys
are unique and match correctly the keys in the data file.

4 The object key column must be recognized as TEXT. Precede each object key with a pound sign
(#) so that it is recognized as text. See also Adding pound signs to Excel keys

5 Position the object key field as the first field in the file--this is where Scan/US looks for it.

If the object key column is not first column, name the column KEY so Scan/US can find it. If the
object key column is not the first one or not named KEY, you can identify the object key column
when you load the data in the "Load Data" dialog.

Tip It's good practice to make the object key column the first one. This is the simplest way to
ensure that Scan/US finds the object keys.

6 If your file is a point data file, the coordinates identifying each location must be in two columns
named LATITUDE and LONGITUDE, and the coordinates must be in decimal format. See

Converting to decimal degrees.
In your Excel files these columns must be numeric.

7 All data columns must have headings. Scan/US treats them as data variable names.

8 Blank cells and empty cells are treated as null values, not zeros. If a data value is zero, enter 0
into the cell.

9 Define a database range.

Select the entire range of cells including column headings, object keys, and all the data and define
them as a database. In Excel 4.0, choose the "Data--Set Database" command. In Excel 5.0,
choose the "Insert--Name" command and its Define option, then type in database.

10 Save the file in the proper format.

The file must be saved in Excel 4.0 format. In Excel 5.0, choose the file type in the "Save As"
dialog when you save your file.

Advanced Techniques (optional)
You can include some data description defaults by adding the keyword [data] to the first cell of the first
row in the database range--column headings are in the second row, and data values in subsequent rows.

. To add a datalist caption--a longer, more descriptive name that Scan/US displays at the bottom of
the Data menu--add the caption to the second cell of the [data] row.
. If the .XLS file is a point data file, you can add a feature declaration describing its display

attributes to the third cell of the [data] row. The feature declaration must be enclosed in curly braces {}
and conform to the syntax described in SCANUS1.TXT. This file is located in CASCANUS, unless you

defined a different home directory in a custom install.

If you do not include a [data] row, you assign a datalist caption when loading the file in the "Load Data"

dialog. Locations in point data files are displayed with preset display attributes--a small white square--



which you may change in the "Features Directory."

See Also
Tips for preparing attribute data
Structure of Excel data item names
Modifying Excel data item names to summarize data
Using your own data
Working with data



Preparing dBASE files

With a minimum of file preparation, Scan/US directly reads your dBASE data files so you don't have to
import them. Your file should meet the following 6 requirements:

1

dBASE file limits You can have up to 3 million records in a file. The number of fields per record
is determined by dBASE or the dBASE-compatible application.

Object keys The file must have an_object key field that uniquely identifies each record. See
Object key formats

All object keys between data files and their maps must be the same.
If the geography is in the Scan/US product database such as ZIP codes or census tracts, you can

copy the object keys from Scan/US. See Exporting object keys from Scan/US and About starter
files for more information.

If the geography is your own such as store locations or branch offices, make sure the object keys
are unique and match correctly the keys in the data file.

4 The object key field must be a CHARACTER field.

Position the object key field as the first field in the file--this is where Scan/US looks for it.

If the object key field is not first field, name the field KEY so Scan/US can find it. If the object key
field is not the first field or not named KEY, you can tell Scan/US which field to use by creating a
datalist description file. Another option is to identify the object key field when you load the data in
the "Load Data" dialog.

Tip It's good practice to make the object key field the first one. This is the simplest way to ensure
that Scan/US finds the object keys.

If your file is a_point data file, the coordinates identifying each location must be in two fields named
LATITUDE and LONGITUDE, and the coordinates must be in decimal format. See Converting to
decimal degrees.

These two fields must be NUMERIC fields.

See Also

Tips for preparing attribute data
About datalist description files
Datalist description file structure
Using your own data

Working with data



Preparing delimited ASCII text files

With a minimum of file preparation, Scan/US directly reads your ASCII text files so you don't have to
import them. Your file should meet the following requirements:

Map files (.BUF, .LOC, .PGN, .PLN, )

1

See "Appendix A" in the Reference Manual for file formats and illustrations.

2 Comma and tab delimiters are now supported. Tabs are treated as spaces.
Data files (.DAT)

1

ASCII text file limits Scan/US limits the number of fields to 500; the file may have any number of
records.

Header record The first record, usually called a 'header,' must list the names of the fields in the
file. Scan/US treats these names as the data variable names.

Data records The remaining records contain values corresponding to the named fields in the
header. Records are separated by the end-of-record/line-feed [0d0a] sequence.

Field delimiters Values in each record must be separated by a single common delimiter--comma
ortab. If a comma is part of a value, enclose the value in quotes.

Empty fields must be defined by two consecutive delimiters without intervening characters other
than spaces. These fields are treated as zero values for numeric (i.e. count or statistic) variables,
and as blanks for text variables.

Object keys The file must have an object key field that uniquely identifies each record. See
Object key formats

All object keys between data files and their maps must be the same.

If the geography is in the Scan/US product database such as ZIP codes or census tracts, you can

copy the object keys from Scan/US. See Exporting object keys from Scan/US and About starter
files for more information.

If the geography is your own such as store locations or branch offices, make sure the object keys
are unique and match correctly the keys in the data file.

Position the object key field as the first field in the file--this is where Scan/US looks for it.

If the object key field is not first field, name the field KEY so Scan/US can find it. If the object key
field is not the first field or not named KEY, you can tell Scan/US which field to use by creating a
datalist description file. Another option is to identify the object key field when you load the data in
the "Load Data" dialog.

Tip It's good practice to make the object key field the first one. This is the simplest way to ensure
that Scan/US finds the object keys.

Save your file with a .DAT extension so Scan/US can load it.

Tip ASCII text files output by Excel need only have their extension changed to .DAT to be
loadable in Scan/US.

See Also
Tips for preparing attribute data
About datalist description files
Datalist description file structure
Using your own data
Working with data






Tips for preparing attribute data
Here are some tips for preparing Excel, dBASE, or delimited ASCII text data files:

. Making your object key field or column the first one in your file is good practice and the simplest
method for ensuring that Scan/US finds the object keys. In Excel, make sure the database range has the
object keys in its first column.

. Avoid putting text values in numeric fields (i.e count or statistic variables). Non-numeric values
for count or statistic variables are treated as zeros in "QuickLook," and when copied to the clipboard with
the "Copy Data" command. They are treated as null values when analyzed in a thematic view.

. Maintaining your data in sorted order on the object keys will produce the best performance.
. Delete any irrelevant fields or columns.
. For convenience, store the file in CASCANUS\USERDATA so that you can quickly retrieve it.

This directory is one of the QuickPath directories available in the "Load Data" dialog. Scan/US provides
QuickPath directories so you don't have to worry about searching directories to find your files. The user
data directory may be in a different location if you did a custom install. See QuickPaths vs. Directories.

. Do not attempt to modify your files while they are loaded in Scan/US. Doing so will cause erratic
results when viewing or analyzing the data.

See Also

Preparing Excel files

Preparing dBASE files

Preparing delimited ASCII text files
Setting up an existing data file
Using your own data

Working with data



About starter files

Creating a new data file using a starter file
Using your own data
Starter file naming conventions

The starter files contain the actual object keys used in the Scan/US features. They are provided in the
Scan/US package to help you create data files that can be attached to Scan/US features. However,
importing a Scan/US starter file is also a way of adding object keys to existing data files so they can be
attached to Scan/US features.

The files are stored in C:ASCANUS\USERDATA\STARTERS or in the user data directory you defined
when installing the program. They all have a .CSV extension.

Within each file, the keys are sorted numerically. Within this order, they are also structured to reflect their
geographic level of detail. Knowing the structure of the keys will demonstrate more clearly how to
collapse and sort your data. The structure is shown below and samples from the starter files are shown
on the next page.

All the keys are composed of numbers; in some of the files (such as the States and Counties starter files),
object captions have been added to help you identify them. The captions are not used to match keys
between your data files and the feature files. In creating the starter files, a pound (#) sign was added
before the numeric keys so that they are automatically treated as character data in Excel files. For
features smaller than counties (for example, zip code areas) the starter files have been divided by
Scan/US regions.

Each feature type and region has a code which is used in naming the file; these codes are in Starter file
naming conventions and will help you choose the desired file

. States are sorted numerically by FIPS (Federal Information Processing Standard) code. This
order corresponds with an alphabetical sort by state name or abbreviation.

Example: #01
. Counties are sorted by county codes within each state code.

Example: #01 001

ADls, DMAs, and MSAs all have numeric codes for their area definitions.

TCAs are sorted alphanumerically within each Scan/US region code.

Zip code boundaries or centroids are sorted numerically by zip code.

Census tracts are sorted by tract number within each county, then within each state.
Example: #01 001 0201.00

. Block groups are sorted numerically within each tract, within each county, then within each state.
Example: #01 001 0201.00 01

Tips
. To ensure a matching correspondence between the starter file keys and your data records, you
can import the starter file keys into an intermediate file and remove the keys for which you do not have

data. This step is quite helpful when dealing with features having thousands of objects like county codes
or zip codes. Import this intermediate file into your data file.

. Consider creating future data files using the starter files (their intended purpose) and a
correspondence between records is automatically ensured.
. Once your data is set up with matching keys, store the data in CASCANUS\USERDATA or the

user data directory you defined when installing Scan/US.

See Also
Object key formats



Starter file naming conventions

About starter files
Using your own data

The starter files contain the actual object keys used in the Scan/US features. They are provided in the
Scan/US package to help you create data files that can be attached to Scan/US features. However,
importing a Scan/US starter file is also a way of adding object keys to existing data files so they can be
attached to Scan/US features.

The naming codes will help you identify the desired files. The codes tell you the feature's geographic
level, the region for geography smaller than counties, and the update year such as '90 or '92.

Examples: USST.CSV for states
R1_TR90.CSV for census tracts in New York
RM_BG90.CSV for block groups in Colorado, Nevada, and Utah

For more detailed information, please see About starter files.
Feature codes

ST States

CT Counties

AD ADIs (Areas of Dominant Influence)

DM DMAs (Designated Market Areas)

MS MSAs (Metropolitan Statistical Areas)

TC TCAs (TIGER County Aggregates)

ZC 5-digit Zip Code (boundaries or centroids)

TR Census TRacts

MG MicroGrids

BG Block Group centroids

Region codes
0 CT, ME, MA, NH, RI, VT

1. NY
2 NJ,PA

3_  DE, DC, MD, VA, WV
4 GA SC

5 AL, MS, TN

6 IL

7 KY, OH

8 IN,MI

9 MN,WI

A_ TX

B_ OR,WA

C_ CA

D_ AR, LA OK



ND, SD
CO, NV, UT



Structure of Excel data item names

If you want Scan/US to summarize your data, distinguishing between count and statistic variables, and
providing percent views or weighted averages, you must tell Scan/US how to handle each variable.
For Excel files, you can add the necessary information to a column heading with the following syntax:

var name:var caption|count {base var name}
|statistic
var_name

In Excel, Scan/US recommends column headings (i.e. data item names) that contain a short name
and caption separated by a colon(:).

Example: 90AvgHhInc:90 Average Household Income

The name may be up to 15 characters, using only alphanumeric characters and an underscore(_).
var_caption

The caption may be up to 79 characters, using alphanumeric characters and symbols. Note that

very long captions may not be fully displayed in list boxes or in the "QuickLook™" window.

If you do not use the recommended format, Scan/US uses the column heading you provide as a
caption and assigns a name. Text data items are sequentially named, starting with Itm001; numeric
data items, starting with Var001.

For count variables only, you must modify the caption so that the count and percent views are
appropriately identified when variable names are displayed in list boxes or in "QuickLook."

The caption must include two parts separated by a back slash (\). The first part of the caption
references the base variable, and the second part, the sub-population being measured. For
example, 90 Pop\Married results in "90 Pop, Married" to identify the count variable, and in "%
Married of 90 Pop" to identify the percent view of the variable. The full data item name would be:

Example: Married:90 Pop\Married|count{90 Pop}
| count or | statistic

To identify a numeric variable as either count or statistic, add a pipe symbol (|) followed by the word
'count' or 'statistic' to the data item name.

Example: 90AvgHhInc:90 Average Household Income|statistic
base_var_name

You must identify a base variable for Scan/US to calculate a weighted average for statistic variables,
or percent views of count variables. To identify a base variable--which must be in the same data
file--you must add its name enclosed in curly brackets {}.

Example: 90AvgHhInc:90 Average Household Income|statistic{90 Households}

See Also
Preparing Excel files
Modifying Excel data item names to summarize data
Using your own attribute data
Using your own data
Working with data



About datalist description files
A datalist description file enhances the usability of your dBASE or delimited ASCII file with these benefits:

. You can attach longer, more descriptive names to your data variables. For example, you can
display the variable name TMAL_AGE as '94 Median Age, Male." A cryptic variable name becomes a
clear description.
. You can select the variables you want to see in Scan/US and list them in a different order. In
many cases, the person who created the database structure for your file may not have paid much
attention to the way people like to view the data. The datalist description file allows you to list the desired
variables in any order you like.
. You can tell Scan/US to calculate percent views for your count variables. When you view or
analyze the data in Scan/US you'll see count
and percent
buttons preceding the variable names so you can toggle the values.
For example, if you're looking at sales data, you probably have figures for "Total Sales' as well as
figures for each of your salespeople that make up the "Total Sales." If you reference "Total Sales"
as a universe variable for those individual sales figures, you can see those individual sales figures
OR toggle to see them as a percent of "Total Sales."

. You can do "smart" data summaries for the statistic variables (such as "Average Income" or
"Median Income") in your file. When Scan/US summarizes user data variables, they are normally
totaled. However, describing your variable as a "statistic" variable tells Scan/US to calculate an average.
Additionally, declaring a universe variable tells Scan/US to calculate a weighted average.

A datalist description file actually controls your dBASE or delimited ASCII text file and gives you added
capabilities. Having percent views and "smart" data summaries are the most popular reasons for using a
datalist description file.

See Also
Datalist description file structure
Using your own attribute data
Preparing dBASE files
Preparing delimited ASCII text files

Using your own data
Working with data




Datalist description file structure

Sample dBASE structure
Sample ASCII file structure
Sample [Datalist] section
Sample [Dataitems] section

For an overview, please see About datalist description files and Using your own attribute data

A datalist description file is a plain text file--you create or modify using NotePad or another text editor.
The file is structured like an initialization file with sections and settings. Datalist description files are
named after their data files but have different extensions. A .DD1 extension is used for dBASE files

and .DD2 for delimited ASCII text files. Datalist description files are stored in the home directory which is
C:\SCANUS, unless you did a custom install

Datalist description files have two sections, [Datalist] and [Dataitems], which are described below.

[DATALIST] section
Describes defaults that Scan/US uses when loading the data file.

Note All settings in the [DATALIST] section are optional. However, we recommend defining a Key
setting and a Caption setting.

Key=field_name
Names the field containing the_object keys in your data file.

If you omit this setting, Scan/US assumes that the object key field is the first one in your file. For
more information on adding object keys to your file, please see Preparing dBASE files or Preparing
delimited ASCII text files.

Caption="text_string"
Assigns a longer, more descriptive name to your data file. This name is displayed in the Data menu
and "Data Center" dialog.

This setting lets you go beyond the 8-character file name limit. If you omit this setting, Scan/US
creates a caption using the file name with a'_d' added to it.
For example: MYFILE_D

Defaultltem=field_name
Name the data field that Scan/US pre-selects when you open a variable selection dialog such
as"View Variables" or "New Thematic."

If you omit this setting, Scan/US uses the first field in the file.

Feature=caption "text_string" ; (optional display attributes)
For point data files only, this setting assigns a longer, more descriptive name to your file. This hame
is displayed in the "Features Directory" after you load the file.
If you omit this setting, Scan/US uses default naming conventions which you may change from either

the "Features Directory” or the "Map Features" dialog.

Tip You can also include display attributes--the symbol type, visibility setting or label style. Don't
attempt to include them unless you've read SCANUS.TXT and SCANUS1.TXT first. These files are
in C:\SCANUS unless you defined a different home directory in a custom install.

Title=field_name
For point data files only, this setting names the field containing the object names in your file. You can
tell Scan/US to use these names as labels on a map.

If you omit this setting, Scan/US uses the object keys as object names. See also Creating a point
data file.

[DATAITEMS] section



Lists and describes the fields in your data file using the following syntax:

field name="var caption";format;
var_ type{universe}

Settings for the following fields are required:

. The object key field in your data file.
. The LATITUDE and LONGITUDE fields in a point data file.
. All universe variables needed to calculate percent views or weighted averages.

You may omit fields that you do not want to view or analyze. Or, you may hide fields, even the required
ones, by preceding the field name with an ampersand (&). Fields may be listed in any order that suits
your viewing or analysis of them.

field_name=
Use the exact name of the field as it appears in your file.

Example: BLK_POP=

"var_caption”
A longer, more descriptive name assigned to the data variable. The caption may be up to 79
characters, using alphanumeric characters and symbols, and must be enclosed in double quotes.

Example: TMAL AGE="94 Median Age, Male"

Note Very long captions may not be fully displayed in list boxes or in the "QuickLook" window.
Because of kerning, some captions can have more characters than others. To determine the correct
length for a caption, you must see it displayed in Scan/US, then modify it in the datalist description
file.

For count variables only, you must modify the caption so that the count and percent views are
appropriately identified when variable names are displayed in list boxes or in "QuickLook."

The caption must include two parts separated by a back slash (\). The first part of the caption
references the universe variable (see {universe} below), and the second part, the sub-population
being measured. For example, 94 Pop\Black results in "94 Pop, Black" to identify the count
variable, and in "% Black of 94 Pop" to identify the percent view of the variable.

Example: BLK POP="94 Pop\Black"

format
Tells Scan/US how to display the data in "QuickLook" and other listboxes. Use the following syntax:

C(length) For character fields. Length is the number of characters.

If the specified length is smaller than the actual number of characters in the field, Scan/US truncates
the character string and displays an ellipsis (...) to indicate the truncation.

Example: CITY NAME="City name";c(23)

9*n For numeric fields. Use a 9 for every digit you want displayed such as 99999.99. The number
of decimal digits may be less than the number declared in your file.

Commas to separate digits will be available in a future version.
Example: BLK POP="94 Pop\Black";999999999

var_type
Describes the type of data. The choices are ID, COUNT or STAT.

ID variables are alphanumeric identifiers such as names. ID variables are ignored when data is
summarized. By default, all CHARACTER fields are treated as ID variables.

Count variables are numeric variables that are totaled when data is summarized. "Total Population"
or "Population, Black" or "Total Sales" are count variables.

Statistic (or STAT for short) variables are averaged or weight-averaged when data is summarized.
"Average Income" or "Median Age" are statistic variables.



Example: BLK POP="94 Pop\Black";999999999;count

{universe}
Identifies the universe variable for Scan/US to calculate a weighted average for statistic variables, or
percent views of count variables. Use the exact field name--as it appears in your file--enclosed in
curly brackets {}.

Example: BLK POP="94 Pop\Black";999999999;count{TOT_POP94}

See Also

Creating a datalist description file
Using your own attribute data
Preparing dBASE files

Preparing delimited ASCII text files
Using your own data

Working with data



Sample dBASE structure

Let's say your file is called MYFILE.DBF, and it has
the following fields:

Field Name Field Type

CITY CODE Character, 5

CITY NAME Character, 25

LATITUDE Real, 5 decimal places
LONGITUDE Real, 5 decimal places
TOT POP94 Integer

ASPI POP Integer

HSP_ POP Integer

BLK_POP Integer

TMAL MAGE Real, 1 decimal place



Sample ASCII file structure

Let's say your file is called MYFILE.DAT, and it has
the following fields:

Field Name Field Description

CITY CODE Character

CITY NAME Character

LATITUDE Real, 5 decimal places
LONGITUDE Real, 5 decimal places
TOT POP94 Integer

ASPI POP Integer

HSP_ POP Integer

BLK_POP Integer

TMAL MAGE Real, 1 decimal place



Sample [Datalist] section

[Datalist]
Caption="1994 City Data"
Key=CITY CODE

Title=CITY NAME
DefaultItem=TOT POP94

Feature=caption "94 City locations and data"; symb 2-7-6-3



Sample [Dataitems] section

[Dataitems]

&CITY CODE="City ID";c(5);id

CITY NAME="City name";c(23);id

TOT POP94="94 Population";999999999;count

BLK POP="94 Pop\Black";999999999;count {TOT POP94}
HSP_POP="94 Pop\Hispanic";999999999;count{TOT POP94}
TMAL MAGE="94 Median age, Male";99.9;stat
&LATITUDE="City Latitude";999.9999;stat
&LONGITUDE="City Longitude";999.9999;stat



Creating a point data file

A point data file contains coordinates to render point objects on the map. Unlike ASCII text feature files, it
can also have attribute data for each object. For a discussion of file formats, please see:

Preparing Excel files
Preparing dBASE files
Preparing ASCII text files

1 Make sure each location has a unique object key in the first column.
Optional: Create a column named 'Title' for the object names.
2 Create two columns named 'Latitude’ and 'Longitude’ to contain coordinates for each location.
3 Enter the coordinates in decimal format. See Converting to decimal degrees for more information.

. For Excel files only Select all the cells containing the headings, keys, coordinates, and data
variables and save them as a database. In Excel 4.0, use the "Data--Set Database" command. In
Excel 5.0, first choose the "Insert--Name" command, then choose the Define option and type in
database. Scan/US reads only the data in the database range.
4 Save the file.
Excel files Save the file in Excel 4.0 format. If you are using Excel 5.0, choose the file type in
the "Save As" dialog.

ASCII files Save the file with a .DAT extension.

5 Store the file in C:ASCANUS\USERDATA or the user data directory you defined when installing
Scan/US.

6 Load the file in Scan/US.
Note While a point data file is loaded as a feature, its attribute data cannot be loaded onto other layers.

See Also

Importing user data into Scan/US

About geocoding

Adding features to a study area

Adding features to the "Features" Directory"
Automatically loading features

Using your own data

Working with data



Creating a new data file using a starter file

1 Choose the desired starter file.
Read Starter file naming conventions to find the desired file.
2 Open the file.
The object keys are in the first column, and captions, if any, follow it.

. Optional: Rename the column headings if desired.

3 Add your data in the remaining columns.

4 For Excel users only Select the entire range of cells containing the column headings, object
keys, captions, data.

5 For Excel users only Choose the "Set Database" command from the Data menu.
6 Save the file, using the appropriate extension and file type.

7 Close the file to avoid Windows messages about sharing violations.

8 In Scan/US activate the layer and load the file.

See Also

Loading attribute data
About starter files
Using your own data
Working with data



Exporting object keys from Scan/US

To export keys with "Copy List"
1 Choose the desired layer from the window layer box.

2 Define an object set on the layer for the keys you need. Do one of the following:

. Group objects.
. Change the objects' visibility settings.
. Create a thematic view that filters objects.
3 From the Objects menu, choose "Copy List" and the desired option:
Option Result
All Sends a list of all objects on the active layer.
Filtered Active only in a thematic view. This option sends

a list of all objects that are not hidden and which
fall within the minimum and maximum values for
the selected variable.

Grouped Sends a list of objects in the active grouping on
the layer.
Visible ends a list of objects currently visible of the layer.

4 Paste the list into your data file.

To export keys with "Object Manager™
1 Choose the desired layer from the window layer box.
2 Select the objects whose keys you need:

Select objects by clicking on them;
Shift-Click selects multiple objects in sequence;
Ctrl-Click selects multiple objects not in sequence.
When multiple objects are selected, Ctrl-Click undoes a single selection.
The Select menu also provides additional options.
3 From the Action menu, choose "Copy Selected."

4 Paste the list into your data file.

See Also

Working with groups

Turning object visibility on /off
Finding an object on the map
Selecting an object

Working with thematic views
Using your own data

Working with data

Copy List (Objects menu)

Object Manager... (Objects menu




Setting up an existing data file

The following procedure shows you how to set up an existing data file so you can attach it to a Scan/US
feature. The steps are geared to data in an Excel worksheet. The steps are similar for setting up
dBASE or ASCl files.

1

Set up your data so that its order matches the order of the object keys.

Your data must be collapsed and sorted so that each record will get a key, and each key in the key
column will be unique.

Create a column for the keys in the data file.
Make it the first column, preceding all the other data columns.
Import the object keys you need into the new column.

4 For Excel users only Select the entire range of cells containing the column headings, object

0 N O O

keys, captions, data.

For Excel users only Choose the "Set Database" command from the Data menu.
Save the file, using the appropriate extension and file type.

Close the file to avoid Windows messages about sharing violations.

In Scan/US activate the layer and load the file.

See Also

Importing user data into Scan/US
Exporting object keys from Scan/US
Creating a new data file using a starter file
Tips for preparing your data

Loading attribute data

Automatically loading attribute data

Using your own data

Working with data



Modifying Excel data item names to summarize data

For an overview, please read Using your own attribute data
For detailed information, please read Structure of Excel data item names
To modify data item names in Excel

1 Use the recommended name format that contains a short name and caption separated by a
colon(:).

Example: 90AvgHhInc:90 Average Household Income

2 Identify a numeric variable as either count or statistic by adding a pipe symbol (|) followed by the
word 'count’ or 'statistic' to the data item name.

Example: 90AvgHhInc:90 Average Household Income|statistic

3 To calculate a weighted average for statistic variables, or percent views of count variables, add the
base variable name in curly brackets {}.

Example: 90AvgHhInc:90 Average Household Income|statistic{90 Households}
4 For count variables only, modify the caption to identify count or percent views.

The caption must include two parts separated by a back slash (\). The first part of the caption
references the base variable, and the second part, the sub-population being measured. For
example, 90 Pop\Married results in "90 Pop, Married" to identify the count variable, and in "%
Married of 90 Pop" to identify the percent view of the variable. The full data item name would be:

Example: Married:90 Pop\Married|count{90 Pop}

See Also

Preparing Excel files

Using your own attribute data
Using your own data
Working with data



Creating a datalist description file

Sample [Datalist] section
Sample [Dataitems] section

For an overview, please read About datalist description files
For detailed information, please read Datalist description file structure
1 Use only a text editor such as NotePad to create or modify the file.
2 To the [Datalist] section, add a Key setting to identify the object key field.
Example: Key=CITY CODE

3 To the [Datalist] section, add a Caption, enclosing it in double quotes. The caption will be
displayed at the bottom of the Data menu and in the "Data Center" dialog.

Example: Caption="1994 City Data"

4 To the [Dataitems] section, add a setting for the object key field, the LATITUDE and LONGITUDE
fields in point data files, and all data fields needed to calculate percent views for count variables,
and weighted averages for statistic variables.

5 If a percent view is being calculated, modify the variable caption to distinguish between the count
value and the percent view.

Example: BLK POP="94 Pop\Black";999999999;count{TOT POP94}

6 Include the format to display the data in Scan/US.
Example: BLK POP="94 Pop\Black";999999999;count{TOT POP94}

7 If a percent view is being calculated, include the 'count' identifier; 'statistic' for weighted averages.
Example: BLK POP="94 Pop\Black";999999999;count{TOT POP94}

8 Make sure the universe variable is included and enclosed in curly braces for each variable that you
want a percent view or weighted average.

Example: BLK POP="94 Pop\Black";999999999;count {TOT_ POP94}

9 Name the file after your data file and save it with the correct extension--.DD1 for dBASE data,
and .DD2 for delimited ASCII text data.

10 Store the file in C:\SCANUS, or the home directory you defined during a custom install.

See Also

Preparing dBASE files

Preparing delimited ASCII text files
Using your own attribute data
Using your own data
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Working with thematic views

For more detailed information, please read About thematic views.

Creating a thematic view

Analyzing the intersection of two variables
Analyzing groups in a thematic view

Choosing a different datalist for a selected layer
Choosing a different thematic presentation
Modifying a selected variable's presentation
Displaying statistics on a selected variable's values
Copy a selected variable to the clipboard®

Hiding null objects

Hiding a thematic analysis

Modifying a variable's stratification

Selecting strata
Hiding strata
Changing strata limits
Saving strata limits
Loading strata limits

Saving views

Saving a thematic view (kwords are saving; views
Saving scenarios (kwords are saving; scenarios; views



About thematic views

Using thematic views to communicate
Using shades, hues, and patterns in thematic views

Using symbols in thematic views
Working with thematic views

Thematic views are most useful for creating and saving a distribution of your data (theme) as represented
in a map. A thematic view renders the data distribution using colors, patterns, shadings, line styles, and
symbols across one or more map features. For example, the opening study area in Scan/US provides a
map having two features, States and Places 500T+. The data attached to the States layer includes the
variables Total Population and Median Household Income. From this feature and these two variables,
you could create one thematic view in various shades of blue that displayed the total population in each
state. Then in another thematic view, using various shades of green, you could display the median
income for each state. The color shades would reflect the value ranges for each variable; the lighter
shades indicate the lower population and income ranges; the darker shades the higher ranges.

You could also create a third thematic view that showed the relationship between these two variables (for
example, if one were to ask "do the states with the most people have the highest average income?"). In
this case, the total population of each state might be shown in various shades of blue, and the per capita
income values shown as a box graph for each state.

Suppose your target customer earns an income between $35,000 and $50,000. You could repeat the
analysis shown in the preceding examples on a local level such as zip code areas. Seeing on the map
which zip code areas contain the most potential customers and seeing if they cluster together in areas of
greater concentration could help you:

. Decide where to expand your business.
. Focus your advertising dollars.

. Send direct mail.

. Buy billboard space.

The map itself shows you the demographic patterns that match your customer profile. A database report
or pie chart of the zip code areas and their population and income levels would not show you the
proximity of the different areas nor the population density that met your customer profile. Seeing this
information on a map can help you make the more effective decision.



Using thematic views to communicate

About thematic views

Using shades, hues, and patterns in thematic views

Using symbols in thematic views
Working with thematic views

Not only do thematic views show you patterns in your data, but they can also communicate the goal of
your analysis. For example, J&J Video (in the tutorial) created a thematic view to find high-concentration
areas of children under 16 and households with an average income of 25,000+. Seeing the areas in
relation to their competition, they could pinpoint the area and site for their new store, the goal of their
analysis. Then taking the thematic view as a communication tool one step further, they created a
presentation-quality map to show the bank the results of their analysis and to demonstrate the
practicability of giving them a loan.

How well your map conveys information depends on the visual interaction of four factors:

Features (layers) selected for the analysis.

Data variables selected for analysis.

Presentation fills and symbols selected to render the analysis.

Colors selected for the map features, map background, and presentation.

The data variables can be represented as a stratification, or you can render a specific value relative to the
maximum and minimum values. Some count variables can also be shown as a percentage.
Appropriately rendering a variable's stratification, data value, or percentage may require a different
presentation for each one.

Choosing the right thematic presentation also depends on the feature and its size. For example,
rendering a count variable on area objects which are irregular in size and shape (such as census tracts,
Zip code areas, or counties) leads one to think 'bigger is more." This distortion--that the larger the object,
the more people in the area--can be avoided in a number of ways. You can use symbols for the area
objects. Another option is to render the density value (count value/square mile) for the area objects.
Scan/US provides a density fill presentation to help you do this.

Or, you can use a dot density presentation which renders the data value for each area object. The data
are represented by a varying number of dots, each representing the same amount. For example, if a dot
represents 10 people, an area object having 800 people is filled with a random distribution of 80 dots.

Colors communicate

The colors you select also determine how well the thematic map conveys its information. Colors should
be chosen carefully to explain the analysis, not decorate it. For example, pure, bright, and strong colors
have a harsh effect in large areas, or next to each other. But spots of bright colors on a light gray or
muted background can highlight the data and create a more harmonious effect.

Because some colors also have preconceived meanings attached to them, such as blue for water, or red
for danger, avoid using colors in ways that clash with these meanings. Instead, use them to highlight
your analysis. In general, colors found in nature, especially those on the lighter side, such as blues,
yellows, greens, and grays best illuminate information. Nature's colors are familiar, and generally appear
harmonious to the human eye.

Avoid noise

Avoid presentations which add "1+1=3 or more" noise to your analysis. Noise results from the interactive
nature of visual elements--for example, two black lines lead you to see a third bright white path between
the two. The white path, having size, shape and color, becomes a visual element but provides no helpful
information. In thematic views, noise may result from the interaction of object shapes, presentation fills
and symbols, and the colors you select. You can minimize noise by experimenting with different fills, line
styles, colors and symbols to see which ones create a harmonious effect and explain your analysis.

In the illustration, the two black lines create more noise than the gray outlines.






Using shades, hues, and patterns in thematic views

Scan/US provides different ways to present an analysis on area objects. Here are some guidelines to
make an analysis more obvious:

Use a monochromatic color scheme, lighter and darker shades of a single hue, to present a stratification.
A monochromatic scheme is helpful when some objects have numerically high values, and others have
comparatively low values. On the map, readers easily understand that objects rendered in lighter shades
have values in the lower strata; objects in darker shades have values in higher strata.

Different hues, such as red, green, purple, or brown are generally assumed to represent different
categories, rather than numerical ranking. Use different hues to differentiate regions such as groups of
objects or sales territories.

Fill patterns also indicate qualitative differences between regions. Patterns are often shown in land use
and soil maps to represent different terrain. For example, sandy soil may be rendered in a dot pattern,
and clay soil in a striped pattern. You can also use patterns to distinguish regions when printing on a
black-and-white printer. Transparent patterns, through which you can see the background, can
highlight an analysis using a monochromatic or color scheme.

See Also
Working with thematic views

Using symboals in thematic views
Using thematic views to communicate
Tips for creating thematic views




Using symbols in thematic views

Symbols are most often used to represent data for point objects, but are sometimes used for area objects
because symbols are independent of object size and shape. Like colors, symbols can present
quantitative, as well as qualitative differences in your data. For example, symbols can easily present a
stratification when the set of symbols have the same shape but vary in size. Readers can assume that
larger symbols represent higher strata.

Symbols of the same size but varying in color or shape can show qualitative differences in your data.
For example, blue circles can present gas stations with self-service only, green circles self- and full-
service, and yellow circles self- and full- service, and a mini-mart. Or you can use circles, triangles, and
squares respectively.

Symbols are, generally, more easily distinguished and easier to compare over a small number of
objects. Variation in size is also reduced by a low-resolution screen. A high resolution screen can help
you see more of the differences between the data represented by the symbols.

See Also
Working with thematic views
Using shades, hues, and patterns in thematic views
Using thematic views to communicate
Tips for creating thematic views




Tips for creating thematic views

About thematic views
Using thematic views to communicate
Using shades, hues, and patterns in thematic views

Using symbols in thematic views
Working with thematic views

Data

. Experiment with strata ranges until the view indicates exactly what you want it to show.
Tables and maps are usually scanned by the 'hurrying eye' moving quickly from one visual element
to another. Your analysis should draw a response within 10 seconds or less to invite further study.

Presentations

. Choose presentations which encourage ease of comparisons, such as choosing symbols which
vary in size so that they are easily distinguished.

. Use box graphs or dot density markers for a small number of objects with irregular shapes and
sizes.

. Box graphs on a single object can be compared to each other when each measures an index,
such as the success of different products within an area.

. Avoid an excessive use of patterns or transparencies to minimize noise.

. Use only the label name in a normal font and/or on a background color to display object labels.

A stylized label with an underline or drop-shadow is best used to emphasize a single object or two.
Colors

. The higher the contrast between the background and map features and symbols, the more noise
results.

. Minimize the number of colors to establish a relationship between color and meaning. Limiting
your use of color also maximizes its impact.

Printing

. Experiment with color and symbol palettes until you have a set that looks great printed. Save the
palettes so you can re-use them.

. An effective title for a printed map can help make an analysis obvious to your readers.

. Use a white background if printing on a black and white printer.



Creating a thematic view

1 From the Views menu, choose "View Variables...."

Tip To create the view in its own window, choose "New Thematic...."

Optional: Enter a different name from the preassigned one.
Select the layer you want thematically displayed.
Optional: Click the "Data Center" button to choose a different datalist to analyze for the layer.

3 Select the variables you want analyzed for the layer.

A single click selects the first variable. Shift-Click to select more than one variable in sequence;
CtrIClick to select more than one variable not in sequence.

. Optional: Repeat steps 2 and 3 for each layer and variable you want thematically analyzed.
4 Clear the "Show layer variables" option for all layers you do not select.
. Optional: Click the "Gallery" button to choose a different thematic presentation from the
reselected one in the "Scan/US Gallery."
el
B
(The sample shown in your dialog may be different.)
. Optional: Click the "Strata Manager" button to change the preset stratification of the selected

variables in the "Strata Manager."

5 Click "OK."
Tip If the the map legend is hidden, display it by choosing "Show Legend" from the Options menu.

See Also
About thematic views
Working with thematic views




Analyzing the intersection of two variables
This procedure shows you how to find a set of objects that meet two criteria.
1 From the Views menu, choose "View Variables...."
2 Choose the layer you want to analyze.
3 Choose two variables to analyze.
Click to select the first variable; CtriIClick to select the second variable not in sequence.
4 Open the "Scan/US Gallery" and choose the Density Fill w/ Overlay presentation.
* "Gallery" button. (The sample shown in your dialog may be different.)

. Optional: If necessary, switch the order of the variables by dragging-and-dropping to the right
position.
5 Open the "Strata Manager" and change the variables' stratification.

* "Strata Manager" button
6 Click "OK" to close the dialogs.

See Also

Working with thematic views
Creating a thematic view
Choosing a different thematic presentation

'Scan/US Gallery" dialog

'Strata Manager" dialog



Analyzing groups in a thematic view

1 From the Views menu, choose "View Variables...."

2 Choose a layer with groups present that you want to analyze.
3 Choose the "Grouped objects in grouping” option.

4 Choose the desired grouping.

5 Complete your selections to create a thematic view.

See Creating a thematic view

See Also

Working with thematic views

Working with groups
View Variables... (Views menu)




Choosing a different datalist for a selected layer

1 From the Views menu, choose "View Variables...."

2 Choose a layer.

3 Click the "Data Center" button to open the dialog.

4 From the list, choose the desired datalist or load another datalist.
5 Close the "Data Center".

6 Complete your selections to create a thematic view.

See Creating a thematic view

See Also
Working with thematic views
Working with data
Activating a different datalist
Loading attribute data
View Variables... (Views menu

Data Center... (Data menu)




Choosing a different thematic presentation

For an overview, please read About thematic presentations.
1 From the Views menu, choose "View Variables...."
2 Click the "Gallery" button to open the "Scan/US Gallery."

Note The sample you see on the button in the dialog may be different.
3 Scroll through the samples until you find the desired presentation.
4 Click on the presentation sample and click "OK."

See Also

Working with thematic views
Modifying a selected variable's presentation

'Scan/US Gallery" dialog



About thematic presentations

Scan/US provides thematic presentations which render a variable's strata or which indicate an object's
value relative to the minimum and maximum values specified for the set of objects being analyzed.

Using these presentations, Scan/US provides preset combinations that allow you to analyze up to six
variables in a map. Most likely you will not render this many variables; most thematic maps that
communicate well include only a few variables to ensure readability and ease of interpretation. The
combinations have been designed with this in mind and provide an optimum set to choose from.

When you have selected the variables you want analyzed, Scan/US preselects a presentation. A sample
is shown on the face of the "Gallery" button. You can choose another presentation in the "Scan/US
Gallery" dialog which also provides a description of each presentation.

Having selected a thematic presentation for the variables being analyzed, you can change a variable's
presentation in the "Strata Manager" dialog. If more than one variable is selected, changing their listed
order in the "Scan/US Gallery" also changes a variable's presentation.

See Also
Working with thematic views
Choosing a different thematic presentation
Modifying a selected variable's presentation
"Scan/US Gallery" dialog

'Strata Manager" dialog




Modifying a selected variable's presentation

For an overview, please read About thematic presentations.
To modify the presentation in the "Strata Manager"

1 From the Views menu, choose "View Variables...."

2 Click the "Strata Manager" button to open the dialog.

3 Select the desired variable from the drop-down list.

4 Click the "Presentation" button to change the presentation's rendition. The button may look like
one of the following:

. opens the "Palette Selector" dialog.

opens the "Dot Density" dialog.

opens the "Proportional Marker" dialog.
5 Change the rendition as desired.

6 Click "OK."

To modify the presentation in the "Scan/US Gallery"” when multiple variables are selected
1 From the Views menu, choose "View Variables...."
2 Click the "Gallery" button to open the "Scan/US Gallery."

(The sample you see on the button in your dialog may be different.)

In the variable's list box, notice the icons indicating each variable's presentation.
3 In the variable's list box, drag-and-drop the variable so that it is positioned next to the desired icon.
4 Click "OK."

See Also

Working with thematic views

Choosing a different thematic presentation
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Displaying statistics on a selected variable's values

1 From the Views menu, choose "View Variables..."
2 Click the "Strata Manager" button to open the dialog.

3 Select the desired variable from the drop-down list.
4 Click the "QuickStats" button.

=

5 ' Click anywhere inside the "Strata Manager" to close the statistcs box.

See Also
Working with thematic views

'Strata Manager" dialog
View Variables... (Views menu

Copy Variable... (Views menu




Copying a selected variable to the clipboard

Copies a list of objects and their values for the selected variable. You can paste them into other
Windows applications, including them in reports or other presentations of your data.

1 Create a thematic view with the desired variables and stratification.
2 From the Views menu, choose "Copy Variable..."
3 Choose the set object whose values you want to copy.

This option Does this

Objects in All Strata Copies the values for objects in all strata.

Objects in Selected Copies the values for objects in selected strata.

Strata
. To select a strata, click on its name; Shift-Click to select multiple strata in sequence; Ctrl-Click to
select multiple strata not in sequence.
. Optional: If you choose "Obijects in All Strata," you may also include a table of strata ranges
defined in the "Strata Manager" and statistics on the selected variable.
4 Click "OK."

Tip Avariable's strata can also be used to group objects. See Copying and pasting group assignments
and Grouping by a variable's stratification

See Also
Working with thematic views

'Strata Manager" dialog
Copy Variable... (Views menu




Hiding null objects

Changing the maximum and minimum limits or hiding strata excludes objects from the analysis; they're
called null objects. The remaining objects are filtered objects. You can hide null objects or display them
in their original rendering.

1 From the Views menu, choose "View Variables..."
2 Click the "Strata Manager" button to open the dialog.

3 Define null objects.
If necessary, see Hiding strata or Changing strata limits

4 Click the loop-arrow button to toggle from the rendering sample to a shade.

See Also
Working with thematic views

'Strata Manager" dialog
View Variables... (Views menu



Hiding a thematic analysis

Scan/US allows you to hide the variables selected for an analysis. You may hide the variables all at once
or hide specific layers.

To hide variables selected for a layer

Use this to fine-tune an analysis. When you have several layers, hiding one or more provides a less
cluttered and more readable map.

1 From the Views menu, choose "View Variables..."
2 Select the desired layer from the drop-down list.
3 Unmark the "Show layer variables" option.

. Optional: Repeat steps 2 and 3 for each desired layer.
4 Click "OK"
To hide all variables

Use this when you need to display a grouping and the thematic analysis uses a fill color or pattern which
obscures the grouping.

. From the Views menu, choose "Hide Thematic."
Note Choosing "View Variables..." automatically activates the "Show Thematic" command to display
the analysis.

Tip If you wish to see a thematic analysis using a fill color or pattern and a grouping a the same time,
you can do the following:

. Create them in separate windows, then tile them using "Tile..." or "Tile All" in the Window menu.
. Display the thematic analysis with a transparent pattern so that you can see the grouping through
the transparent background.

See Also
Working with thematic views
Choosing a different thematic presentation
Modifying a selected variable's presentation
Changing group rendering
New Thematic... (Views menu)

Hide Thematic & Show Thematic (Views menu)




Selecting strata
For an overview, please see Modifying a variable's stratification.

Strata panel with a selected limit bar
1 From the Views menu, choose "View Variables..."
2 Click the "Strata Manager" button to open the dialog.

3 Do one of the following:

. Click on a limit bar.

. Click on a section in the strata panel.
. Click on a limit value.

See Also
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Hiding strata
For an overview, please see Modifying a variable's stratification.

Hiding strata is a useful way of focusing an analysis to a specific set of objects. Strata can be hidden
only when a variable's strata, instead of data values, are being rendered by the thematic presentation.

1 From the Views menu, choose "View Variables..."
2 Click the "Strata Manager" button to open the dialog.

3 Click on the presentation icon next to the desired stratum.
A window shade replaces the presentation icon next to the stratum.
Tip You can show a hidden stratum by clicking on the shade.

See Also
Working with thematic views
"Strata Manager" dialo

"Scan/US Gallery" dialog
View Variables... (Views menu)




Changing strata limits

Changing the maximum and minimum limits or hiding strata excludes objects from the analysis; they're
called null objects. The remaining objects are filtered objects.

To change a single stratum's limits
1 From the Views menu, choose "View Variables..."
2 Click the "Strata Manager" button to open the dialog.

3 Select a stratum.
If necessary, see Selecting strata.
4 Change the limit by doing one of the following:

Drag the limit bar upward to increase the value; drag downward to decrease the value.
. Click on a limit value and type in a new value.

Note The maximum and minimum values of a variable are set according to the data; you cannot
increase the maximum, nor decrease the minimum.
To change all limits

1 From the Views menu, choose "View Variables..."
2 Click the "Strata Manager" button to open the dialog.

3 Do one of the following

. Click the plus and minus buttons to increase and decrease the number of strata.
5
The limit values change according to the number of strata.
. Click the "Qtiles" button so that each stratum has the same number of objects.
The limits are not evenly divided.
. Click the "Scale" button so that each stratum's limits are evenly divided.

The number of objects in each stratum are not the same.
Click the "Reset" button to display the default stratification of five quintiles.
Load a saved set of limits.

If necessary, see Loading strata limits.

See Also
Working with thematic views
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Saving strata limits

Saving strata limits is a way of using the same stratification for the same variable in different study areas,
or a stratification of percentages (e.g. 0, 20, 40, 60, 80, 100) for different variables.
1 From the Views menu, choose "View Variables..."

2 Click the "Strata Manager" button to open the dialog.

3 Define the stratification and change its limit values as desired.

If necessary, see Changing strata limits.
4 Click the "Library..." button.

The stratification values are dimmed because they can be edited only in the "Strata Manager."
5 Type a name for the stratification set.
6 Click the "Save" button.

See Also
Working with thematic views
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Loading strata limits

You can load a previously saved set of limits.
1 From the Views menu, choose "View Variables..."
2 Click the "Strata Manager" button to open the dialog.

3 Click the "Library..." button.
4 Click on the name of the desired set.
5 Click the "Load" button.

See Also
Working with thematic views
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Changing the map display
For an overview, please read About map display

Changing borders

Changing fill colors

Changing fill patterns and transparencies
Changing line styles

Changing symbols

Changing labels

Changing group rendering

Modifying a selected variable's presentation
Hiding map elements

Showing hidden map elements

Moving map elements

Changing the map background

Displaying a lat/long grid in a map window
Changing the map legend

Using palettes

Creating a palette

Modifying a palette
Changing the preset palettes
Deleting a palette



About map display

All Scan/US maps are initially generated with a preset display attributes so that you can focus on data
analysis, rather than 'map looks.! However, you can change the appearance of a map to suit your
preferences by:

Modifying the features' display attributes.

Choosing a different background color.

Changing coordinate display.

Displaying a lat/long grid.

Creating or modifying a palette.

You can also create different views of a study area to try out different map presentations.--Choose the
"New Thematic..." command from the Views menu to create a new window for each alternate
presentation. In each window, clear the "Show layer variables" option for each feature layer in the map.
Then open the "Map Features" dialog, and modify the display attributes as desired. Next, choose the
"Tile" or "Tile..." command from the Window menu to compare the different views.

If you are changing display attributes in a thematic view or to convey information, please see "Creating
thematic views" in the User's Guide some guidelines.

Changing a feature's display attributes

When you add features to a map, the fills, borders, lines, symbols, and labels which display the objects on
the map are preset by Scan/US. You may use these preset values or override them during a session in
the following dialogs:

. "Features Directory" lets you preset features' display attributes before they are added to study
areas, or for future sessions.

. "New Map Features" lets you to change features' display attributes when creating a new study
area.

. "Map Features" lets you change features' display attributes after creating a study area.

. "New Layer" lets you preset display attributes for the editable features you create.

. "New Grouping" lets you preset group display attributes before creating groups.

. "New Group" lets you change group display attributes when creating a new group.

. "Group Manager" lets you change group display attributes after creating the groups.

. "Palette Selector" lets you create and edit display elements to apply to groups and thematic
views.

These dialogs include an object or label button which shows a sample of the display attributes.
Examples: # & & =

Clicking a button opens a selector dialog in which you can modify the display attributes. For more
information, please see Using selector dialogs.



Changing borders

1 From the Map menu, choose "Map Features...."
2 Click on the object button of the feature whose border you want to change.

Example: = or @

3 Click the "Borders" button in the "Area Fill Selector" dialog.

=]
4 Click on the desired border.

Note The first and sixth border choices are displayed with the same width on your screen. When
printed, the first border is printed as a hairline, and the sixth border is printed slightly wider--unless
your print driver cannot interpret hairlines.

5 To choose a color for the border, click the arrow button to display a palette then select the desired
color.

6 Click "Select," or drag-and-drop to the "Map Features" dialog.
7 To display the map with your selections, click "Update" in the "Map Features" dialog.

See Also
Changing the map display



Changing fill colors
1 From the Map menu, choose "Map Features...."
2 Click on the object button of the feature whose fill color you want to change.
Example: = or =
3 Click the "Colors" button in the "Area Fill Selector" dialog.

[
4 Click on the color you want.

5 Click "Select," or drag-and-drop to the "Map Features" dialog.
6 To display the map with your selections, click "Update" in the "Map Features" dialog.

See Also
Changing the map display



Changing fill patterns and transparencies

Scan/US provides two types of fill patterns: patterns for which you can select foreground and
background colors, and transparencies for which you select a foreground color on a transparent
background.

1 Choose "Map Features..." from the Map menu.
2 Click on the object button of the feature whose area fill you want to change.
Example: = or =

3 Click on the "Patterns" or "Transparencies" button in the "Area Fill Selector" dialog.

7 .
Patterns Transparencies
4 Click on the desired pattern or transparency.

5 Choose foreground and background colors for the pattern.
OR
Choose a foreground color for the transparency.
6 Click "Select," or drag-and-drop to the "Map Features" dialog.
7 To display the map with your selections, click "Update" in the "Map Features" dialog.

See Also
Changing the map display



Changing borders and fills shortcut

You can combine procedures and change borders and fills in the same procedure.

1
2

From the Map menu, choose "Map Features...."

Click on the object button of the feature whose area fill you want to change.
Example: = or »

First choose the border and its color.

For this shortcut to work, the border must be defined first. When you define the fill before the
border, only the border selections are updated, and you must repeat the procedure to change the
fill.

Next choose a fill color, pattern, or transparency and define colors for them.
Click "Select" or drag-and-drop to the "Map Features" dialog.
To display the map with your selections, click "Update" in the "Map Features" dialog.

See Also
Changing the map display



Changing line styles
To change a feature with a single road type
1 From the Map menu, choose "Map Features..." .
2 Click on the object button of the feature whose line style you want to change.
Example: =
3 Choose a new style in the "Line Style Selector" dialog.

. Optional: Choose foreground and background colors for the line style.

. Optional: Check the "Dashed" option to use a transparent background for dashed lines.
4 Click "Select," or drag-and-drop to the "Map Features" dialog.

5 To display the map with your selections, click "Update" in the "Map Features" dialog.
See Also

Changing the map display
Group Manager... (Groups menu

Working with groups



Changing symbols
1 From the Map menu, choose "Map Features..." .
2 Click on the object button of the feature whose symbol you want to change.

Example: |Z|

3 Choose a new symbol in the "Symbol Selector" dialog.
4 To choose colors for the symbol's parts, click on the arrow button to display a palette of colors, then
click on the color you want.

Border
Outer shape

Center
5 Click "Select," or drag-and-drop to the "Map Features" dialog.

6 To display the map with your selections, click "Update" in the "Map Features" dialog.

See Also
Changing the map display



Changing labels
1 From the Map menu, choose "Map Features...."
2 Click on the label button of the feature you want to change.
3 In the "Label Syle Selector" dialog, choose a new format, font, style, or colors for the label.
Click on the arrow button to display the available options, then click on your selection.

. Optional: Choose a different alignment for point objects.

. Optional: Check the "Show Ties" option to display a thread between moved labels and their
objects.

4 Click "Select" to display your selections in the "Map Features" dialog

5 To display the map with your selections, click "Update" in the "Map Features" dialog.

See Also

Changing the map displayChanging_the_map_display
Select--Label submode



Hiding map elements

To hide features
1 From the Map menu, choose "Map Features..."

2 Shift-Click on the object or label button preceding the feature name.
Examples; ®, & = »
3 Click "Update."
To hide groups
1 From the Groups menu, choose "Group Manager..."
2 Shift-Click on the object button preceding the group name.
To hide specific objects, labels, or thematic charts
1 From the Objects menu, choose "Object Manager..."
2 Select the desired object names from the list.

Click to select a single name; Shift-Click to select multiple names in sequence; Ctrl-Click to select
multiple names not in sequence.

3 Click the = button next to the visibility icon to hide the selected objects

= their labels
+ or thematic charts
[ ]

OR

1 Activate Select mode ».
2 Activate the desired submode:

* to select objects.
* to select labels.
* to select thematic charts.
3 In Label or Graphic submode, activate the desired layer.

4 With the right mouse button select the desired map element (i.e. label in Select--Label submode).
5 From the popup choose the hide option.

Note If an object, its label and its thematic chart are all hidden, you can show them from the "Object
Manager."

To hide all objects, all groups, or all labels on a layer
1 From the Map menu, choose "Map Features..."

2 Select a feature with the right mouse button to display a popup
3 Do one of the following:
Choose This To Do This

Hide Objects Hide all objects on the layer.
Same as hiding a feature.

Hide Labels Hide all labels on the layer.
Hide Groups Hide all groups on the layer.

Note Choosing "Hide Objects" or "Hide Labels" when all objects or labels are visible turns OFF their
visibility settings in the "Object Manager." If only some objects or labels are visible when you choose
the option, they are hidden but the visibility settings are unaffected.

To hide the map legend

. Double-click on the legend.
To show it, choose "Show Legend" from the Options menu.



See Also
Showing hidden map elements
Changing the map display
Working with map features
Working with groups
Working with objects



Showing hidden map elements

To show features
1 From the Map menu, choose "Map Features..."

2 Click on the window shade preceding the feature name. The object or label sample is shown on
the button.

Examples: ®, & = »
3 Click "Update."
To show groups
1 From the Groups menu, choose "Group Manager..."
2 Click on the window shade preceding the group name.
To show specific objects, labels, or thematic charts in the "Object Manager”
1 From the Objects menu, choose "Object Manager..."
2 Select the desired object names from the list.

Click to select a single name; Shift-Click to select multiple names in sequence; Ctrl-Click to select
multiple names not in sequence.

3 Click the = button next to the visibility icon to show the selected objects

= their labels
+ or thematic charts
L ]

To show objects using Select mode
Follow these steps if the hidden objects' labels are displayed. If the objects and labels are both hidden,
you can show them from the "Object Manager" (preceding procedure).

1 Activate Select mode =.
2 Activate Label submode:

3 Activate the desired layer.

4 With the right mouse button select the desired label.

5 From the popup choose the "Show Object" option.
To show thematic charts using Select mode

. If the object is hidden and label displayed, follow the steps in the preceding procedure. A
thematic chart can only be shown when its object is also visible. Then, choose the "Show Chart" option.
. If the object is displayed, follow these steps:

1 Activate Select--Graphic submode.
[ ]

2 Activate the desired layer.

3 Click on an object to show its chart.

To show labels using Select mode

. If the object is hidden, you must use the "Object Manager" to show the labels. See the above
procedure.

. If the object is displayed, follow these steps:

1 Activate Select--Label submode.

2 Activate the desired layer.
3 Click on an object to show its label.



To show all objects, all groups, or all labels on a layer
1 From the Map menu, choose "Map Features..."

2 Select a feature with the right mouse button to display a popup
3 Do one of the following:
Choose This To Do This

Show Objects Show all objects on the layer.
Same as showing a feature

Show Labels Show all labels on the layer.
Show Groups Show all groups on the layer.

Note Choosing "Show Obijects" or "Show Labels" when all objects or labels are hidden turns ON
their visibility settings in the "Object Manager." If only some objects or labels are hidden when you
choose the option, the visibility settings are unaffected.

To show the map legend
. Choose "Show Legend" from the Options menu.

See Also

Hiding map elements
Changing the map display
Working with map features
Working with groups
Working with objects



Moving map elements

To move horizontal labels
1 Activate Select--Label submode.

2 Activate the desired layer
3 Drag the label to its new position.

4 To display a thread between the label and its object center, select the label with the right mouse
button.

5 Choose "Show Ties" from the popup.
To move rotated labels
1 Activate Select--Label submode to move labels.

2 Activate the desired layer

3 Select the desired label.

4 Click in another position along the street segment.
The label is displayed in that position.

Note You must change a rotated label to a horizontal one so you can drag it away from the street
object. Select the rotated label with the right mouse button, then choose "Show Ties" from the
popup. Then, drag the horizontal label to the desired position.

To move thematic graphics

1 Activate Select--Graphic submode to move thematic graphics.

2 Activate the desired layer
3 Drag the graphic to its new position.

4 To display a thread between the graphic and its object center, select the graphic with the right
mouse button.

5 Choose "Show Ties" from the popup.
To move the map legend
Position the cursor on the legend, then drag it to the desired position.

See Also

Changing the map display
Select--Label submode

Select--Graphic submode



Changing the map background
1 From the Options menu, choose"Background..."
2 Click on the desired color.

* Optional: Mark the "Set Default" option to make the color the preset background for all subsequent
map windows and all future sessions.
3 Click "OK."

See Also
Changing the map display



Displaying a lat/long grid in a map window
1 From the Options menu, choose "Lat/Long..."
2 Check the box for "Show latitude/longitude grid."

3 Choose a display option.
You can show the grid in the foreground or background, or choose the replace the lines with

tickmarks.
. Optional: Choose a color or line style for the grid. A yellow, solid line is preset.
. Optional: Check "Set Default" to make your selections preset for the rest of the session and

future sessions.
4 Click "OK."

See Also

Changing the map display
Lat/Long... (Options menu)



Changing the map legend
1 From the Options menu, choose "Legend..."
OR
Click on the map legend with the right mouse button.
2 In the "Edit Legend" list box, you can do the following:

To do this Click this item

Display an entry * Toggles to a check mark.

Hide an entry W Toggles to a shade.

Modify an entry Click on the entry to open an edit box with

'okay' # and 'undo' = buttons. Type a new
name then click the 'okay' button.

3 Click "OK" to save your entries and view the legend.

Note If the legend is hidden, choose "Show Legend" from the Options menu to display it.

See Also

Changing the map display
Legend... (Options menu



Creating a palette

You can create your own palettes to override the preset ones Scan/US provides for groups and thematic
presentations. For more information, please see About palettes

To open the "Palette Selector”
1 From the Options menu, choose the "Palettes..." command.
OR
Click the "Palette" button is in the "New Grouping" and "Strata Manager" dialogs.
.
To create the palette
2 Choose the desired palette class in the "Palette Selector" dialog.
3 Click the "New>>" button to display an empty work area palette

A selector dialog is also opened according to the current palette class. For example, if the class is
AreaFill, the "Area Fill Selector" dialog is opened.

4 Define the new element in the selector dialog.
For more information, see Using selector dialogs .
5 Drag-and-drop the defined element to a cell in the work area palette.
6 Repeat steps 4 and 5 for each desired element in the new palette.
7 Click inside the name text box and type a name for the palette.

Note Avoid beginning palette names with an underscore (_) so you can easily distinguish the
palettes you create from the Scan/US built-in palettes.

8 Click "OK" to save the palette.
To activate the palette

9 Click on the palette to highlight it.

10 Click the "Select" button.

See Also

Changing the map display
Modifying a palette

Changing the preset palettes
Palettes... (Options menu

New Grouping... (Groups menu

'Strata Manager" dialog



Modifying a palette
Follow these steps to edit an existing palette. Note that you cannot modify a built-in Scan/US palettes,
however, it can be used as a starter palette to create your own.
1 From the Options menu, choose the "Palettes..." command.
OR
Click the "Palette" button is in the "New Grouping" and "Strata Manager" dialogs.

2 Select the desired palette class in the "Palette Selector" dialog.
3 Select the desired palette.
4 Click the "Edit>>" button to display the elements in the work area palette.
5 Select the element you want to modify in the work area palette.
6 Make the desired changes in the selector dialog.
For more information, see Using selector dialogs .
7 Click the "Select" button, or drag-and-drop to the selected cell.
The element is updated in the work area palette.
. If you selected a Scan/US palette, name the palette.
8 Click "OK" to save your changes and close the work area palette.
Tips

You can insert an element by dragging-and-dropping to a filled slot. Elements are moved to the right to
make room for the new element.

To remove an element, drag it off the work area palette.

See Also

About palettes

Creating a palette

Changing the preset palettes
Palettes... (Options menu

New Grouping... (Groups menu)

'Strata Manager" dialog
Changing the map display



Changing the preset palettes

Scan/US has preselected palettes to render groups and thematic presentations. You can make the
palettes you create the preset ones.

1 From the Options menu, choose the "Palettes..." command.
OR

Click the "Palette" button is in the "New Grouping" and "Strata Manager" dialogs.

2 Select the desired palette class in the "Palette Selector" dialog.

3 Select the desired palette.

4 Check the "Thematic" option to preset the palette for a thematic presentation.
OR
Check the "Groups" option to preset the palette to display groups.

5 Click "OK" to save your selections.

See Also

About palettes
Creating a palette

Modifying a palette
Palettes... (Options menu)

New Grouping... (Groups menu
1

'Strata Manager" dialog
Changing the map display




Deleting a palette
Follow these steps to delete any palette you create.
1 From the Options menu, choose the "Palettes..." command.
OR
Click the "Palette" button is in the "New Grouping" and "Strata Manager" dialogs.

2 Select the desired palette class in the "Palette Selector" dialog.
3 Select the desired palette.

4 Click the "Delete" button to remove the palette.

See Also

About palettes
Creating a palette
Modifying a palette

Changing the preset palettes
Palettes... (Options menu)

New Grouping... (Groups menu

'Strata Manager" dialog
Changing the map display




Using selector dialogs

The selector dialogs allow you to modify a feature's display attributes. You can open the following
selector dialogs:

"Area Fill Selector" for area objects

"Symbol Selector” for point objects

"Line Style Selector"” for line objects
"Label Style Selector" for object labels
The selector dialogs can be opened from the following dialogs

* "Map Features"
"New Map Features." opened in "New Study Area" dialog

'Features Directory"

'New Layer"

'New Group"

'Group Manager"
"Palette Selector"

Ky
Each selector dialog provides a loop-arrow button which toggles between a sample of the current
selection and the underlying codes which Scan/US reads. Viewing the sample can help you make the
right selections.

Each selector dialog provides a "Select" button to add your choices in the originating dialog--from which
the selector dialog was opened. You can also drag-and-drop your choices to the feature or group name
in the dialog. Confirming your selections in the originating dialog updates the map.

See Also
Changing the map display



"Area Fill Selector” dialog

Open this dialog to change the borders and fills of area objects. You have the following options:

* Borders
Click the button to display a selection of borders in different line widths and styles. An option is also
provided to hide borders ====. Select a new border by clicking on the desired selection, then
choose a color for it.

Note The first and sixth border choices are displayed with the same width on your screen. When
printed, the first border is printed as a hairline, and the sixth border is printed slightly wider--unless your
print driver cannot interpret hairlines.
s Colors

Click this button to display a selection of colors. Select a new color by clicking on the desired one.

+ Patterns
Click this button to display a selection of patterns. You can also choose foreground and background
colors to render the pattern. Select a new pattern by clicking on the desired one, then choose colors

* Transparencies
Click this button to display a selection of patterns with transparent backgrounds. You can a choose
foreground color to render the pattern. Select a new transparent pattern by clicking on the desired
one and choose a color.

After choosing a border or fill, click "Select" to change the attributes in the originating dialog. Or,
drag-and-drop your selection to the feature or group name in the dialog.

Tip
To quickly change both the border and fill, you must select the border first, then the fill. Click "Select"
only after choosing the fill, or drag-and-drop to the originating dialog.

=== Border foreground color
Lets you choose a foreground color for dashed line borders. Click the down arrow button to display a
palette of 16 colors to choose from.

=== Border background color
Lets you choose a background color for dashed line borders. Click the down arrow button to display
a palette of 16 colors to choose from.

@ pattern foreground color
Lets you choose a foreground color for fill patterns and transparencies. Click the down arrow button
to display a palette of 16 colors to choose from.

# Pattern background color
Lets you choose a background color for patterns. This option is not available for transparencies.
Click the down arrow button to display a palette of 16 colors to choose from.

Toggles between a sample of the current selection and the underlying codes which Scan/US reads.
Viewing the sample can help you make the right selections.

See Also

Using selector dialogs

Changing the map display

Changing borders

Changing fill colors

Changing fill patterns and transparencies



"Line Style" Selector dialog

Open this dialog to change the line style and color that represent line objects. Select a new line style by
clicking on the desired one and choose a color for it. Click "Select" to change the attributes in the
originating dialog. Or, drag-and-drop your selection to the feature or group name in the dialog.

L
Toggles between a sample of the current selection and the underlying codes which Scan/US reads.
Viewing the sample can help you make the right selections.

* Border foreground color
Lets you choose a foreground color for dashed and bordered line styles. Click the down arrow

button to display a palette of 16 colors to choose from.

* Border background color
Lets you choose a background color for dashed and bordered line styles. Click the down arrow
button to display a palette of 16 colors to choose from.

Dashed
Check this option to use a transparent background for a dashed line style.

See Also

Using selector dialogs
Changing the map display
Changing line styles



"Symbol Selector" dialog

Open this dialog to change the shape and colors for symbols that represent point objects. You can
choose a color for each of the symbol's parts, its outer border, inner shape, and center. Sometimes a
symbol's inner shape has two parts; in this case, the colors alternate between the inner shape and center.

Select a new symbol by clicking on the desired shape; if necessary, scroll through the available choices.
Choose colors for the symbol. Click "Select" to change the attributes in the originating dialog.  Or,
drag-and-drop your selection to the feature or group name in the dialog.

Outer border
Lets you choose a color for the symbol's outer border. Click the down arrow button to display a

palette of 16 colors to choose from.

Inner shape
Lets you choose a color for the symbol's inner shape. Click the down arrow button to display a

palette of 16 colors to choose from.

Center
Lets you choose a color for the symbol's center. Click the down arrow button to display a palette of

16 colors to choose from.

Toggles between a sample of the current selection and the underlying codes which Scan/US reads.
Viewing the sample can help you make the right selections.

See Also
Using selector dialogs
Changing the map display
Changing symbols



"Label Style Selector” dialog
Open this dialog to change the appearance of object labels. You can change the label's format, font,
style, and highlight.

To change a label, make your selections from the drop-down lists. Click the "Select" button to change
the attributes in the originating dialog. You have the following options:

Toggles between a sample of the current selection and the underlying codes which Scan/US reads.
Viewing the sample can help you make the right selections.

Label format
Click the down arrow button to display a list of formats to choose from.

Available formats vary according to the feature. All features have at least one format, the object key,
which is a numeric identifier. Additional formats are text strings which name or describe an object.
For example, the states feature has three formats--the FIPS code, providing the object key, the postal
state code, and the state name.

Label style
Scan/US provides different designs for showing labels. Click on the desired style.

The simplest styles, text only or text with a background color, are best for displaying labels on all
objects. The remaining styles using drop shadows or filled-in boxes are best for emphasizing a
single object or two on the map.

Label font

Scan/US provides different font sizes and styles (bold, underline, or italic) to choose from. Click the
down arrow button to display a list of fonts and choose another.

You can add your own fonts by entering them in the "Preferences" dialog. See the "Preferences..."
command description for more information.

Label colors

To emphasize the label style, you can choose a color for the characters, a background color, and
colors to frame the style with a box, or with a box and shadow.

* | ets you choose colors for the label text. Click the down arrow button to display a palette of 16 colors
to choose from.

Lets you choose colors for the label background or text drop shadow. Click the down arrow button
to display a palette of 16 colors to choose from.

Lets you choose colors for the box frame. Click the down arrow button to display a palette of 16
colors to choose from.

Lets you choose colors for the box drop shadow. Click the down arrow button to display a palette of
16 colors to choose from.
Alignment

Available for point objects only. The white box represents a point object. Each rectangle represents
a label position relative to the object. Click on the desired rectangle to choose a label position. The
selected position is highlighted in red.

Draw ties

Check the box to display a thread between an object's center and its label or thematic graphic when
they are moved. Clear the box so that threads are not displayed. A dark gray box indicates that the
current display of threads on the layer will be retained. This option is preset to be ON for point
features, and OFF for polygon features.

The dark gray box is especially useful when you have moved, hidden, or shown individual threads in
Select--Label submode or Select--Graphic submode



See Also

Using selector dialogs
Changing the map display
Changing labels



Printing a map or report
For an overview, please see About printing.

Printing a map

Printing the map background

Modifying a text entry in a print layout
Creating a bitmap image of your map
Creating a PostScript image of your map
Printing a report



About printing
Printing a map or report in Scan/US is quick and easy.

To quickly print a map, choose the "QuickPrint" command to produce a map with a preset page layout.
The QuickPrint layout frames the map in a rectangle and includes a header and footer. Scan/US
provides additional layouts which let you include descriptive text, additional maps, a legend, and map
graphics. To use a different layout, or change the printer setup, choose the "Print..." command to print
the map.

Scan/US also lets you modify the text that is printed with a map. In the "QuickPrint" dialog, you can
change the header and footer right before printing the map. You can also edit text entries used in the
layouts with the "Dictionary..." command.

To print a map in other applications, you can copy a bitmap image of the map with the "Copy Map..."
command, or create a PostScript image. Then paste the image in other applications.

To print a report, Scan/US provides an Excel macro package and the "Copy Data..." command. [f you
have Excel, choosing "Reports..." from the Tasks menu starts up Excel, sends the active datalist on the
current layer to Excel, formats the data into a report, and prints it. A report format is provided for each
datalist in the Scan/US database. A macro is also provided to print a report for a selected object or group
in "QuickLook."

If you do not have Excel or wish to print a report of other data--not part of the Scan/US database--you
must send the data to the clipboard with the "Copy Data..." command. You can then paste the data into
another application and use its tools to generate a report.

See Also
Printing a map or report
QuickPrint... (Map menu)
Dictionary... (Options menu)
Copy Map... (Map menu)
Copy Data... (Data menu
QuickLook... (Views menu)
Reports... task




Printing a map
To print a map with the standard built-in layout
1 From the Map menu, choose "QuickPrint."
Shortcut:  Ctrl-P

. Optional: Enter another header or footer.

2 Click "OK."
Note To print the map background using this command, you must first turn on the "Map
Background" option in the "Print" dialog.

To print a map with a custom layout
1 From the Map menu, choose "Print..."

2 Choose the desired layout.

A blueprint of the selected layout is displayed. Each rectangle, called a field, is a place-holder for
a layout element such as a map, title, date, or descriptive text. The map field is selected and
shown in red.

3 Choose the desired map.
4 Click the right-left arrow buttons to select each layout field.
5 Define the selected field's contents.

The contents you can modify vary according to the selected layout. For example, you change the
map title or footer, but not the north arrow.

. Optional: Check the "Map Background" option to print the current background color. The option
is preset to be unchecked so that the map background is the color of the paper you are printing on.

. Optional: Indicate the number of copies. One copy is preselected for you.

6 Click "OK."

Note Some disparity occurs between the colors you see on the screen and how the colors appear
printed out. How different they are depends on the monitor and printer you are using. Depending on your
output device, you may need to modify a palette's colors and see how they appear printed out. Once
you define a palette that meets your presentation needs, you can save it and then reuse it as often as

needed. For more information see Palettes... (Options menu) or Changing the map display.

See Also
Printing a map or report




Printing the map background

1 From the Map menu, choose "Print..."

2 Check the "Map Background" option to print the current background color.
The option is preset to be unchecked so that the map background is the color of the paper you are
printing on.

See Also
Printing a map or report




Modifying a text entry in a print layout

The "Dictionary" dialog lists all the text entries used in the print layouts. Each entry is composed of a
keyword and its text string. Each keyword is referenced in a layout, then when a map is printed using the
layout, the text string is printed in place of the keyword.

1 From the Options menu, choose "Dictionary..."

2 Select a keyword from the list box to display its text.

3 Click inside the "Text" box and make your changes, then press Enter.
4 Click the "Replace" button.

Note To add new entries, enter them into the "Dictionary” then modify or create a print layout. The
layout (.TEM) file structure is described in TEMPLATS.TXT. This file and the layouts Scan/US provides
are stored in the home directory C:\SCANUS, unless you defined a different one during installation.

See Also
Printing a map or report
Dictionary... (Options menu
Print... (Map menu




Creating a bitmap image of your map

1 From the Map menu, choose "Copy Map...."

2 Enter the desired width and height in pixels.

3 Click "OK."
Note The final size of the bitmapped image depends on how the target application and output device
handles bitmaps. You may need to try different sizes until you find one that produces the desired results.
Tip 800 x 600 is a recommended size for output on a slide device.

See Also

Printing a map or report

Copy map... (Map menu

Show Clipboard (Window menu)
Creating a PostScript image of your map



Creating a PostScript image of your map

Creating a PostScript image of your map requires changing the print destination to output a PostScript
file. You can then paste the PostScript file into other applications. Note that the file does not include a
TIFF preview that allows you to see the actual map on the screen in the target application; instead, a box
is displayed with some notes identifying the file. When the box is selected, sizing handles are displayed,
and you can scale the box (i.e. map) to meet your presentation needs. When the file is printed, however,
you will see the map as you created it in Scan/US.

1 From the Map menu, choose "Print..."

Click the "Printers..." button.

Click the "Setup" button in the "Printers" dialog.

Click the "Options" button.

Choose the "Encapsulated PostScript File" option and enter a name for the file, including its path.
Return to the Scan/US "Print" dialog and click "OK."

7 Import the file into a target application.

D o0~ WDN

Note Transparent patterns cannot be printed on PostScript printers. If you print a map that uses
transparent patterns, everything except the transparent pattern will be printed. If your PostScript printer
has a LaserJet emulation mode, switch to it before printing maps with transparencies. Another work-
around is to print to Adobe's Acrobat printer driver, open the resulting file in Acrobat Reader, then print the
file.

See Also
Printing a map or report
Print... (Map menu)
Copy map... (Map menu

Creating a bitmap image of your map




Printing a report

The following procedures show you how to print a report using Excel macros provided in your BasePak.

You must have Excel to run the macros.--If you don't have Excel, use the "Copy Data..." command to
send the data to the clipboard, then paste the data into another application to generate a report.

To print a single report for a selected object or group
1 Activate the desired layer in the window layer box.
2 From the Views menu, choose "QuickLook..."
3 Do one of the following:
Click this button  To Do This
To select objects.

To select groups. This button is inactive if no
groups are present on the layer.

4 Select the desired object or group from the drop-down list or on the map.

See also Selecting an object or Activating a group

Optional: Activate another datalist from the Data menu.

Optional: To report only selected variables, choose the variables and contract the list.
Shift-Click to select multiple variables in sequence or Ctrl-Click to select multiple variables not in
sequence. Then click the "Contract" = button.

5 Click the "Print" button.

6 Click "OK" from the "QuickL ook reports dialog"
To print one or more reports for objects in any study area
1 Choose "Reports..." from the Tasks menu.
The "Default Titles" and "Print Preview" options are preselected for you.
Select a study area.
Select a layer in the study area.
Choose the desired report.

a b WD

Choose the object set.

The active options vary according to the layer selected. For example, if groups are not present,
the options to select grouped objects are inactive.

6 Choose a report option.
This option Does this

Summary Generates a report, summarizing all objects in the object set.
Individual Generates a report for each object in the object set.

7 Click "OK" to open the "Print Preview" dialog.

8 Click the "Print..." button in the dialog.

Tip To enter different titles, clear the "Default Titles" option. A dialog is displayed before printing
which prompts you for the titles.

See Also
Printing a map or report



Copy data... (Data menu
QuickLook... (Views menu)
Reports... task

Working with data

Working with objects
Working with groups



Initialization files

SCANUS.GDS, the preset session file, and SCANUS.INI are two initialization files that define the
Scan/US environment. A session file defines the amount of geography and attribute data available for a
session at start-up. SCANUS.INI defines the operating environment such as the background color,
printing templates, fonts, palettes, etc.

Updating the session file

A session (.GDS) file is structured like other Windows initialization files with sections and settings which
are described in SCANUS.TXT (installed in C:\SCANUS unless you did a custom install.). Its four
sections can be updated in Scan/US with the following commands:

. [Database] contains user data files that Scan/US automatically loads. Each time you check the
"Autoload" option in the "Data Center," this section is updated.

. [Features] contains the features available at start-up. The contents in this section are shown in
the "Features Directory." You can update this section by modifying and saving the "Features Directory."
. [Study Areas] contains the opening map, automatically loaded study areas, and saved study
areas. You update this section with the "Save Study Area..." and "Study Area Manager..." commands.

. [QuickPaths] lists your favorite directories for storing geography and data. The directories are

immediately available in the "Add Feature to Directory" and "Load Data" dialogs. Scan/US lets you
access the files in these directories without searching for them. You can define QuickPaths in the
"Preferences" dialog.

Scan/US also lets you have more than one session file so you can configure Scan/US for different

projects. When you have multiple session files, Scan/US displays the "Scan/US Sessions" dialog at
start-up. You choose the desired session for a project, and all the geography and data you need is there.

You can copy SCANUS.GDS or another session file with the "Copy Session" task in the Tasks menu--this
will also update SCANUS.INI so that the "Scan/US Sessions" dialog is displayed at start-up. The next
time you start Scan/US, choose the new session file, then update it, as described above, so that only the
geography and data needed for a project are available.

Updating SCANUS.INI

SCANUS.INI has several sections and settings which are described in SCANUS.TXT (installed in C:\
SCANUS unless you did a custom install.) Some sections are for internal use only; others you can
modify with the following commands.

. All the commands in the Options menu, mainly the "Preferences..." command.
. The "Task Center..." command.
For more information on the commands which update these files, see their command descriptions.

See Also

Copying and modifying a session file
About session files

Adding QuickPaths to a session file
QuickPaths vs. Directories



Copying and modifying a session file
1 From the Task menu, choose "Copy Session..."
The window title bar shows the name of the session file currently in use.
2 Type a caption for the new session file.
This name will be displayed in the "Scan/US Sessions" dialog at start-up.
3 Type a new file name with a .GDS extension.

If you do not include a path, the file is stored in the home directory, CASCANUS, unless you
defined a different one at install.

Click "OK."

Exit and restart Scan/US.

From the "Scan/US Sessions" dialog, select the new session file and click "OK."
Update the contents of the session file.

N o o b~

See Initialization files

See Also
"Copy Session" dialog

'Scan/US Sessions" dialog
About session files






Background... (Options menu)

Use the "Background..." command to change the background color for the map in the current window. All
other map windows are not affected by the change.
When you choose the command, the "Map Background" dialog is opened, showing a color palette. A

selection rectangle highlights the current background color. The number box in the lower right shows
you the color number. Select another color and click "OK" to change the color background.

If you check the "Set Default”" option, the color selection becomes the preset background color for all
subsequent windows and future sessions.

See Also

Changing the map display
Printing the map background



Backup (Window menu)

Use the "Back Up" command to activate the study area window from which the current study area was
created. The "Back Up" command is useful when several windows are open for quickly returning to a
parent study area.

Choosing the command from a view window also activates the parent study area, and not the study area
the view analyzes.

See Also
The display window



Clear Groups (Groups menu)

The "Clear Groups" command clears the active grouping from the map display. Note that the groups
themselves are not deleted when you choose the command.

To redisplay the grouping, choose its name from the bottom of the Groups menu or from the "Group
Manager" dialog. To delete an entire grouping, see the "Groupings..." command description.
To hide or delete groups in the active grouping, see the "Group Manager..." command description.

If the "Map Features" dialog is open, choosing "Clear Groups" removes the group icon from the feature's
object button. The object sample rendering is shown instead.

See Also

Group mode
Working with groups




Close All Dialogs (Window menu)

Shortcut Ctrl-K

Use "Close All Dialogs" to clear the screen of all the open dialogs. The command is not available when a
dialog requiring you to confirm or cancel an operation is open.



Copy CrossReference... (Objects menu)

The "Copy CrossReference..." command allows you to copy to the clipboard an object-key list of objects
on the active layer and their corresponding objects on another layer. The correspondence is set up in
the "Add Datalist from Layer" dialog when you choose a layer to summarize its data for the active layer.

"Copy CrossReference" dialog options
Reference layer

Names the referenced layer. If multiple cross-references have been set up, the arrow button is
active. Click the arrow button to display other referenced layers.

Selected object only
Preset if you selected an object before opening the dialog, this option copies the selected object and
its corresponding objects.

Filtered objects

This option is active only in a thematic view. Copies all objects whose values are in non-hidden
strata or whose values fall within the defined maximum and minimum limits, and their corresponding
objects.

All objects
Copies all objects and their corresponding objects.

Objects in groups
Copies grouped objects and their corresponding objects. When you select this option the following
options become active:

Group drop-down list Select one or more groups from the drop-down list. Click the arrow button
to display the list. ShiftClick to select one or more groups in sequence; CtriClick to select multiple
groups not in sequence.

"[no groups selected]" is displayed until you choose a group, then the group name is shown. If you
select more than one group, the number of groups is shown.

Grouping drop-down list Displays the name of the current grouping. If more than one grouping is
present on the layer, the arrow button is active, and you may choose another grouping to select
groups from.

OK
Sends a [crossreference] parcel to the clipboard.

See Also
"Add Datalist from Layer" dialog
Data Center... (Data menu)
crossreference] parcel
Aggregating data on other layers
Working with data



Copy Data... (Data menu)

Use "Copy Data..." to send to the clipboard the data for selected objects on the layer. You can select one
or more variables, including text variables, from a single datalist, or select all variables from multiple
datalists. Percent variables are only calculated for viewing in thematic views and "QuickLook;" they do
not belong to any datalist.

The copied data can be pasted into other Windows applications, and placed in reports and other data
presentations.

"Copy Data to Clipboard" dialog options
Datalist name drop-down list

Displays the name of the datalist currently selected for the layer. You can choose one or more
datalists from the drop-down list. Shift-Click to select multiple datalists in sequence; Ctrl-Click to
select multiple datalists not in sequence.

Variable name drop-down list

You can choose specific variables only when one datalist has been selected. If you select more than
one datalist, Scan/US copies all their variables to the clipboard.

To select specific variables click the arrow button to display a list of variables to choose from.
ShiftClick to select multiple variables in sequence; CtriClick to select multiple variables not in
sequence.

If you select an array variable, preceded by the plus (+) button, all its cell variables are selected. To
copy specific cell variables, expand the array by clicking the plus button, then choose the desired
ones. When the array is expanded, the plus button changes to a minus (-) button, and clicking it
collapses the list.

Selected object only

This option is active only if you selected an object before opening the dialog. Selecting this option
copies data only for the selected object.

Filtered objects

This option is active only in a thematic view. Filtered objects are objects whose values fall within the
defined maximum and minimum limits and are in non-hidden strata.

All objects
Sends to the clipboard the data for all the objects on the layer.
Objects in groups

This option is active only when groups are present on the layer. Only data for the grouped objects is
sent to the clipboard. When you select this option the following options become active:

Group drop-down list Displays the name of the active group. If an object is selected when you
open the dialog, "[no groups selected]" is displayed. When you select a group, then the group name
is shown. If you select more than one group, the number of groups is shown.

To select a group, click the arrow button to open the drop-down list. A click selects a single group;
ShiftClick to select multiple groups in sequence; CtriClick to select multiple groups not in sequence.

Grouping drop-down list Displays the name of the active grouping. If more than one grouping is
present on the layer, the arrow button is active, and you may choose another grouping to select
groups from.

OK
Sends a [data] parcel to the clipboard.

See Also



[data] parcel

Copy Variable... (Views menu
Copying data to the clipboard
Working with data



Copy Distance... (Objects menu)

"Copy Distance..." is active only in Select, Group, or Edit mode when an object or group is currently
selected. Use this command to calculate the distance from one or more objects to objects on the same
layer or on another layer.

You may target all the objects on a layer or only grouped objects. Scan/US sends to the clipboard a list
of the target objects and the distance and orientation of each one from the selected object(s). You may
view this list in the clipboard or paste it into another application.

The precision of the calculated distances depends on the height (vertical extent) of the study area map:

. Greater than 1000 miles, zero decimal places.
. 100 to 1000 miles, one decimal place.
. Less than 100 miles, two decimal places.

"Copy Distance to Clipboard" dialog
"Distance from" options
Selected object only
This option is active only if an object is currently selected.
Filtered objects

This option is active only in a thematic view . Filtered objects are all objects whose values fall within
the defined limits and are in non-hidden strata.

Objects in group(s):

This option is active only when groups are present on the active layer. Scan/US calculates the
distance only from objects assigned to the selected groups. The following options are active when
this option is selected:

Group drop-down list Displays the name of the active group. If an object is selected when you
open the dialog, "[no groups selected]" is displayed. When you select a group, then its group name
is shown. If you select more than one group, the number of groups is shown.

To select a group, click the arrow button to open the drop-down list. A click selects a single group;
ShiftClick to select multiple groups in sequence; CtriClick to select multiple groups not in sequence.

Grouping drop-down list Displays the name of the active grouping. If more than one grouping is
present on the layer, the arrow button is active, and you may choose another grouping to select
groups from.

"To objects on layer" options
Layer drop-down list

Displays the name of the target layer. The active layer is preselected for you. To calculate the
distance to objects on another layer, click the arrow button to display a list of layer names and choose
another layer.

All objects

This option is preselected. Scan/US will calculate the distance from the selected object to all other
objects on the target layer.

Objects in group(s)

This option is active only when groups are present on the target layer. Scan/US calculates the
distance only to objects assigned to the selected groups. The following options are active when this
option is selected:

Group drop-down list Displays the name of the active group. If an object is selected when you
open the dialog, or you choose a different target layer, "[no groups selected]" is displayed. When
you select a group, then its group name is shown. If you select more than one group, the number of
groups is shown.



To select a group, click the arrow button to open the drop-down list. A click selects a single group;
ShiftClick to select multiple groups in sequence; CtriIClick to select multiple groups not in sequence.

Grouping drop-down list Displays the name of the active grouping. If more than one grouping is
present on the layer, the arrow button is active, and you may choose another grouping to select
groups from.

OK
Sends a [distance] parcel to the clipboard. Target objects are shown in a [to] packet within the
parcel.

See Also

[distance] parcel
Working with objects



Copy Groups... (Groups menu)

Use the "Copy Groups..." command to send to the clipboard a list of objects and their group assignments
in the current grouping.  You can then paste the list into another grouping with the "Paste Groups"
command or into other Windows applications, including them in reports or other data presentations.

"Copy Group Assignments" dialog options
Objects in All Groups

This option is preselected to send a list of all objects and their group membership, including the
'Unassigned' group, to the clipboard.

Include Group Table Also preselected, Scan/US includes a list showing the total number of groups,
group names and the number of objects in each group.

Objects in Selected Groups

Selecting this option allows you to decide which groups of objects are to be copied. When you select
this option, the group name drop-down list becomes active. Click the arrow button to display the
group names in the current grouping. Click on the desired group name; ShiftClick to select group
names in sequence, or CtrIClick to select group names not in sequence.

The group name you select is shown in the text box. If you select more than one group, the number
of selected groups is shown.

OK

Sends a [grouplist] or [group set] parcel to the clipboard. The [grouplist] parcel is sent when all
objects are selected. The parcel contains a [grouping] packet if you checked the "Include groups
table" option. A [group set] parcel, containing a [group] packet for each group, is sent for objects in
selected groups.

See Also
rouplist] parcel
roup set] parcel

Working with groups



Copy List (Objects menu)

Use the "Copy List" command to send to the clipboard a list of objects on the active layer. The list
contains the keys for the selected objects. One way to use the list is to create new data files that you
can attach to the layer.

Tip If necessary, you can activate another layer by choosing a different one from the window's layer box.
All

Sends a list of all objects on the layer to the clipboard.
Filtered

Sends a list of objects that are in non-hidden strata and whose values fall within the maximum and
minimum limits defined in a thematic view. This option is active only in a thematic view that has
hidden strata or whose maximum and minimum limits are not equivalent to the maximum and
minimum values of the objects on the layer.

Grouped

Sends a list of all the objects assigned to a group in the current grouping. This option is active only
when a grouping is on the layer.

Visible
Sends a list of objects whose individual visibility settings for object rendering are on. If all settings
are on, which is the preset value, the list of objects is the same one sent with the "All" option.

When you select an option, Scan/US sends an [objectlist] parcel to the clipboard.

See Also
obijectlist] parcel

Working with objects
Using your own attribute data



Copy Map... (Map menu)
Shortcut Ctrl-Y

Use the "Copy Map..." command to send a bitmapped image of the active map to the clipboard. You can
then paste the map into other Windows applications, including them in reports or other presentations of
your data.

"Copy Map to Clipboard" dialog

When the dialog is opened, the width and height of the map's current screen size is shown in pixels.
Enter the width and height that best reflects the desired output.

The final size of the bitmapped image depends on how the target application and output device driver
handles bitmaps. You may need to enter different sizes until you find the size that produces the desired
results. The minimum size you can enter is 210 pixels wide by 170 pixels high; the maximum size is
approximately 2750 pixels wide by 2250 pixels high. These maximum values may vary according to the
amount of virtual memory available on your computer.

Tip 800 x 600 pixels is a recommended size for output on a slides device.

See Also

Printing a map or report
Creating a PostScript image of your map



Copy Objects... (Objects menu)
Shortcut Ctrl-C

The "Copy Objects..." command to copy the spatial definition of selected objects on the active layer to the
clipboard. "Copy Objects..." is only active in Select mode when an object is currently selected, in Edit
mode when one or more objects are present on the editable layer, and in all modes when a grouping is
active on the layer.

Objects copied to the clipboard can be used to group objects on another layer. They can also be pasted
onto an editable layer for modification. The objects’ text description can be pasted into other
applications.

"Copy Objects to Clipboard" dialog options
Selected object only

This option is active only if you selected an object (in Select--Object submode) before choosing the
command.

Filtered

This option is active only in a thematic view that has hidden strata or whose maximum and minimum
limits exclude objects on the layer. Filtered objects are those in non-hidden strata and whose values
fall within the maximum and minimum limits defined in a thematic view.

All objects
This option is only active for objects on editable layers.
Objects in group(s)

This option is active if one or more groups are present on the layer. The following become active
when this option is selected:

Group name drop-down list Displays the name of the selected group. To select a group and copy
its objects' definitions, click on the arrow button to display a list of groups to choose from. Shift-click
to select multiple groups in sequence; Ctrl-click to select multiple groups not in sequence. The box
displays "[No group selected]" until you select a group name. The box is blank and the arrow button
dimmed when no groups are present on the layer.

Grouping name drop-down list Displays the name of the active grouping. If more than one
grouping has been created for the layer, you may select another grouping. Click on the arrow button
to display a list to choose from. If no groups are present, the box displays "[No groupings on layer]"
and the arrow button is dimmed.

OK

Sends a parcel to the clipboard. A [polygons] parcel is sent for polygon area objects; [lines] for line
objects; [locations] for point objects; [areas] for ring objects; [grids] for grid objects.

See Also
areas] parcel
rids] parcel
lines] parcel
locations] parcel
olygons] parcel

Working with objects



Copy Tour (Objects menu)

The "Copy Tour" command is only active in Tour mode when a tour has been drawn on the map.
Choosing the command sends a description of the tour to the clipboard.

A tour is the distance 'as the crow flies' between a starting point and an ending point. If you have points
in between, the distance between one point and the next point is called a leg. To draw a tour, see the
Tour mode description.

When you choose the command, Scan/US sends a [tour] parcel to the clipboard.

See Also
Help
tour] parcel
Tour mode

Reference Manual
"Copy Tour" command



Copy Variable... (Views menu)

"Copy Variable..." is active only when data on the active layer has been analyzed in a thematic view.
Use the command to send to the clipboard a selected variable's strata ranges and the objects and their
values within each range.

After copying the strata, you can paste them into other Windows applications, including them in reports or
other presentations of your data.

"Copy Variable Strata" dialog options
Variable name drop-down list

Shows the first variable that was selected for the active layer in the thematic view. If more than one
variable was selected, clicking the arrow lists the other variables. Click on the variable whose strata
you wish to copy.

Objects in All strata

The preselected option, it sends to the clipboard all objects on the layer, including objects excluded
from the thematic analysis. For each object, Scan/US sends its key, its value for the selected
variable, and the stratum the value belongs to. The stratum number is zero for objects excluded
from the analysis or in hidden strata.

Include strata table Choosing this option sends to the clipboard a list of the strata ranges that you
defined in the thematic view for the variable's values.

Include statistics Choosing this option includes the statistics that tell you the total number of
objects, the maximum and minimum values, the mean, standard deviation, and median values.

Tip You can view the statistics by clicking the "QuickStats" button = in the "Strata Manager" dialog.
Objects in Selected Strata

Selecting this option allows you to send to the clipboard only those objects whose values belong to
specific strata. Clicking the arrow lists the variable's strata ranges. Initially, all non-hidden strata are
selected. Click on a range to select it; Shift-Click to select one or more ranges in sequence; or Ctrl-
Click to select more than one range not in sequence. Ctrl-Click also undoes a selection.

OK

Sends a [stratlist] or [strata] parcel to the clipboard. The [stratlist] parcel is sent when all objects are
selected. The parcel contains [stratatable] and [varstatistics] packets when you check the "Include
Strata Table" and "Include Statistics" options. A [strata] parcel, containing a [stratum] packet for each
stratum, is sent for objects in selected strata.

Tip You can also use the data sent to the clipboard to create groups by choosing the "Paste Groups..."
command. This is the same as clicking the "Save As Groups..." button in the "Strata Manager" dialog.
The groups are assigned to a grouping given the same name as the variable.

See Also

strata] parcel
stratlist] parcel
"Strata Manager" dialog

Working with groups
Working with thematic views




Data Center... (Data menu)

The "Data Center..." command is your key data management tool in Scan/US. You can do the following:

Activate a loaded datalist.

View the variables in a selected datalist

Load data onto the current layer.

Remove data from the current layer.

Summarize the data on another layer for one or more objects on the current layer.
Create a new file definition from variables in other datalists.

"Data Center" dialog options

The dialog is opened, listing the Scan/US datalists and user data files loaded on the active layer. The
active datalist or user file is shown in red text. Each datalist or file is preceded by an icon which
describes it.

& The datalist is from the Scan/US product database.

= A user data file that was manually loaded.

. A user data file that was automatically loaded.

&S An external spreadsheet that is DDE linked with the "Paste Link" command on the Data menu.
& A user point data file that has been loaded as a feature.

. The data summarizes data loaded on another layer.

5 A new data file constructed by selecting its variables from other datalists or user files.

Click this button to close the dialog and activate the highlighted datalist or user file.

When the dialog is opened, the active datalist is shown in red text and highlighted. When you click
on another datalist or user file, it becomes highlighted, and the "Select" button becomes active.

Shortcut Double-clicking on the datalist name selects it and closes the dialog.

Note Because only one datalist is active at a time, selecting another datalist will remove a thematic
analysis of the current datalist.

Show

This capability has been removed from this release. It will become available in a future version of
Scan/US.

Click this button to open the "Datalist" dialog, listing all the variables in the highlighted datalist or user
file.

Unload

Click this button to unload the highlighted datalist or user file from the layer (the data is not actually
deleted). The data is also unloaded from all views of the study area and may change the
presentation of a thematic analysis. Note the following exceptions:

. Product database files cannot be unloaded.

. While a point data file is loaded as a feature, its data cannot be unloaded.

. Unloading a data file that is cross-referenced by another layer automatically unloads the cross-
references for that layer.

Close

Click this button to close the dialog; any changes you made are not saved.
Autoload

When checked, this option tells you that the selected datalist is automatically loaded with the feature
into a study area. For all datalists in the Scan/US product database, the option is checked and
inactive. The Scan/US datalists are always automatically loaded.

Each time you check or uncheck this option, the session file is instantly updated with your selection.
Unchecking the option means that you will manually load the selected file in the future.



Default

When checked, this option tells Scan/US to activate the selected datalist when the feature is added to
a study area. Although several datalists can be loaded with a feature, only one can be active at a
time. This option tells Scan/US to activate the selected datalist first.

"Add datalist from" buttons:
Layer...

This button is active only two or more layers in the window have data loaded onto them. Clicking the
button opens the "Add Datalist from Layer" dialog which allows you to set up a cross-reference
between layers.

File...
Duplicates choosing the "Load Data..." command to load more data onto the current layer.
New...

This capability has been removed from this release. It will become available in a future release of
Scan/US.

Like the "Show" button, opens the "Datalist" dialog in which you can build a new datalist definition
from variables in other data files. Because only one datalist can be active at a time, building a new
datalist allows you to see data from several files at once.

See Also
Help
Load Data... (Data menu)
"Add Datalist from Layer" dialog
Working with data
Using your own data

User's Guide
"Using your own data"



"Add Datalist from Layer" dialog

You open this dialog by clicking the "Layer..." button in the "Data Center."

The dialog allows you to cross-reference data on another layer for the active layer. The active layer is
considered the target layer; the source layer contains the data that is summarized for the current layer.
The source layer must be a finer level of geography than the current layer. For example, if Counties is
the current layer, you can summarize data in zip code areas, census tracts, or grids. These objects are
all smaller than counties. If the available source layers are not finer, you can only cancel the dialog.

Name
The name of the datalist or user file you select.
Caption
A brief description of the data. Scan/US uses the caption to help you identify the datalist or user file

when it is listed at the bottom of the Data menu. If you do not enter a caption, Scan/US uses the
datalist name.

The first four datalist or files loaded onto the layer, whether loaded automatically from the session file
or loaded manually, are shown at the bottom of the menu. Selecting a datalist or user file from the
list makes it the active one for the layer.

If there are more than four, the "More datalists..." command is shown, and choosing it opens the
"Data Center" dialog.

Layer

Displays the name of the source layer. If multiple source layers are available, the arrow button is
active. Click the arrow button to display a list and select the desired layer.

The scroll box beneath the layer name lists all the data files loaded onto the source layer.

Show
Duplicates the "Show" button in the "Data Center" dialog. Clicking the button opens a window listing
all the variable names in the selected datalist.

Cancel

Cancels your selections and closes the dialog.

See Also
Help
Data Center... (Data menu)
Load Data... (Data menu
Working with data

Using your own data

User's Guide
"Using your own data"



"Datalist" dialog

This capability has been removed from this release. It will become available in a future version of
Scan/US.

You open this dialog by clicking the "Show" or "New..." button in the "Data Center."

The dialog displays the datalist for other data files. You can build a new datalist definition from variables
in other data files. Because only one datalist can be active at a time, building a new datalist allows you
to see data from several files at once.

See Also

Using your own attribute data
Working with data



Dictionary... (Options menu)
Shortcut Ctrl-E

Use "Dictionary..." to create, edit, or delete text that is substituted for keywords defined in printing
templates.

Each dictionary entry is composed of a keyword and its text which are saved in the [Dictionary] section of
SCANUS.INI.  When you customize templates with the "Print..." command, you can position the keyword
to suit your presentation needs, then when a map is printed using the template, the text is printed in place
of the keyword.

"Dictionary" dialog options
Keyword

Displays the keyword that you include in a printing template. You may define a new keyword or
select an existing one listed below the text box. Some of the keywords, such as 'company' and
'user,’ were defined and added to SCANUS.INI when you installed Scan/US.

Text
Displays the text that is substituted for the keyword when the printing template is used to print a map.

If you type in a new keyword, press the Tab key and type in the text. If you selected an existing
keyword, its text is automatically displayed in the text box. Click inside the text box and modify the
text as desired.

Add

This button is active only after entering a new keyword and its text. Clicking this button adds the new
keyword and its text to the [Dictionary] section in SCANUS.INI. Scan/US will ask you to confirm the
addition to the file.

Replace

This button is active only after editing the text of an existing keyword. Clicking the button updates
the text in SCANUS.INI with your changes.

Delete

This button is active only after selecting an existing keyword. Clicking the button removes the
keyword and text from SCANUS.INI.

Cancel

Cancels any selections or changes you make before clicking the "Add," "Replace," or "Delete"
buttons. After an addition, replacement, or deletion, the button changes to "Close."

Close
Closes the dialog.

See Also
Print... (Map menu)

Printing a map or report




Distance (Options menu)

The "Distance" command lets you choose from two units of measurement for distance to be calculated
and displayed. Scan/US is shipped with miles as the preset unit of measure; kilometers is the other.
The option you choose is selected for the current session, automatically updates SCANUS.INI and is in

effect for future sessions until you change it.



Exit (Map menu)

Use the "Exit" command to leave Scan/US and return to Windows. If you exit without having saved your
most recent changes, Scan/US prompts you to save them.



Features Directory... (Map menu)

Shortcut Ctrl-D

Use the "Features Directory..." command to open the "Features Directory" which lists all the features that
are available in the current session. You can do the following in the "Features Directory:"

Add features to the active study area.

Change the drawing order of the features.

Modify the preset rendering of a feature.

From the Features menu, add and remove features, and save changes to the directory.
From the Attributes menu, control feature attributes.

"Features Directory” dialog options
When you choose the command the "Features Directory" is opened and lists the available features. You

can also open the directory by clicking the "Add Features" button in the "New Map features" or "Map
Features" dialogs.

If the directory shows only a portion of the feature set, you can lengthen the dialog by dragging the top or
bottom edge.

Features List

The order of features determines their drawing order when loaded into a study area. |If features are
ordered so that the rendering of one does not obscure another, they will also be loaded that way.

To change the order, press Shift while you drag-and-drop the feature to its new position. The feature
is placed above the one you drag to.

Visibility indicators

* indicates object visibility.

* indicates label visibility.

These indicators are displayed according to ranges specified for a feature's objects and labels in the
"Feature Visibility" dialog. Scan/US compares the ranges to the vertical extent of the current study area,
and if the vertical extent is within range, an indicator is present.

The presence of an indicator means the feature would be 'usably’ visible if loaded into the study area.
See About feature visibility for more information.

Object and label buttons

These buttons shows a sample of the feature's current display attributes. Click a button to open a
selector dialog and change the attributes.
Shows the color and/or border chosen for area objects. Click to open the "Area Fill Selector” dialog.

Shows the symbol specified for point objects. Click to open the "Symbol Selector" dialog.

Shows the line style and color for line objects. Click to open the "Line Style Selector" dialog.

Shows the size, color, and style of the object labels. Click to open the "Label Style Selector" dialog.
Indicates that the objects or labels are hidden when the feature is added to a study area. ShiftClick on
the object or label sample to display the shade; clicking on the shade toggles back to the object or label
sample.

When you modify a feature's display attributes, your changes remain in effect for any subsequent
study area to which you add the feature. If a study area containing the feature was created before

your changes, the feature will not be updated to show the changes.

Tip When a you modify a feature's display attributes in a study area using the Map Features... (Map
menu), you can quickly make them the preselected ones in the "Features Directory." In the "Map
Features" dialog, select the feature with the right mouse button to display a popup with a "Set Default"
option. Choosing this option automatically updates the display attributes in the "Features Directory."

Adding features to a study area
You can drag-and-drop features from the directory into the map.
If you open the "Features Directory" from either the "Map Features" or "New Map Features" dialogs,



you can also drag-and-drop features into these dialogs.
The "Add" and "Insert" buttons are activated when the directory is opened from these dialogs.

Add Clicking the button adds the selected feature in the directory to the top of the features listed in
the dialog.

Insert Clicking the button places the selected feature in the directory above the highlighted feature
in the dialog.

Features popup

Hide Objects
Hide Labels
Rename
Delete Feature

Clicking the right mouse button to select a feature displays a popup of commands.
Hide Objects Hides objects when the selected feature is loaded into a study area.
Show Labels Displays labels for all objects when the selected feature is loaded into a study area.

When objects are hidden or labels are shown, the popup displays a "Show Objects" or a "Hide
Labels" command. Hiding objects or labels is the same as toggling to the window shade on an
object or label button. Showing objects or labels is the same as removing the window shade to
redisplay the object or sample.

Rename Allows you to modify the feature's name in the "Feature's Directory." When you choose

this option, a text box is opened with 'okay' and 'undo' buttons. Type a new name and click the 'okay’
button.

Delete Feature Marks a feature for deletion so that when you choose "Save Directory," the feature
is removed from the session file. When you choose the command, a red line is drawn through the
feature name. Click on the feature to unmark it.

See Also
Help
About features
About feature visibility
Attributes menu in "Features Directory"
Features menu in "Features Directory"
Using selector dialogs
Working with map features
Changing the map display

Reference Manual
Features Directory...



Features menu in "Features Directory"
The Features menu in the "Features Directory" provides the following options:

Save Directory

Saves any changes you make to the directory and updates the current session (.GDS) file. All your
changes will be available at start-up the next time you choose the session file to start a session.

Delete Feature

Marks a feature for deletion so that when you choose "Save Directory," the feature is removed from
the session file. When you choose the command, a red line is drawn through the feature name.
Click on the feature to unmark it.

Add Feature...
Opens the "Add Feature to Directory" dialog from which you can load more features.

See Also
Features Directory... (Map menu

Working with map features



"Add Feature to Directory" dialog

Choose "Add feature..." from the Features menu in the "Features Directory” to open this dialog.

Opening this dialog allows you to load more Scan/US features (.GFX) and user features which are not
part of the Scan/US product database. Once a feature is added to the directory, the feature is available
for any study area until you end the session or delete the feature. To load data with the feature, please
see the "Load Data..." command description.

QuickPaths

Displays a list of directories containing user data files to which you have immediate access. The
directories may be located anywhere. Because they have been declared as QuickPaths in the
"Preferences" dialog, Scan/US gives you immediate access to files in them. You do not have to
switch directories and search for the files. Each QuickPath directory is listed by its assigned name

and is preceded by a directory icon @
Directories

Allows you to traverse directories and search for files in the standard Windows way.
List files of type

Filters the list of file names to display a specific type. Each option refers to a single feature type.
Click the down arrow button to view a list of the different types. Select the desired type to display
those file names in the list box.

.BUF for user-defined ring areas
.LOC for user-defined locations.
.PGN for user-defined polygons
.PLN for user-defined lines
.GFX for Scan/US features

XLS for point data files

.DBF for point data files

For file formats, see Appendix A in your Reference Manual.
The following options are activated when you select a feature:
Feature caption

Displays the feature name that will be shown in the directory. The preassigned name indicates the
feature type and file name. If the entry is highlighted, type a new name. If the entry is not
highlighted, click in the edit box and start typing.

Filename
Displays the file name.
Key

Active only when a point data file is selected, this option tells Scan/US which column or field contains
the object keys. They are needed to display the feature and load data.

Click the down arrow button to view a list of column headings or field names in the file. Select the
heading or name which contains the object keys. If you do not identify the key column or field,
Scan/US looks for one named 'Key,' and if not found, assumes the keys are in the first column or field.

Title

Active only when a point data file is selected, this option tells Scan/US which column or field contains
the object captions. Because they are sometimes more descriptive than object keys, captions are
useful as object labels.

Click the down arrow button to view a list of column headings or field names in the file. Select the
heading or name which contains the object captions. If you do not identify the caption column or
field, Scan/US looks for one named 'Title,"' and if not found, uses the object keys as labels.



File in

Displays the path to the directory containing the file.
OK

Closes the dialog and adds the feature to the directory.
Cancel

Discards all your selections and closes the dialog.

See Also
Features Directory... (Map menu
Load Data... (Data menu

Working with map features



Attributes menu in "Features Directory"

The following options are activated only after selecting a feature in the directory. Note that the first three
options duplicate the popup commands which you access by selecting a feature with the right mouse
button.

Hide objects

Hides objects when the selected feature is loaded into a study area. Choosing this option displays a
window shade on the feature's object button.
Hide labels

Hides labels when the selected feature is loaded into a study area. Choosing this option displays a
window shade on the feature's label button.

Rename

Allows you to rename a feature. When you choose this option, a text box is opened with 'okay' * and
'undo’

» buttons. Type a new name and click the 'okay' button.
Autoload

Tells Scan/US to automatically load the feature into any study whose vertical extent falls within the
visibility ranges defined for the feature's objects or labels. A check mark precedes the option when it
is activated for the selected feature.

Autoaggregate
Toggles the aggregation of MicroGrid or block group data for the selected feature.

Visibility...
Opens the "Feature Visibility" dialog which lets you define visibility ranges for the selected feature's
objects and labels.

Radius...

Opens the "Feature Radius" dialog which lets you define the width of the area enclosing an object
when it is selected to create a study area. The preset radius is three miles.

See Also
Features Directory... (Map menu

Working with map features



"Feature Visibility" dialog

Use this dialog to determine the size of the study area into which a feature's objects or labels are
loaded. Scan/US compares the specified ranges to the vertical extent of the current study area and
displays visibility indicators for the feature in the "Features Directory." An indicator is present when the
vertical extent of the current study area is within range and absent when out of range.

You open this dialog by choosing "Visibility..." from the Attributes menu in the "Features Directory."

The visibility scale, 0-1800, reflects the largest possible study area in the continental United States. The
scale is different for Hawaii.

To set a range, drag the 'slider buttons' to the left or right until the desired values are displayed. The

maximum value cannot be less than the radius specified in the "Feature Radius" dialog.
Autoload when in visibility range

Tells Scan/US to autoload the feature into any study area whose vertical extent is within the specified
ranges.

See Also

About feature visibility

Attributes menu in "Features Directory"
Features Directory... (Map menu)

'Feature Radius" dialog
Working with map features




"Feature Radius™ dialog

You open this dialog by choosing "Radius..." from the Attributes menu in the "Features Directory."

Type in a new value to define the width of the area enclosing an object when it is selected to create a

study area. The preset radius is three miles. The distance unit of measure is defined by the "Distance"
command in the Options menu.

See Also

Attributes menu in "Features Directory"”
Features Directory... (Map menu
Distance (Options menu)

Working with study areas



About feature visibility

Each feature in the "Features Directory" has preset visibility ranges for its objects and labels. Scan/US
compares each one to the vertical extent of the current study and displays visibility indicators accordingly.

» indicates object visibility.

» indicates label visibility.

An indicator is present when the vertical extent is within range and absent when out of range. These
indicators help you decide which features to add to a study area. Generally, the larger the study area,
the less detailed features are visible.

The absence of an indicator does not prevent you from adding the feature to the study area but lets you
know that displaying it may provide too much detail. For example, loading grids into a county or into a
large and densely populated study area results in a cluttered view in which boundaries of individual grid
objects cannot be distinguished.

Adding features is also limited to 16,000 objects on a layer. A visibility indicator is absent if adding a
feature would exceed this limit.

Although Scan/US has preset the visibility ranges, you can change them for any feature in the "Feature
Visibility" dialog.
Visibility and usable maps

The visibility range is essential to creating usable maps--In theory, a feature can be added to a study area
of any size, but in practice, finer levels of geography can be analyzed and viewed with more clarity in
smaller study areas. Scan/US uses the visibility range in the following ways to help you create usable
maps:

. If the feature is in the current study area, any new, smaller study area created from the current
one will also contain the feature if its vertical extent is still within the specified range for either the objects
or the labels.

. If the feature is available from the "Features Directory," visibility indicators precede the feature's
name when the vertical extent of the current study area is within the specified ranges.

Setting different visibility ranges for the objects and labels is also a way to create more readable maps.
In small study areas, displaying both the objects and labels can obscure other features or make an
analysis difficult to understand.

See Also
Features Directory... (Map menu

Feature Visibility dialog



Group by Object (Groups menu)

This command groups objects on a target layer by overlaying them with a spatial definition from the
clipboard. If Scan/US does not detect such data in the clipboard, the command is inactive. The overlay
may be a single object or a group of objects whose spatial definition has been sent to the clipboard with
the "Copy Objects..." command. Or, the overlay may be a ring or polygon drawn in Group mode.

When polygons, grid objects, or buffer area definitions are in the clipboard, all objects covered by the
overlay are grouped.

Point and line objects also have spatial definitions to group by when they are copied to the clipboard.
Point objects are assigned a three-mile ring area surrounding the object. Line objects are assigned a
one-mile corridor surrounding the object. The radius values are preset and may be changed using the
Attributes menu in the "Features Directory."

The "Group by Object" command provides two ways to create groups. Choosing the command
automatically activates Group mode so you can complete other grouping operations.

Choosing the object overlay

First activate the layer with the object you want to group by, next select the object and choose the
"Copy Objects..." command. Next, activate the layer with objects you want to group and choose the
"Group By Object" command.

To continue grouping objects on other layers with the same object overlay, activate the desired layer,
then choose "Group by Object." Repeat for each layer.

Grouping by automatic overlay

The ring or polygon you draw to group objects is automatically sent to the clipboard when you create
the group. This is so you can group objects on different layers with the same ring or polygon using
the "Group By Object" command. Immediately after creating the group with a ring or polygon,
activate the layer with objects you want to group, and choose the "Group By Object" command.

To continue grouping objects on other layers with the same ring or polygon, activate the desired layer,
then choose "Group by Object." Repeat for each layer.

Note Do not choose the "Copy Objects..." command after creating the group; the ring or polygon
definition in the clipboard will be replaced by the definitions of the grouped objects.

See Also
Copy Objects... (Objects menu
Group mode
Working with groups



Group Manager... (Groups menu)

The "Group Manager..." command is active only when a grouping is present on the layer. You can do the
following in the "Group Manager:"

Activate another grouping.

Rename a grouping.

Activate another group

Change a group's display attributes.
Hide or show one or more groups.
Rename a group.

Delete a group.

"Group Manager" dialog options

When you choose the command Scan/US lists alphabetically all the groups in the active grouping on the
layer. Or, if the groups are saved from a thematic view, the groups are listed according to their ranges.

Grouping caption box

Shows the name of the current grouping. If more than one grouping is on the layer, activate another
grouping by clicking the arrow button then choosing its name from the list. If only one grouping is on
the layer, the arrow button is dimmed.

To rename a grouping, click inside the box and type a new name. Press Enter so that the name is
immediately recognized. If the grouping has been previously saved, Scan/US copies the grouping
and assigns it the new name. Saved groupings can be renamed from the "Groupings" dialog. See

also Grouping naming conventions
Group list box

Lists all the groups in the current grouping. Objects you have not assigned to a group are
automatically in a group of their own called 'Unassigned.’

The active group is highlighted. To activate a different group, click on its name.

Hide Group
Hename
Delete Group

Clicking the right mouse button to select a group displays a popup of commands.

Hide group When you choose this command, the group is hidden, and objects in the group are
shown with their original rendering on the map. If this command was previously selected for the
group, the popup provides a "Show Group" command. This option is inactive for the unassigned
group.

Rename Allows you to rename a group. When you choose this option, a text box is opened with
'okay' = and 'undo’

s puttons. Type a new name and click the 'okay' button.

Delete group Removes the group assignment from the grouping and from the "Group Manager." The
objects are shown with their original rendering on the map. This option is inactive for the unassigned
group.

Object buttons

Examples: =

®or

[ ]
On the face of each button is a sample of the group's display attributes. To change them, click the
button to open a selector dialog and make your changes.

The unassigned group does not have group display attributes and is always shown in its original
rendering.



* |ndicates a hidden group. Clicking the window shade shows the sample rendering and displays the

group on the map. Shift-Click to display the shade and hide the group. Note that the unassigned group
cannot be hidden.

+ "Palette” button
Click this button to choose, create, or edit another palette and assign new display attributes to groups.
The palette elements are automatically assigned to the active group and each subsequent group. If

you assigned display attributes when creating groups, in either the "New Grouping" or "New Group"
dialogs, your selections may be overridden.

See Also
Working with groups
Using selector dialogs
Changing the map display
Groupings...(Groups menu

Grouping haming conventions



Groupings... (Group menu)

Use the "Groupings..." command to load, save, rename, unlink or delete groupings on the active layer.
Because the objects in groupings are not limited to the study area in which the groups are originally
created, you can load groupings across study areas for the same layer. For example, if you created a
grouping of counties in a study area of California, you can load this grouping onto the counties layer in a
study area of New York.

In some cases, you can load groupings across different layers. For example, a grouping of '93 ZIP
centroids can be loaded onto '93 ZIP code boundaries, or '94 ZIP code centroids or boundaries.

Suppose you had your customer locations in more than one point data file. Each file would be loaded as
a locations feature on its own layer. A grouping you created on a customer locations layer could be
loaded onto a different customer locations layer.

"Groupings" dialog options
When the dialog is opened, it shows the active layer in the window title bar and lists the groupings
available for that layer. Each grouping name is preceded by an icon which describes it.

%P  indicates the grouping is loaded on the layer.

* indicates the grouping information is saved in a file.

* indicates the grouping is saved and loaded on the layer.

* indicates the grouping information is DDE-linked to an Excel file
Show All

Lists all the groupings you have saved and created in the current session, including groupings for
other layers. Use this option when you want to load a grouping from a different layer (as described
above)

Show layer only

Lists only the groupings you have saved and created for the active layer. Preselected when you
open the dialog.

Select
Activates the selected grouping and displays it on the map. The grouping is initially empty if you:

. Loaded a grouping from a different layer.

. Loaded the grouping from the same layer but the originating study area does not overlap the
current one. For example, you loaded a grouping of saved counties in a study area of California onto a
counties layer in a study area of New York.

Load

Loads the selected grouping onto the layer. The grouping name is added to the bottom of the
Groups menu.

Save

Saves the grouping information in two ASCII text files. The list of groups is saved in a .GPG file.
The list of objects in each group is saved in a .GRP files. These files are assigned the same name.
See Grouping naming conventions for more information. You may load these files for analysis in
other applications.

Delete

Removes a loaded grouping from the layer, and if previously saved, deletes the .GPG and .GRP files.
Scan/US asks you to confirm each deletion.

Note Removing a loaded grouping is unlike "Clear Groups" which only hides the grouping display.
Unlink

Disconnects DDE-linked grouping information in an Excel file. Subsequent changes to group
assignments are not updated in the Excel file.

Rename



Lets you change the grouping name on the layer, and if previously saved, renames the .GPG
and .GRP files. Scan/US asks you to confirm renaming the files. If you don't rename them, Scan/US
creates a new grouping with the new name.

Use a naming convention that helps you distinguish the different groupings you create. See Grouping
naming conventions for more information.

See Also

Working with groups
Clear groups (Groups menu)

Group Manager... (Groups menu
Grouping naming conventions



Grouping naming conventions

When you create a grouping, Scan/US names the new grouping unless you enter a different name. The
preset name includes the word 'Grouping' followed by a sequence number (based on the total number of
groupings created), and the layer name in parentheses. For example, Grouping0027(states).

The preset name for user-defined features such as customer locations is similar except that the file name
is shown in parentheses. For example, Grouping0029(storeloc).

You may use any naming convention you like, however one that helps you keep track of the different
groupings and their originating layers is recommended. Names may be up to 31 characters long, using
any character except the equal sign (=) and semicolon (:).

You can rename a grouping after it has been created from either the "Group Manager" or the "Groupings"
dialog.

Saved groupings

When you save groupings, they are saved in two ASCII text files. The list of groups is saved in a .GPG
file. The list of objects in each group is saved in a .GRP file. These files are assigned the same name.
The groupings you name are assigned the first 8 characters, excluding blanks. For example, a grouping
named Sales Territories would be saved as SALESTER.GPG and SALESTER.GRP.

The first grouping saved with a preset name is assigned the first 8 characters. For example,
Grouping0027(states) would be saved as GROUPING.GPG and GROUPING.GRP. To avoid duplication,
subsequent groupings with preset names are assigned the first six characters, followed by a number sign
(#) and a sequence number. For example, GROUPI#7.GPG and GROUPI#7.GRP.

Because file names are limited to 8 characters, the number of characters assigned is reduced as the
number of groups increases. For example, GROUP#10.GPG or GROU#100.GPG.

See Also

Working with groups
New Grouping... (Groups menu)

Groupings... (Groups menu
Group Manager... (Groups menu

Group naming conventions



Group naming conventions

The preset name for a group is "Group [#]" where the number sign (#) indicates a sequence number
assigned to the group in the grouping. Scan/US starts the numbering scheme from one; zero is reserved
for a group called 'Unassigned' which Scan/US automatically creates for all objects not assigned to a
group.

The square brackets [] are used to identify the group key. If there are no square brackets, the entire
name is used as the group key. For example, "District 25" is the group name and key. In "District [25]"
only '25' is the group key. The keys are used to identify groups in data parcels output by the "Copy
Groups..." command.

You can name a group any way you like, using up to 25 characters. A method that includes a key and
relates to the purpose of the group is a helpful one. For example, you could create a grouping named
Territories by ZIP' and within it create groups named for each one of your salespeople.

You can rename groups from the "Group Manager."

See Also

Working with groups
New Group... (Groups menu)

Group Manager... (Groups menu
Grouping naming conventions



Contents (Help menu)

Displays the help system's table of contents. Note that pressing F1 during a Scan/US session displays
context-sensitive help for the currently active menu command or dialog.



Search for Help on... (Help menu)

Displays the "Search" dialog in which you can enter a command or phrase that describes the topic for
which you want information. Or, you can scroll through the keyword entries listed and select the topic
closest to what you are looking for.

If you type an entry in the "Search For" box, you need not type in the entire word, the help system scrolls
the list box to find the keywords in topics that most closely match the entry you type. Choose the "Show
Topics" button to display a list of the matching topics at the bottom of the dialog. Select the topic you
want to view and choose the "Go To" button.



Commands (Help menu)

Starts the help system and displays a list of menus and commands to choose from.



Procedures (Help menu)
Starts the help system and displays a list of procedures to choose from.



Product Support (Help menu)

Tells you how to get help from Scan/US, Inc.



Database (Help menu)

Describes different databases available to you from Scan/US, Inc.



HelpLine (Help menu)

Toggles on or off the display of help messages describing each menu command or tool button.
"HelpLine" is preset to be on, and messages are shown in the title bar of the window.



About Scan/US... (Help menu)

Displays the copyright and current version of Scan/US along with the amount of free memory and storage
on your computer.



Hide... & Unhide... (Window menu)

Use the "Hide..." command to hide selected windows. The command is useful when you have several
windows open to limit the number of windows to what you are working on. When you want to work in
one or more hidden windows, choose "Unhide..." to make them available.

When you choose the "Hide..." command, the "Hide Windows" dialog is displayed and lists all the open
windows, whether or not they are visible on the desktop. Choosing the "Unhide..." command displays
the "Unhide Windows..." dialog which lists all the currently hidden windows. Both dialogs have the
following options for filtering the list of windows to choose from:

All windows
The preset option which lists all the windows.
Study areas only
Lists the windows containing study area maps, including the opening map.
Views of study area
Lists the windows containing views of the active study area.
To select one or more windows, click on its name.
OK
Is active only when you've selected windows.
Cancel
Closes the dialog, and the number of open or hidden windows remains the same.

Tip You can also unhide a view by selecting its name from the bottom of the Views menu.

See Also

The display window
Hiding and unhiding windows



Hide/Show Annotations (Options menu)

This capability is inactive and will become available in a future version of Scan/US. However, you can
use .LOC files as a work-around. Call us for more information.

"Hide Annotations" and "Show Annotations" toggle between hiding or showing annotations that you
created in Annotation mode. Choosing a command toggles to the other.

Annotations are preset to be shown on the map. "Show Annotations" is automatically activated in
Annotations mode.

See Also
Annotation mode



Hide/Show Legend (Options menu)

Shortcut Double-clicking on the legend hides it.

"Hide Legend" and "Show Legend" toggle between hiding and showing a map legend. Choosing a
command toggles to the other. The legend is preset to be shown.

See Also
Legend... (Options menu



Hide Thematic & Show Thematic (Views menu)

"Hide Thematic" and "Show Thematic" toggle the display of a thematic analysis in the map. Choosing a
command toggles to the other.

Choosing "Hide Thematic" is a shortcut for unmarking the "Show layer variables" option in the "View
Variables" dialog for each layer selected for a thematic view. The command is helpful when the thematic
analysis uses a fill color or pattern and you wish to display a grouping. The fill color or pattern would
obscure the grouping from your view, unless you hid the analysis or used a transparent pattern to render
the analysis.

Choose "Show Thematic" to display a hidden thematic analysis. Note that choosing "View Variables..."
when a thematic analysis is hidden automatically activates the "Show Thematic" command. If you cancel
out of the "View Variables" dialog, the thematic analysis remains displayed.

See Also
View Variables... (Views menu)
Working with thematic views

Hiding a thematic analysis




Lat/Long... (Options menu)

Use the "Lat/Long..." command to display a lat/long grid in the active window and to choose a format for
displaying lat/long coordinates in the status bar.

Show latitude/longitude grid

Check this option to display a lat/long grid in the map. If the study area is tiny, smaller than a one
minute increment, the grid is not visible. Checking the box activates the following choices:

Show tickmarks Selecting this option replaces the grid lines with tick marks.
Lines on top Displays the grid on top of any features in the map.

Lines on bottom Displays the grid below any features in the map. Note that the grid is obscured
completely if the map fills the whole window and a polygon feature is rendered with a color or pattern.

Grid attributes

Lets you choose a color and line style for the grid. Click the arrow button to display a palette of 16
colors to choose from; the preset color is yellow. You can choose either a dotted line or a solid line;
the preset style is a dotted line.

Format

You have the following options to display coordinates in the status bar.

deg/min+disp Displays coordinates in degrees and a displacement in one hundredths of a mile
north and east of the nearest minute.

deg/min/sec The preselected option; displays coordinates in the traditional format of degrees,
minutes, and seconds.

deg.tenthds Displays degree coordinates in a decimal format with precision up to four decimal
places (ten thousandths).

Set Default

Tip

Checking this option makes your grid and format choices preset for the rest of the Scan/US session.
Map windows you created before setting the default are not affected. Checking this option also
updates the SCANUS.INI file with your selections. The next time you start Scan/US, your grid and
format choices will be in effect for all windows.

To convert coordinates in degrees, minutes, and seconds to a decimal format: Note that there are 60
seconds/minute and 60 minutes/degree. First, convert the seconds to minutes (divide by 60). Then add
up the minutes and convert them to degrees (divide by 60 again). Add up the degrees and you'll have
the coordinates in decimal format.

See Also

Displaying a lat/long grid in a map window
Changing the map display



Legend... (Options menu)

Shortcut Click on the map legend with the right mouse button.

Use the "Legend..." command to control the display and amount of information in a presentation legend
automatically generated for a map.

A presentation legend consists of a title, the window name in parentheses, and one entry for each layer
on the map. If a grouping is active and its members are visible, the legend includes an entry describing
the grouping and an entry for each visible group. For layers rendered thematically, the legend includes
an entry for each stratum whose objects are visible on the map.

"Presentation Legend” dialog options
Edit Legend

Lists all the entries in the legend for the current map. Modify an entry by clicking on it. A text box is
opened with 'okay' »* and 'undo’

# puttons. Type a new name and click the 'okay' button.
* Displays the entry in the legend.
Hides the entry in the legend.
When the cursor changes to a loop arrow, click to toggle between the check mark and the shade.
Options

Hide nonthematic layer Hides entries for all layers not selected for a thematic view.
Hide groups Hides all group entries.

Include scale Displays a map scale. When printing a map, checking this option includes a scale in
all layouts that do not have a legend field. A scale is always included in layouts with a legend field.

Show counts

For each group or stratum entry in a thematic legend, Scan/US displays the number of objects in
parentheses.

None The number of objects are not shown.

As counts Displays the number of objects as a count value.

As percents Displays the number of objects as a percentage of the fofal number of objects.
Set Default

Saves the Options settings in SCANUS.INI. These options are preset until you change them.

See Also
Show Legend (Options menu)
Changing the map legend
Changing the map display



Load Data... (Data menu)

Shortcut Ctrl-L

Choose "Load Data..." to attach a user data file to the active layer in the study area. The selected file
becomes the active one for the layer.

Note The dialog is also opened by choosing the "File..." button in the "Data Center" However, the
selected file is added to a file list shown in the "Data Center," instead of becoming the active one.

Note While a point data file is loaded as a feature, its data cannot be loaded onto other layers.

Note Do not modify or save user data from another application while it is loaded in Scan/US. Modifying
or saving the data automatically unloads the data and may cause erratic results in thematic views.

"Load Data" dialog options
To select files, Scan/US provides two ways to search directories and filter the file names:
QuickPaths

Displays a list of directories containing user data files to which you have immediate access. The
directories may be located anywhere. Because they have been declared as QuickPaths in the
"Preferences" dialog, Scan/US gives you immediate access to the files in them. You do not have to
switch directories and search for files. Each QuickPath directory is listed by its assigned name and
is preceded by a directory icon ».

Directories
Allows you to traverse drives and search files in the standard Windows way.
List files of type

Filters the list of file names to display a specific type. You can filter the list to show only Excel (.XLS),
dBASE (.DBF), or ASCII (.TXT or .CSV) files. Click the down arrow button to view a list of the
different types. Select the desired type to display only those file names.

The following options are activated when you select a file:
Datalist name

A name you assign to a data file to reference the column headings or field names within the file.
Scan/US uses the datalist name to track the data when loaded.

If you do not enter a datalist name, Scan/US uses the file name.
Caption

A brief description of the data. Scan/US displays the caption at the bottom of the Data menu or in
the "Data Center" dialog when the file is loaded for the active layer. If you do not enter a caption,
Scan/US uses the datalist name.

The first four data files loaded onto the layer, whether loaded automatically from the session file or
loaded manually, are shown at the bottom of the menu. Selecting a caption from the list activates the
data for the layer.

If there are more than four, the "More datalists..." command is shown, and choosing it opens the
"Data Center" dialog.

You can change the number of entries shown at the bottom of the menu by updating SCANUS.INI.
See the "Preferences..." command description for more information.

Key

Tells Scan/US which column or field contains the object keys. They are needed to match each
record in the data file to the corresponding object on the layer.

Click the down arrow button to view a list of column headings or field names, and select the desired
one. If you do not identify the column or field containing the keys, Scan/US assumes they are in the
first column or field.



File in
Displays the path to the directory containing the file.
OK

Activates the selected file and closes the dialog. If you opened the dialog from the "Data Center,"
clicking "OK" adds the selected file to the list in the "Data Center."

Cancel

Discards your selections and closes the dialog.

See Also
Help
Data Center... (Data menu
Loading attribute data
Automatically loading attribute data
Using your own data
Working with data

User's Guide
"Using your own data"



Map Features... (Map menu)

Shortcut Ctrl-F
Use the "Map Features..." command to:

. Add or delete features from a study area.
. Hide or show objects, labels, or groups of any feature in the study area.
. Change the display attributes of objects and labels.

"Map Features" dialog options
Map name text box

Displays the name assigned to the map. If you did not name the study area or view when it was
created, then the preset name Scan/US assigns is shown. To rename the map, click inside the text
box and type a new name. You must press Enter so that the change is recognized.

If you rename a study area, its name becomes part of any subsequent views you create of the study
area. If you rename a view, the change applies only to the view.

Names may be up to 31 characters long, using any character except the equal sign (=) and semicolon

()
. "MapStats" button

Clicking this button displays the latitude and longitude of the map's center points, the vertical and
horizontal extents of the map, and the map scale.

List of features

The dialog lists the features that are currently selected for the map. The order of the features reflects
the way they will be rendered on the map--the feature at the bottom of the list is drawn first, then
each feature above that in successive order. The top feature on the list is the top layer on the
map. Keep this rule in mind when changing the display attributes of a feature or changing the
feature order so that you can avoid the display of one feature obscuring another.

To change the order in the list, click on a feature's name and drag-and-drop it to its new position.
The feature is placed above the one the cursor is on.

An editable feature is identified by the edit icon [&, and the presence of groups by the group icon

T
{bml POPMPFEA.BMP}Pressing the right mouse button to select a feature displays a popup with the
following options:

Hide Objects hides objects on the feature layer.
Hide Labels hides labels on the feature layer

If the commands were previously selected, the popup lists options to redisplay them, "Show Objects"
and "Show Labels."

Note When all objects or labels are visible on the layer, these hide commands also toggle off
visibility settings in the "Object Manager" If only some are visible, choosing the commands hides
them on the map but does not change their visibility settings.

Rename Allows you to rename a feature. When you choose this option, a text box is opened with
'okay' and 'undo’ buttons. Type a new name and click the 'okay' button.

Clear Labels hides visible labels on the feature layer and turns off their visibility settings in the
"Object Manager." Unlike "Hide Labels," visibility settings are toggled off regardless of the number of
visible labels on the layer.

"Show Labels" redisplays labels and toggles on visibility settings

Delete Feature is dimmed when the popup is displayed for a thematic map.--Features can be deleted
only from a study area map. Deleting a feature also removes it from all views created of the study



area. When you delete a feature, check the associated views and make sure that your data are still
represented correctly.

Set Default Allows you to update the selected feature's display attributes in the "Features Directory."
These display attributes become the preselected ones for the feature and are applied to all
subsequent study areas.

Object and label buttons

Clicking an object button opens a selector dialog from which you can modify the objects' display
attributes.

* Opens the "Area Fill Selector" dialog from which you can define borders, colors, and patterns for area
objects.

* Opens the "Symbol Selector" dialog from which you can choose a symbol shape and its colors to
display location objects.

* Opens the "Line Style Selector" dialog from which you can choose a line style, width, and color for line
objects.

If you modify a feature's display attributes, remember to check the feature order, and if necessary change
it, to ensure that the rendering of one feature does not obscure another.

+ Displays the "Label Style Selector" dialog from which you can define a format, font, and style for object
labels.

* The window shade on either the object or label button tells Scan/US to hide all the objects or all the
labels on the feature layer. Shift-Click displays the shade; clicking on the shade redisplays the object or
label sample.

Hiding objects or labels using the window shade is the same as choosing "Hide Labels" from the popup;
hiding objects is the same as choosing "Hide Objects" from the popup.

Update

Clicking this button redraws the map with your selections. The button is active only when you have
changed the features list or any feature's display attributes.

Reset

Discards any changes you made. Scan/US reverts to the settings that were displayed when the
"Map Features" dialog was opened, or to the settings of the last update.

Add Features

Clicking this button displays the "Features Directory" from which you can drag-and-drop selected
features into the "Map Features" dialog.

See Also
Features Directory... (Map menu)
Using selector dialogs
Working with map features
Changing the map display




New Group... (Groups menu)
Shortcut Ctrl-G
Use the "New Group..." command to create a new group in the active grouping.

Choosing the command activates Group mode so you can complete other group operations. If a
grouping is not active, the "New Grouping" dialog is automatically opened so you can create a grouping.
You can create up to 2000 groups in a grouping.

"New Group..." dialog options

You can do the following:

. Change the preset name assigned to the group.
. Change the preset display attributes assigned to the group.
. Predefine groups and add objects to them at a later time.

Group name text box

The preset name for a group is "Group [#]" where the number sign (#) indicates a sequence number
assigned to the group in the grouping. Scan/US starts the numbering scheme from one; zero is
reserved for a group called 'Unassigned' which Scan/US automatically creates for all objects not
assigned to a group.

You can name a group any way you like, using up to 25 characters. See Group naming
conventions .

Object button Example: =or
L ]

The object button indicates the preset rendering for objects in the group.

The preset rendering is determined by the palette chosen when the parent grouping was created. If
you did not choose a palette, then the preset palette assigned by Scan/US is in effect. The number
of choices in the palette determines the number of groups which will be assigned unique renderings
before they are repeated. For example, if a palette has five different colors, they will be assigned to
the first five groups in the grouping. The fifth and following groups will be rendered the same way
unless you choose another rendering in the "New Group" dialog, or at a later time in the "Group
Manager."

Click the object button opens a selector dialog in which you can choose different display attributes.
Add Next

Allows you to predefine empty groups and add objects to them at a later time. To add objects,
activate the group in the "Group Manager" then assign objects to the group.

See Also
Working with groups
Changing the map display
Using selector dialogs

Group mode
New Grouping... (Groups menu)

Group Manager... (Groups menu
Copy Groups... (Groups menu




New Grouping... (Groups menu)

Use the "New Grouping..." command to create and name a new set of groups. The new grouping
becomes the active grouping.

Choosing the command activates Group mode so you can complete other group operations. You can
create as many groupings as desired, limited only by the amount of memory on your computer.

"New Grouping" dialog options

You can do the following:

. Change the preset name assigned to the grouping.
. Change the preset palette which determines how the groups are rendered.
. If a grouping is active when you choose the command, you can use its groups as a starter set for

the new grouping.
To use an existing grouping as a starter set, activate the grouping before choosing the command.
Select the grouping name from the bottom of the Groups menu or from the "Group Manager," or
choose the "Groupings..." command and activate the desired grouping.

Grouping name text box

Enter a name for the grouping. The preset name for a grouping is "Grouping#(layer)" where the
number sign (#) indicates the total number of groupings, including the new one, created across all
sessions.

If the grouping is being created from the "Strata Manager," or by pasting "Copy Variable" output, the
preset name is the variable name.

You may enter any name you like, up to 31 characters. A method that relates to the purpose of the
grouping and reminds you of its originating layer is a helpful one. For example, a grouping named
"Territories by ZIP' could contain groups each named after the salesperson handling the territory. The
name would also remind you that you created it for ZIP codes.

You can rename a grouping from the "Group Manager" and "Groupings" dialogs.

+ "Palette” button
Clicking this button displays the "Palette Selector" dialog from which you can choose, create or edit
another palette to render the groups that will be stored in the grouping.

The palette determines the number of groups that will be assigned unique renderings. For example,
if a palette contains five elements, they will be assigned to the first five groups in the grouping. The
fifth and following groups will all be assigned the same color--unless you change it in the "New
Group" dialog when creating a group, or at a later time in the "Group Manager."

Scan/US has preselected palettes to render groups of each object type. (You can easily identify the
Scan/US palettes by the underscore (_) which precedes each name.) You may choose a different
palette, edit an existing palette, or create a new one. To select a different palette, scroll through the
choices and click on the desired palette, then click the "Select" button.

To design your own palette or modify an existing one, see the "Palettes.." command description.
Clear current grouping

This option is preselected to create a new grouping. If another grouping is active, its groups are
cleared from the map display; they are not actually deleted.

Use current grouping

Copies the groups you created in the active grouping to the new one. This way you have a starter
set of groups which you may modify for the new grouping.

See Also
Working with groups



Changing the map display
Group mode

Group Manager... (Groups menu
Groupings... (Groups menu
Palettes... (Options menu



New Layer... (Objects menu)

Use the "New Layer..." command to create a layer on which object definitions, the set of points needed to
render an object, can be edited and on which you can create new objects. Choosing the command
activates Edit mode; in all other modes object definitions cannot be modified nor new ones created.

When you choose the command, a submenu of options is displayed. Each option corresponds to one of
the Edit submodes. The "New Layer..." dialog can be opened by either selecting one of the command
options or by activating one of the Edit submodes

When the new layer is created, the map itself does not look any different. (Remember layers are like
transparencies which contain the features on a map.) However, the new layer's name is automatically
added to the window's layer list box and is preceded by the edit icon. You will also find the layer
included in the features list in the "Map Features" dialog and in the "Features Directory." The new layer
can be treated like any other feature layer: you can add it to other study areas, which automatically adds
the layer to views of the study areas; change object display attributes and labels; copy objects and data;
copy and paste objects or groups; cross-reference objects on other layers and attach data; create
thematic views, etc., and save it.

"New Layer" dialog options
Name

Displays the preselected name Scan/US assigns to the layer. The name is composed of the object
type and sequence number. The object type corresponds to the submenu option you selected, or to
the Edit submode you activated. The sequence number indicates how many editable layers of a
specific type are in the study area including the one you are creating.

Creating a new layer for line objects will assign a name of "Lines#;" for buffer areas a name of
"Areas#;" and for polygons or area objects a name of "Polygons#;"

You may name the layer using any convention that suits you.
First object key

Displays the unique identifier that will be assigned to the first object created or copied to the layer.
The object key is composed of a code that reflects the object type and a sequence number.

The codes are "Loc" for locations or point objects, "Line" for line objects, "Pgn" for polygons or area
objects, and "Area" for ring areas. The sequence number is important for creating and tracking
object IDs. Each object placed on the layer will be automatically assigned a key with the sequence
number increasing by one. Each key being a different sequence number makes each one unique
and ensures that the correct data can be attached to it. For example, if you click in different places
to create point objects on a locations layer, the first object is labeled Loc001, the second Loc002, the
third Loc003, and so on.

You may choose a different code up to 11 characters long. Including a sequence number is optional,
in which case, Scan/US will begin the sequence with 001.

Object and label button
o, =]

On the face of each button is a sample of the preset rendering assigned to the new layer. Clicking a
button opens a selector dialog in which you can modify the rendering.

Radius

Determines the size of a study area created for a selected object. The size is equivalent to the
selection rectangle surrounding the object plus the radius distance measured around the rectangle.

You may enter a different radius by selecting the text then typing in the desired value.

For point and line objects, the radius also defines the buffer area surrounding the object. A point
object has a preselected radius of 3 miles to define its ring area; a line object has a preselected
radius of one mile to define its corridor. Scan/US uses these buffer areas when you have a selected



a point or line object to group objects on another layer with the "Group By Object" command.

The radius is calculated according to the active unit of measure for distance. The preselected unit of

measure for a session is miles (mi). You may change it to kilometers (km) using the "Distance"
command.

To change the radius after creating the layer, choose the "Radius..." option in the Attributes menu of
the "Features Directory."

See Also
Working with objects
Changing the map display

Using selector dialogs
Edit mode

Features Directory... (Map menu



New Study Area... (Map menu)
Shortcut Ctrl-N
Use the "New Study Area..." command to create a new study area whose boundaries were defined by:

* Drawing a framing rectangle in Frame mode.

* Zooming into the study area. If you are not zoomed in, then activating this button creates an exact
copy of the entire study area.

= Selecting an object on the map in Select--Object mode

= An object definition sent to the clipboard by the Copy Obijects... (Objects menu) command or by
Scan/US Geocoder.

The new study area is loaded into its own window. Map features and data are also loaded into the study
area and limited to the bounded region. You may create views of the data in the study area.

"New Study Area" dialog options

When you choose the command, or double-click inside the framing rectangle, the "New Study Area"
dialog is opened. It displays the center point coordinates and vertical and horizontal extents of the new
study area. You can do the following:

Change the preset name assigned to the study area.

Change the extents of the study area.

View the list of features automatically loaded into the study area.
Add or remove features.

Change a feature's rendering in the map.

Name text box

Displays the preset name Scan/US assigns to the study area. To rename it, click inside the text box
and type the desired name.

You may use any naming convention you like; however, one that helps you keep track of the different
study areas is recommended. See "Study area naming conventions"

Names may be up to 31 characters long, using any character except the equal sign (=) and semicolon
).
Extents

Displays the vertical and horizontal extents of the new study area. To change the extents, click
inside the text box and type the desired value.

Maximize

This option is preset to maximize the window for the new study area. Clear the check box if you do
not want a maximized window.

Features...

Displays the "New Map Features" dialog which shows you the features Scan/US automatically loaded
into the new study area. You may remove these features or add to them as needed for your
analysis.

Scenarios

Displays the Scenarios dialog which lets you choose a set of features and thematic analysis for the
new study area.

See Also

Working with study areas
Study area naming conventions

'New Map Features" dialog
Scenarios dialog



Study area naming conventions

A study area of a selected object is pre-assigned the object name. If the name includes a colon (:), only
the part preceding the colon is shown in the study area name. For example, if you create a study area
around a major metro intersection such as 'Main St. & Hwy 203:Monroe, WA:,' only 'Main St. & Hwy 203’
is in the preset name.

All other study area are named "StudyArea#" in which the pound sign (#) denotes its sequence number
during the session. The United States opening map is equivalent to StudyArea0000.

When you create study areas, use any naming convention you like; however, one that helps you
distinguish them is recommended. Names may be up to 31 characters long, using any character except
the equal sign (=) and semicolon ().

You can rename a study area at a later time using the "Map Features..." command or the "Save Study
Area..." command.

Saved study areas

When you save study areas, their contents are stored in .SSA files in your Scan/US home directory. The
study areas you name are assigned the first 8 characters, excluding blanks. For example, a study area
named K-Mart Study would be saved as KMARTSTU.SSA.

The first grouping saved with a preset name is assigned the first 8 characters. For example,
StudyArea0022 would be saved as STUDYARE.SSA. To avoid duplication, subsequent study areas with
preset names are assigned the first six characters, followed by a number sign (#) and a sequence
number. For example, STUDYA#7.SSA.

Because file names are limited to 8 characters, the number of characters assigned is reduced as the
number of save study areas increases. For example, STUDY#10.SSA or STUD#100.SSA.

See Also

New Study Area... (Map menu)
Map Features... (Map menu)

Save Study Area... (Map menu



"New Map Features" dialog

Open this dialog by clicking the "Features..." button in the "New Study Area" dialog.

The "New Map Features" dialog lists all the features that will be automatically loaded into the study area
when you click "OK." Each feature is selected according to visibility ranges defined for its objects and
labels. The visibility ranges determine an acceptable size of a study area into which a feature can be
added. If the feature is preset with an optional 'autoload' capability, Scan/US automatically loads the
feature into any study area whose vertical extent is within the visibility ranges.

Each time you create a study area, Scan/US compares its vertical extent to each feature's visibility ranges
and checks for an autoload specification. As a result, when you create different-sized study areas, some
features are visible in them and others are not. Or, the objects are visible but the labels are not.
Generally, the larger the study area, the less detailed features are visible.

Each feature also has preset display attributes which ensures that the rendering of one feature does not
obscure another when loaded into the new study area. Unless you err in modifying the display attributes,
Scan/US provides a map in which all the loaded features are correctly displayed.

To modify the preset visibility ranges and rendering, please see the "Features Directory..." command
description.

Dialog options

The capabilities provided in this dialog--to add and remove features and change a feature's display--apply
only to the new study area. These capabilities are also provided in the "Map Features" dialog, except
that you are using them after creating the study area.

Please see the "Map Features..." command for a more detailed description. A brief description is
provided below.

Object and label buttons
Examples: =,

[ ]

On the face of the object and label buttons preceding each feature name is a sample of the preset
rendering assigned to the feature. Clicking a button opens a selector dialog in which you can modify the
rendering.

* A window shade on a button indicates that the objects or labels will be hidden when the feature is
loaded into a study area. Click the shade to display the sample; Shift-Click to redisplay the window
shade.

Add Features

Displays the "Features Directory" from which you can drag-and-drop new features into the "New Map
Features" dialog.

OK

Accepts any changes made to the features listed and redisplays the "New Study Area" dialog.
Cancel

Discards any changes you made to the features listed and redisplays the "New Study Area" dialog.

See Also
Changing the map display
Features Directory... (Map menu)
New Study Area... (Map menu
Map Features... (Map menu)
Using selector dialogs







New Thematic... (Views menu)

The "New Thematic..." command lets you create a thematic analysis of the current study area in a new
window. When you choose the command, the "New Thematic" dialog is opened--providing all the same
buttons and options as the "View Variables..." command.

You can also:

. Name the new view. See Thematic view naming conventions for more information

. Choose to maximize the window or not.

The views you create are listed, along with the study area, at the bottom of the "Views" menu and can be
activated from there.

Another use of the command is to create different views of a study area to try out different map
presentations. In each view window you create, clear the "Show layer variables" option for each feature
layer in the map. Then open the "Map Features" dialog, and modify the features' display attributes as
desired. Next, tile the windows to compare the different views.

If you add features or create groups in a view map, they are also added, but hidden, to the original study
area and to associated views. Closing a study area window automatically closes all its view windows.



Thematic view naming conventions

When you create a thematic view with the "New Thematic..." command, Scan/US names the new view
unless you enter a different one. The preset name includes the study area name and the view's
sequence number in parentheses. For example, United States(V1) or StudyArea0002(V1).

You may use any naming convention you like, however one that helps you keep track of the different
study areas and their views is recommended. Names may be up to 31 characters long, using any
character except the equal sign (=) and semicolon (:).

See Also
New Thematic... (Views menu)
View Variables... (Views menu)
Working with thematic views




Object Manager... (Objects menu)
Shortcut Ctrl-O

Use the "Object Manager..." command to select objects from a list of objects on the layer and to do the
following:

. Control the visibility settings of one or more objects, their labels, or thematic charts (box graphs,
pie charts, or bar charts).
. From the Action menu:

-- Show the selected object on the map.
-- Assign the selected objects to a group.
-- Copy a list of selected objects to the clipboard.

"Object Manager" dialog options

The "Object Manager" lists all the objects on the active layer. If you activate another layer by choosing it
from the window's layer list box, the objects on that layer are listed. To see more objects listed at one
time, lengthen the dialog by dragging its top or bottom edge.

Objects are listed in sorted order by object key, except for streets, highways, DMAs, and user-defined
objects which are listed alphabetically by name.

Selecting objects

You can select objects in different ways. The objects you select are not indicated on the map; they are
independent of the object or group currently active on the map.

Point-and-click

A click selects an object. Shift-Click to select multiple objects in sequence; Ctrl-Click to select
multiple objects not in sequence.

Find

Selects objects whose names match the criteria you enter. Scan/US matches your entry with each
word in an object name. For example, you can enter 'Ar' to select Arizona and Arkansas. "York' or
'New York' will select New York. Find entries are not case-sensitive.

Pressing Enter, Tab, or the "Find Next" button selects the first object in the list that matches your
entry. The object name is outlined in red.

* Pressing the "Find Next" button selects each subsequent matching object name. The button is
dimmed when there are no more matching entries.

Tip Pressing the spacebar also selects subsequent matching entries.

Note The "Object Manager" only lists up to 6528 objects--a limit imposed by Windows. Therefore, if a
layer has more objects (such as a streets layer), you may not find any matching entries in the list.
Select objects in group(s):

Choosing one or more groups from the drop-down list box selects their members in the list. When
grouped objects are selected, an indicator of the group rendering precedes each object's name.

The arrow button to display a list of groups to choose from is dimmed until a grouping name is
selected.

in [no groupings on layer]

Indicates that groupings are not present on the layer, and you cannot use groups to select objects in
the list. If groupings are present on the layer, the option changes to "[no grouping selected]."

You must select a grouping before you can choose groups to select objects in the list.
Select menu

Provides options to select different object sets available on the layer. See "Select menu in Object
Manager."




Controlling visibility
Preceding each object name are three icons, one for each attribute:

* |ndicates object visibility.

* |ndicates label visibility.

* |ndicates thematic chart visibility.

The presence of an icon means the attribute for the object is displayed (on); the absence of an icon
means the attribute is hidden (off). Icons for thematic charts are only present in thematic views that
present data using box graphs, bar charts, or pie charts. You can turn off the object's rendering or its
label, or both at the same time; however, a thematic chart can only be shown when its object is also
visible.

To toggle visibility, select objects, then click the button for the attribute you want to turn off, or the button
to turn it on.

Note Layer visibility settings can override an individual object's (or label's) visibility settings. For
example, if all objects are visible, choosing "Hide Objects" from the layer popup in the "Map Features"
dialog turns OFF the visibility settings. If only some objects are visible, choosing "Hide Objects" hides
them on the map but does not change their visibility settings.

See Also
Select mode
Select menu in "Object Manager"
Action menu in "Object Manager"
Working with objects
Working with groups
Map Features... (Map menu)
Changing the map display




Select menu in "Object Manager"

Allows you to select a set of objects from the list in "Object Manager."

"All objects" selects all objects.

"All found" selects all objects meeting criteria entered in the "Find" box.

"Current object" selects only the object currently selected on the layer.

"Filtered objects" is only active in a thematic view in which you modified the stratification. This
option selects all objects in non-hidden strata or whose values are within the maximum and minimum
values of the stratification.

. "Invert selection" tells Scan/US to select the objects that are not currently selected on the layer.
The objects originally selected become unselected.

. "Visible objects" selects only objects currently visible on the layer.

. "Visible labels" selects only objects whose labels are currently visible.

. "Visible charts" selects only objects whose thematic charts are visible.

. "Invisible objects" selects only objects whose visibility settings are off.

. "Invisible labels" selects only objects whose labels are not visible.

See Also
Object Manager... (Objects menu
Working with objects




Action menu in "Object Manager"

After selecting one or more objects in the "Object Manager," you can act on it with the following:
Show Object

Highlights on the map the object selected in the list.  Choosing this option automatically activates
Select mode. ltis also active in Group or Edit mode. If multiple objects are selected, only the first
object is highlighted.

Shortcut Double-clicking on the object name select the object and shows it on the map.
Assign to Group

Assigns the selected objects to the active group on the map. Choosing this option automatically
activates Group mode.

To assign the objects to a new group, choose the "New Group..." command before choosing the
option.

If no groups are present on the layer, Scan/US prompts you to name a grouping and group for the
selected objects.

Copy Selected
Sends to the clipboard a list of the selected objects, their keys, and captions.

This option is useful for creating a list of object keys you can import into your own data files so they
can be loaded into Scan/US.

See Also
Object Manager... (Objects menu
Working with objects
Working with groups



Palettes... (Options menu)

Use the "Palettes..." command to create, edit, or delete a palette--a collection of preselected display
attributes which are used to render groups or represent a thematic analysis. Palettes are classified by
object type or thematic presentation. For example, AreaFill is a class of palettes used to render grouped
area objects; ChartColors to render box graphs in a thematic view.

Scan/US provides a set of built-in palettes which are preselected to render groups or a thematic analysis,
and cannot be modified or deleted. However, you can use the built-in palettes as a starter set to create
your own and make your palettes the preselected ones. All Scan/US palette names begin with an
underscore (_) to help you distinguish them.

"Palette Selector" dialog
Palette name drop-down list

Shows the name of the selected palette. Select another palette by choosing its name from the drop-
down list, or by scrolling the displayed palettes and clicking on the desired one.

Number box
Shows the number of elements in the selected palette. Sixteen is the maximum.
Palette class drop-down list

Shows the class of palettes that are currently displayed in the dialog. To work with a different set of
palettes, click the arrow button to display a list and select another class. Scan/US provides the
following classes:

Area Fill Displays palettes with different borders, fills, patterns, or transparencies.
Symbols Displays palettes of different symbol shapes and colors.
Lines Displays palettes containing different line styles and colors.

ChartColors Displays palettes of different colors for box graphs, bar charts, and pie charts used to
represent a thematic analysis.

Set Default

Lets you preset the palette Scan/US uses to render groups or a stratification in a thematic view.
Select a palette, then choose the desired option.

Thematic Preselects a palette to render a thematic stratification.
Groups Preselects a palette to render groups
Select

This button becomes active when the "Palette Selector" is opened from the "New Grouping," "Group
Manager," or "Strata Manager" dialogs. These dialogs use preselected palettes which you may
override by choosing another palette, then clicking "Select."

Delete

Deletes the selected palette from the "Palette Selector" dialog. The button is dimmed when you
select built-in Scan/US palettes; they cannot be deleted.

New>>

Allows you to create a new palette. Clicking the button opens the selector dialog for the current class
and an empty work area palette.

Edit>>

Allows you to modify an existing palette. Clicking the button opens the work area palette with
elements from the currently selected palette.

Work area palette
Create or edit a palette by defining attributes in the selector dialog then adding them to the work area.



You can drag-and-drop to any cell in the work area, or click "Select" in the selector dialog, and the
selected cell in the work area is automatically updated.

To rearrange elements in the work area, you can drag elements to the desired cell; elements
automatically move to the right to make room for the new one. To delete an element, drag it off the
palette.

When the work area palette is open, the following options are available:
Name text box

Shows the preselected name. If you are creating a new palette or modifying a built-in palette, the
preselected name is 'new palette." If you are modifying a user palette, the preselected name is its
current name. Type in the desired name.

Save

Saves the palette and updates the [Palettes] section in SCANUS.INI which lists a declaration for each
palette you create.

OK
Saves the palette and updates the [Palettes] section in SCANUS.INI. Also closes the expanded
dialog.

Cancel

Closes the expanded dialog and discards any changes you have not saved.

Tip To create a new palette, you can start by editing a built-in palette and saving it with a new name.
Because the built-in palettes cannot be modified, the name text box says '[new palette]' instead of the
Scan/US palette name.

See Also
Help
About palettes
Changing the map display

Reference Manual
"Palettes..."



About palettes

Palettes... (Options menu

New Grouping... (Groups menu)
New Group... (Groups menu)

'Strata Manager" dialog

Scan/US provides several built-in palettes which are preselected to render groups or represent a thematic
analysis. You can view these palettes in the "Palette Selector" dialog; all Scan/US palettes begin with an
underscore (_). The "Palette Selector" also allows you to create and modify your own palettes, and
make them the preselected ones.

Group palettes

The preselected palettes to render groups--_GroupFill, _GroupSymbols--are applied in the "New
Grouping" dialog. The display attributes of each palette element are assigned to a group in the
grouping. The number of elements in the palette determines the number of groups that will be assigned
unique display attributes before they are repeated. If you want all the groups in a grouping to have
unique renderings, you can choose a different palette or create a new one when the grouping is created.
You can also change the display attributes assigned to a group when it is created in the "New Group"
dialog, or at a later time in the "Group Manager" dialog.

Thematic palettes

_StratSymbols, _StratFill, and _ChartColors are preselected to represent a variable's stratification, or to
render thematic charts. These palettes are applied in the "Strata Manager" dialog.

The number of elements in the preselected palette determines the initial number of strata displayed for a
variable in the "Strata Manager." You can define up to twelve strata for a selected variable. If you have
fewer strata than the number of palette elements, Scan/US assigns the elements to maximize contrast in
the thematic map. If you have more strata than palette elements, then one or more strata will have the
same rendering and result in a misleading map. Choose another palette, add more elements to the
current palette or design your own palette.

In _ChartColors, each palette element is assigned to render a variable selected for the analysis. You
can select up to six variables. If you have more variables than palette elements, then one or more
variables will have the same rendering.

+ "Palette" button

The "Palette" button is displayed in the "New Grouping" and "Strata Manager" dialogs. Clicking the
button opens the "Palette Selector" dialog so you can select, create, or edit another palette.

Note There is some disparity between the colors you see on the screen and how the colors appear
printed out. How different they are depends on the monitor and printer you are using. Depending on
the output device you are using, you may need to modify a palette's colors and see how they appear
printed out. Once you define a palette that meets your presentation needs, you can save it and then
reuse it as often as needed.

See Also

Changing the map display
Changing group rendering

Modifying a variable's stratification
View Variables... (Map menu)

Working with thematic views




Paste Groups (Groups menu)

Use the "Paste Groups..." command to create a new grouping from group assignments sent to the
clipboard with the "Copy Groups..." or "Copy Variable..." command, or from an external data file.

The external data file must be set up like the parcels output by the "Copy Groups..." or "Copy Variable..."
command.

If necessary, you can view the assignments in the clipboard with the "Show Clipboard..." command in the
Window menu, or paste and view them in another application.

See Also
Copy Groups... (Groups menu
Copy Variable... (Views menu
Show Clipboard... (Window menu

Data parcels
Copying and pasting groups



Paste Link (Data menu)

This capability has been removed from this release. It will become available in a future version of
Scan/US.

Use this command to load data in an Excel spreadsheet as a datalist for the active layer. Choosing the
command sets up a Dynamic Data Exchange (DDE) link between Excel and Scan/US.

"Paste Link" provides another way of loading data onto a layer. But unlike other loaded datalists that are
analyzed in a thematic view, you can return to the Excel window and modify the data, then see the
changes automatically updated in the thematic view. In this way, Excel acts as a data server (and
Scan/US as a mapping server) that allows you to analyze data you may have in a number of applications.

You can thematically render any data that can be imported into Excel. To find out which data you can
import, see the Microsoft Excel User's Guide. Once the data is in Excel, you must prepare it for use with
Scan/US as you would any Excel external data file.

Preparing the data
The data must be formatted as a [data] parcel.

. The keyword, [data], must be in the first cell of the first row and column. The keyword must be in
the row preceding the column headings.

. Make sure the first column contains the object keys to link them to the corresponding objects on
the layer.

. Sort the data by the object keys.

. Data columns which are numeric variables can be analyzed in a thematic view. Text variables

are linked; however, they can only be viewed in "QuickLook" or used to create groups.
Setting up the link

To set up the DDE link, start Excel and Scan/US. Next, select the data in Excel, making sure there are
no blank rows or columns, and choose the "Copy" command from the Excel Edit menu. In Scan/US,
note the parcel icon & in the upper right of the window, indicating that usable data has been detected in
the clipboard. Activate the layer you want to link to and choose "Paste Link" from the Data menu.

Analyzing the data
To analyze the data in a thematic map, choose the "View Variables..." or "New Thematic..." commands.

See Also

Paste Link (Groups menu)
Working with data

Using your own data

User's Guide
"Using your own data"



Paste Link (Groups menu)

Use this command to assign objects to groups on the active layer using group assignments formatted as
a [grouplist] parcel in an Excel file. After copying the formatted data, choosing the command sets up a
Dynamic Data Exchange (DDE) link between Excel and Scan/US. While the link is active, changing the
group membership in one program is automatically reflected in the other. If the Excel data also contains
formulas which aggregate the data for each group, then paste linking becomes a helpful tool in playing
‘what if games with your data.

Setting up the data in Excel

Your data must be formatted as a [grouplist] parcel that includes a keyword, object keys, and group
names.

. The keyword, [grouplist], must be in the first cell of the first row and first column. If necessary,
insert a row and add the keyword.
. All the object keys must be unique and entered as text data in the first column. If the object keys

are numeric, you must add a pound sign (#) to precede each one so they are recognized as text data.

The object keys should match the object keys on the layer. They must also be sorted in ascending order.
The object keys that don't match will not be linked. They will be rendered as unassigned objects.
Grouping objects with unmatched keys does not update the spreadsheet.

. The second column contains the group assignments and must have an entry for every object.
If some objects will not be assigned, make sure that they have object keys and a group name of 0
(zero entered as a number, not text data). Scan/US will recognize them as unassigned objects
and will not change their original rendering.

After formatting the data, select the keyword and columns of data, and choose the "Copy" command from
the Excel Edit menu. The data is in the clipboard for Scan/US to link.

Linking the data in Scan/US

When Scan/US detects usable data in the clipboard, the parcel icon = is displayed in the upper right of the
window. To set up the DDE link, activate the layer which will contain the groups and choose "Paste Link"
from the Groups menu. If you have not yet created a grouping for the groups, Scan/US prompts you to
name one, and the groups are shown on the map.

The linked grouping can be handled like any other grouping. For example, choosing the "Clear Groups"
command only clears the grouping from the map; it does not cut off the DDE link. Like other groupings of
the study area, the linked grouping can also be displayed in any views of the study area.

If you have more than one grouping set up in the same spreadsheet, each one must be formatted as
described and can be linked to Scan/US. A grouping can be linked to the same layer in two or more
study areas. Or, a grouping can be linked to multiple layers (e.g. States and States 1:3) in the same
study area.

Changing group membership in either Excel or Scan/US will automatically update the group assignments
in the other study areas and layers.

See Also
Help
rouplist] parcel
Paste Link (Data menu)
Working with groups
Hot-linking group assignments
Using your own data

User's Guide
"Using your own data"



Paste Objects (Objects menu)

Use the "Paste Objects" command to paste locations sent to the clipboard with "Copy Objects...,"
Scan/US Geocoder, or another application. The locations are pasted onto an editable layer.

Objects pasted onto a layer retain their object keys unless they duplicate the keys of other objects on the
layer. In this case, Scan/US opens a dialog that lets you decide if objects with duplicate keys replace
their counterparts on the layer, are assigned a new key, or are to be ignored.

See Also
Edit mode
New Layer... (Objects menu

"Paste Objects" dialog
Working with objects



"Paste Objects" dialog

This dialog is opened when the objects you are pasting from the clipboard duplicate the keys of objects
on the layer. Choose one of the following options:

Do not paste duplicates
Objects with duplicate keys are not pasted onto the layer.
Paste objects with new keys
Assigns new keys to the duplicate objects when they are pasted. Preselected option.
Replace objects on the layer
Duplicate objects on the layer are removed when the objects are pasted.
Continue
Pastes the objects from the clipboard according to your selection.

See Also

Paste Obijects (Objects menu)



Preferences... (Options menu)

This capability has been removed from this release. It will become available in a future version of
Scan/US.
Use the "Preferences..." command to specify the following:

. Additional fonts. See Adding fonts for more information
. User data QuickPaths. See Adding QuickPaths for more information.

. Hide or show the map extents in the window title bar. See Map extents for more information.



Print... (Map menu)

Use the "Print..." command to print the map in the current window using a customized page layout.
Scan/US provides a selection of layouts for which you can choose the desired maps and include
descriptive text and a header or footer.

Printer

The default printer is shown in the list box. Click the down-arrow button to display a list of available
printers and choose another one.

Printers...
Lets you change the printer setup.
Print layout

The name of the last layout you used is shown in the list box. Click the down-arrow button to display
a list of layouts and choose another one.

N — ]
A blueprint of the selected layout is displayed. Each rectangle, called a field, is a place-holder for a

layout element such as a map, title, date, or descriptive text. An empty field is white. A filled-in field is
solid gray. A selected field is outlined in red. Click on a field to select it.

{— ) — L m—

Click the right-left-arrow buttons to select each field in successive order.

oSelect [map]:
™ United States +

+
The work area displays the contents for a selected field. For example, a selection of map windows is
shown when the map field is selected. The contents you can modify vary according to the selected
layout. For example, you change the map title or footer, but not the north arrow.

Your map selections remain in effect for the session until you choose another layout. Your text
entries remain in effect until you change them, choose another layout, or choose "Reset."

When a layout uses the window name as descriptive text for a map, you may change the text. Your
changes remain in effect as described above, or until you choose another map.

Copies
Enter the desired number of copies.
Map Background

Check this option to print the current background color. The option is preset to be unchecked so that
the map background is the color of the paper you are printing on.

The status of this option also determines printing the background when you use the "QuickPrint...'
command.



Reset
Returns all text entries to their defaults. Choosing "Reset" does not change your map selections.

Note Some disparity occurs between the colors you see on the screen and how the colors appear
printed out. How different they are depends on the monitor and printer you are using. Depending on your
output device, you may need to modify a palette's colors and see how they appear printed out.

See Also
Dictionary... (Options menu
Background... (Options menu
QuickPrint... (Map menu)
Printing a map or report
Changing the map display




QuickLook... (Views menu)

For a description of data variables, please see Product Database

Shortcut Ctrl-Q

Use "QuickLook..." to view the data for a selected object or group, and compare the data to a
benchmark. Choosing the command opens a window and displays the data.

If you are not in Edit, Group, or Select modes, choosing the command activates Select--Object submode.
If an object is not selected, "QuickLook" displays data for the most recently selected object, or the first
object in the object list..

Tip
In Select--Object submode, double-clicking on an object opens the window.
"QuickLook" dialog options

When you open "QuickLook," variables from the active datalist are shown. You can scroll to view the
variables, or lengthen the dialog to see more of them at one time. While the "QuickLook" window is
open, you can:

Select variables to view.

Select another group or object to view its data.

Contract the variable list to show only selected ones.

Copy the data to the clipboard.

Print the data.

Save the data as a record in the benchmark file.

Expand the dialog and compare the current selection to a benchmark.
Switch datalists to view more data for the selected object or group.
Selection list box

Shows the name of the currently selected object or group. Selecting an object or group on the map
displays its data.

Click the down-arrow button to display a list of objects or groups to choose from. If the "Show
Object" » button is active, objects are listed; "Show Group"

* groups.
» Click these buttons to select each object or group in the list in successive order.

Note The selection list reflects the visibility settings of objects. If you turned off visibility settings in the
"Object Manager" or have hidden strata in a thematic view, these objects are not included in the object
list. For more information see the "Object Manager..." and "View Variables..." command descriptions.
Note You can also activate another grouping from the Groups menu or from the "Groupings" dialog.
Variables list

Click on a variable to select it. Shift-Click to select multiple variables in sequence; Ctrl-Click to select
multiple variables not in sequence.

You can toggle the following buttons:

(= Expands an array variable so you can select its cell variables.

[l Closes the array.

* Data for the count variable is displayed as a count value.

+ Data for the count variable is displayed as a percentage of a base variable.

You can select variables from another datalist while the "QuickLook" window is open. Choose the
datalist from the bottom of the Data menu or choose the "Data Center..." and "Load Data..." commands.

Tip Because only one datalist is active at a time, selecting another datalist will remove a thematic
analysis of the current datalist.



"Contract" and "Expand"
Active when one or more variables are selected, click "Contract" # to shorten the list and display only
the selected ones. Clicking the button toggles to "Expand"

"Clipboard”
Sends data for the selected object or group to the clipboard. All variables are sent unless the list is
contracted to selected variables.

"Print"
Prints an Excel report of the data for the selected object or group. All variables are sent unless the
list is contracted to selected variables. See also QuickLook report dialog

"Save Benchmark"

Saves the data as a record in the Scan/US benchmark file. All variables are sent.

* "Show Object"
If a group's data is displayed, click this button to view the data for a selected object.

"Show Group"
If an object's data is displayed, click this button to view the data for the active group.

"Sum" and "Average"
For count variables, the "Sum" and "Average" buttons toggle to display the sum and average of the
selected group's data. Clicking the "Sum" button = toggles to the "Average" button

@ "Show Benchmark" and "Hide Benchmark"
Toggle to expand and contract the dialog to show and hide benchmark data. Clicking® expands the
dialog; the button toggles to

See Also
Help
Viewing summarized variables in 'QuickLook"
Benchmarking in "QuicklLook"
Working with data

Printing a map or report

Reference Manual
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Viewing summarized variables in "QuickLook™

If you are viewing data for groups or data cross-referenced on another layer, Scan/US automatically
summarizes variables to give you an aggregate view. Data for each object in a group is combined to
give you a summary for the group. Cross-referenced data is combined to give you an aggregate view
for a selected object or group. See the "Data Center..." command for more information on cross-
referencing data.

If the current datalist is from the Scan/US product database, count variables are totaled, and statistic
variables weight-averaged in the aggregate view. Percent views are calculated by dividing the values of
each count variable by its base variable. Weighted averages are calculated by first multiplying the
values of each statistic variable by its base variable, totaling the results, then dividing this total by the total
of the base variable's values.

In a user data file, all variables, including statistic variables, are totaled, unless you tell Scan/US how to
summarize them. Text data items in user data files are shown with gray blanks in an aggregate view.
To differentiate user data variables by their type--count, average, statistic, etc.--you must identify each
variable as 'count' or 'statistic." To generate percent views or weighted averages, you must identify the
base variable which must be in the same user data file. Procedures on updating user data items to
distinguish the different variable types are in the User's Guide.

See Also
Help
QuickLook... (Views menu
About variables
Viewing a groups data
Viewing selected variables in a datalist
Working with data
Using your own data

User's Guide
"Using you own data"

Reference Manual
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Benchmarking in "QuickLook™

Clicking the "Show Benchmark" = button expands the "QuickLook" dialog to display benchmark data to
which you can compare the data of the currently selected object or group. Note that all options and
buttons relating to benchmarking are colored or outlined in red. This will help you distinguish them from
the others in the window.

While the benchmark data is displayed, you can continue selecting objects and groups and compare their
data to the benchmark. You can also change the benchmark to make additional comparisons. You can
do the following:

. Compare a selected object or group to a U.S. benchmark Scan/US provides.

. Compare a selected object or group to a previously saved benchmark.

. Compare a selected object to an object benchmark.

. Compare a selected object to a group benchmark.

. Compare a selected group to a group benchmark.

Viewing benchmark data

When you expand the dialog, the currently selected object or group is the benchmark. Its data is
duplicated in the benchmark column. If a group is active, and an object selected, the group data is the
benchmark, unless there is a U.S. benchmark.

The benchmark data is provided for the current selection of variables. Choosing different variables
displays their benchmark data. The loop-arrow button toggles between the actual data values and index
values created by dividing the selected object's or group's data by the benchmark data.

Selecting another benchmark

You select a benchmark from the benchmark drop-down list box. Whether the active benchmark is an
object, group, or from the file, the list provides others you can choose. If the current benchmark is an
object, then the list shows objects on the active layer; if a group, then group names in the active grouping;
if from the file then other U.S. benchmarks or saved benchmarks.

Click the down arrow button to the right of the benchmark name to display a list of names. Then, click on
the desired name. Or, click the up-down buttons to the left of the benchmark name to successively
select each name in the list.

You can also select objects and groups on other layers. The benchmark list box includes a list of layer
names and groupings. Choosing a different layer displays its objects in the drop-down list; another
grouping its member groups.

The drop-down list also provides a button to delete a previously saved benchmark.
The following buttons will help you choose another benchmark:

*+ "Object Benchmark"
Click this button to choose object benchmarks, then select the desired object from the drop-down list.

* "Group Benchmark"”
Click this button to choose group benchmarks, then select the desired group from the drop-down list.

* "Filed Benchmark"
Click this button to select a U.S. benchmark or a previously saved benchmark from the file, then
select the desired one from the drop-down list.

See Also
Help
QuickLook... (Views menu
Viewing benchmark data
Working with data
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"QuickLook" object selection

When the "Show Object" # button is active, the selection drop-down list displays a list of objects on the
active layer. Select the desired object from the list to view its data

* Click these buttons to select each object in the list in successive order and view their data.

See Also

Viewing an objects data
Working with data

QuicklLook... (Views menu)




"QuickLook" group selection

When the "Show Group" = button is active, the selection drop-down list displays a list of groups on the
active layer. Select the desired group from the list to view its data

* Click these buttons to select each group in the list in successive order and view their data.

See Also

Viewing a groups data
Working with data

QuicklLook... (Views menu)




"QuickLook" file benchmark

When the "Filed Benchmark" = button is active, the benchmark drop-down list displays a list of U.S.
benchmarks and previously saved benchmarks. Select the desired benchmark to view its data and
compare it to the current selection. The benchmark data is outlined in red.

* Click these buttons to select each group in the list in successive order and view their data.
The "Delete Benchmark" button is activated when you select a previously saved benchmark. Click the
button to remove the benchmark from the file.

See Also

Viewing benchmark data
Working with data
Benchmarking in "QuicklLook"

QuickLook... (Views menu)



"QuickLook" group benchmark

When the "Group Benchmark" # button is active, the benchmark drop-down list displays a list of groups on
the active layer. Select the desired group from the list to view its data and compare it to the current
selection. The benchmark data is outlined in red.

* Click these buttons to select each group in the list in successive order and view their data.
To make a group on another layer the benchmark, choose the desired layer and grouping from the list
boxes at the bottom of the benchmark drop-down.

See Also
Viewing summarized variables in "QuickLook"
Viewing benchmark data
Working with data
Benchmarking in "QuicklLook"

QuickLook... (Views menu)



"QuickLook" object benchmark

When the "Object Benchmark" = button is active, the benchmark drop-down list displays a list of objects
on the active layer. Select the desired object from the list to view its data and compare it to the current
selection. The benchmark data is outlined in red.

* Click these buttons to select each group in the list in successive order and view their data.

See Also

Viewing benchmark data
Working with data
Benchmarking in "QuicklLook"

QuickLook... (Views menu)



QuickLook reports dialog

Clicking the "Print" button # prints a report of the selected object or group using the active datalist. When
you click the button, Scan/US runs Excel macros that open a dialog with the following options.

You must have Excel to run the macros. If you don't have Excel, use the "Copy Data..." command to send
the data to the clipboard, then paste the data into another application to generate a report.
Note The first time you print a report you will be asked to enter a company name and to restart by
clicking the "Print" button again.
Custom Report
Prints a report of all variables in the active Scan/US datalist--using a cutomized template. Only
available for data in the Scan/US product database unless you've created your own report
templates.

Standard report
Creates a report in which variables are printed in groups of five. Choose this option when:

. The active datalist is user data file.
. You have contracted the variables list to show only the ones you selected.
Title 1

The preset title is the object or grouping name

Title 2
No preset title.

Titles are shown in the upper left corner of the report, below the datalist name.

Preview
Click this option to view the report before printing. The preview is shown after you click "Print" in the
dialog.

Save
Click this option to save a copy of the report. The Excel "Save As" dialog is opened before printing
the report.

Reports...
Adds the custom report templates you create to the macro. They become available with the "Custom
report" option

Printers...
Lets you change the printer setup.

Close
Discards your selections, closes the dialog, and quits Excel.

See Also

Printing a report
Reports... task



QuickPrint... (Map menu)
Shortcut Ctrl-P

The "QuickPrint" command prints the current map using a built-in layout that centers the map on an 8% x
11 page in landscape mode and adds a preset header and footer. The map background is printed
according to the "Map background" option in the "Print" command.

Use this command to quickly print several maps using the same template, changing only the header and
footer. Your header and footer entries remain in effect for the session until you change them, choose
"QuickPrint" from another window, or choose the "Reset" button.

"QuickPrint" dialog options

Header
The preset header is the window name. Enter the desired header.

Footer

No preset footer. Enter the desired footer.
Reset

Redisplays the window name and clears the footer, if any.
OK

Prints the map.

Cancel
Discards your entries and closes the dialog.

Tip Your entries in the dialog are available the next time you choose the command during the session.
This allows you to print variations of a view map with the same header and footer.

See Also
Help
Print... (Map menu)
Printing a map or report

Changing the map display




Save (Objects menu)

Choose the "Save" command to update an existing ASCII feature file with changes to its object definitions
on an editable layer. If a layer has not been previously saved, choosing "Save" opens the "Save Objects

As" dialog.



Save As... (Objects menu)

Choose "Save As..." to save the object definitions on an editable layer to an ASCII text file. Each object
type is saved in its own file with a different extension--.LOC for location files, .PLN for line object
files, .PGN for polygon object files, and .BUF for buffer area files.

"Save Objects As" dialog options
You can do the following:

. Create an ASCII feature file using object definitions on an editable layer.
. Change the name of an existing ASCII file.

. Save an ASCII file on a different disk or directory.

Filename

Indicates the file extension for the object type. Type a new name.
File in

Indicates the path of the directory where the file will be stored.
QuickPaths

The preselected directory option, "QuickPaths" displays a list of user data directories to which you
have immediate access. The directories may be located anywhere. Because they have been
declared as QuickPaths in the "Preferences" dialog, Scan/US gives you immediate access to them.

Directories
Allows you to traverse drives in the standard Windows way.

See Also

Save (Objects menu)
QuickPaths vs Directories

Working with objects



Save Scenarios... (Views menu)

This capability is inactive and will become available in a future version of Scan/US.
This command is not active and will be available in a future release.



Save Study Area... (Map menu)
Shortcut Ctrl-S

Choose "Save Study Area..." to save a study area and its views. If you have zoomed into a study area,
the entire map (not the zoomed-in portion) is saved. You can reload saved study areas using the "Study
Area Manager..." command.

You can choose "Save Study Area..." from a study area or view window.

"Save Study Area" dialog options
Caption

Displays the name currently assigned to the study area. Type a new name for the study area. If
you do not enter a name, the current name assigned to the study area is saved. Entering a new
name also renames the study area window when you click "OK."

Study area definition only

Choosing this option saves only the definition--center point coordinate, and vertical and horizontal
extents--of the study area. Scan/US uses this information to reload the study area and to

automatically load features according to visibility settings in the "Features Directory

The next two options save the definition and study area contents in .SSA files stored in your C\SCANUS
home directory. See also Study area naming conventions

Study area definition and map features

Choosing this option saves the study area definition, automatically loaded features, and any features
you added or deleted.

All views of study area
This option is preselected and saves the most information as listed below:

Window size Zoom window
Background color Object display attributes
Lat/Long grid settings Object position

Legend hide/show state Object visibility settings
Legend contents Label display attributes
List of features Label position

Label visibility settings
Choosing this option also saves any groupings you have created or modified that were not previously

saved. For more information on saving groups, see the "Groupings..." command.
Autoload

Checking this option tells Scan/US to automatically load the study area at start-up. To activate the
window, choose its name from the bottom of the Window menu.

OK

Saves the study area definition and closes the dialog.
Cancel

Discards your changes and closes the dialog.

See Also
Study Area Manager... (Map menu

Working with study areas



Scenarios... (Views menu)

This capability is inactive and will become available in a future version of Scan/US.
This command is not active and will be available in a future release.



Show Clipboard (Window menu)

Shortcut F2

Use "Show Clipboard" to view the clipboard contents, output by one of the Scan/US copy commands, or
sent by another application for use in Scan/US.

Each of the Scan/US copy commands outputs a data parcel which you can view before applying it in
Scan/US or in another application. Any time the parcel icon # is displayed in a Scan/US window, the
clipboard contents can be read in Scan/US.

Often Scan/US data sent to the clipboard is meant to be viewed in a columnar format. Maximizing the
clipboard or pasting such data into Excel will make it easier to read the data. Pasting the data into Excel
or another application will also allow you to use the data in ways not available in the Clipboard Viewer.
Choosing "Show Clipboard" will immediately display the output of each Scan/US copy command, except
"Copy Objects...." Scan/US first displays a description of the object type and number of objects.
Choosing the "Text" option from the Clipboard Viewer's File menu displays the coordinates of each object
definition.

Note You can view up to 40K of information in the clipboard. If you have copied more than 40K, all of
the information will be available when you paste it into the target application.

See Also

Using the Clipboard Viewer
Data parcels



Using the Clipboard Viewer

When you choose the "Show Clipboard" command, the Clipboard Viewer is displayed with the following
menus; a brief description is given for each one. For more information, refer to the Microsoft Windows
User's Guide.
File
Contains commands to open a clipboard (.CLP) file, save the current contents to a file, and exit the
Clipboard Viewer.
Edit
Contains the "Delete" command to remove the contents from the clipboard.
Display

Lists the text and graphic formats (if any) in which you can view the clipboard contents. The listed
formats will vary according to the application from which the current clipboard contents were sent.
Scan/US provides a "Bitmap" command, the format in which maps are sent to the clipboard, and a
"Text" command, the format for textual data.

The "Auto," "Display Text," and "OEM Text" format commands are supplied by Windows. The "Auto"
format displays the contents in their original format when the contents were first placed in the
clipboard. The "Display Text" allows you to view privately-formatted data as text. The "OEM Text"
format allows you to view data created with the OEM character set. Of the three format commands
you will most likely only use "Auto" in Scan/US.

Help
Provides on-line information about Clipboard Viewer.



Study Area Manager... (Map menu)

Choose the command to do the following:

. Load study areas previously saved with the "Save Study Area..." command.
. Change the autoload status of a saved study area.
. Delete a saved study area.

"Study Area Manager" dialog options

The dialog lists all the saved study areas. The dialog is also opened when you choose "More study
areas..." from the bottom of the Map menu. "More study areas..." becomes available when more than
four study areas are open.

Preceding some of the names are icons which indicate the following:

. The study area has been loaded into a window.
. The red dot means study area is automatically loaded at start-up into a window.

B, The study area has been selected for autoloading in future sessions, but has not been loaded into
a window.
. The study area is automatically loaded at start-up and is the opening map.

=) The study area has been selected as the opening map for future sessions, but has not been
loaded into a window.
The absence of an icon means the study area has not been loaded.

After selecting a name, the following become active:
Load
Loads the study area into a new window. The study area becomes the active window.
Shortcut Double-clicking on the study area name selects it and loads it.
Autoload
Tells Scan/US to automatically load the study area at start-up in subsequent sessions.
First Map

Tells Scan/US to activate the study area at start-up in subsequent sessions. The study area is the
opening map for the session.

Delete

Marks the study area for deletion by drawing a red line through its name. Click on the name to
unmark it.

If you delete a study area that is already loaded, the study area window remains open until you close
it. Itis no longer available, unless you re-save it.

To delete the opening map, you must first choose another study area as the first map.

Study areas of zone maps--the entire United States and Hawaii--which are always available to define
new study areas cannot be deleted while loaded into a window.

Cancel

Closes the dialog. If any one of the preceding options has been selected, the button changes to
"Close."

Close
Saves your selections and closes the dialog.

See Also
Save Study Area... (Map menu

Working with study areas






Task Center... (Tasks menu)

Use this command to execute a task--an activity or procedure you do, such as running Excel or DOS, or
changing printer settings--that you would like to do without leaving the Scan/US window each time. The
dialog shows the available tasks. To execute a task, click on the desired one then click "OK."

Scan/US provides four tasks in the BasePak:

'Copy Session..." opens a dialog to copy the current session file.

"Reports" generates reports from the Scan/US product database using an Excel macro.

"Build Gravity Model" builds a Huff gravity model for locations you specify using an Excel macro.
"Run Excel" opens another window and starts Excel.

"Quick Tour Parts 1 and 2" show you movies demonstrating procedures in Scan/US.

"Run Geocoder" opens another window and starts Scan/US Geocoder. This task is only
available when you buy the Scan/US Geocoder.

. "QuickFind Street Address" opens the "QuickFind dialog" in Scan/US Geocoder. This task is
only available when you buy the Scan/US Geocoder.

Creating tasks

To create or modify your own tasks, see TASKS.TXT for instructions. The file is stored in the home
directory, C:\SCANUS, unless you defined a different location when you installed the product.

Executing tasks

The most recently used tasks are listed at the bottom of the Task menu. Selecting a task executes it. If
more than nine tasks are available, Scan/US displays "More Tasks..." which opens the "Task Center."



Reports... task

Execute this task by choosing "Reports..." from the bottom of the Tasks menu or from the "Task Center."
This task runs an Excel macro to generate Scan/US reports for a selected object set. Report formats are
provided for all data sets in the Scan/US product database. You can add your own report formats to the
macro.

When you choose the task, the "Scan/US Reports" dialog is opened, giving you the following choices:
Study area

The current study are is preselected for you. To choose another study area, click the down-arrow
button to display a list of study areas and select the desired one

Layer

The active layer in the selected study area is preselected for you. To choose another layer, click the
down-arrow button to display a list of layers in the study area and select the desired one.

Available Report(s)

Lists the available reports. The first report is preselected for you. Shift-Click to select multiple
reports in sequence; Ctrl-Click to select multiple reports not in sequence.

List Type

Custom Prints a report of all variables in the active Scan/US datalist--using a cutomized format.
Only available for data in the Scan/US product database unless you've created your own report
formats.

Standard Creates a report in which all variables are printed in groups of five. Choose this option to
print reports with user data files.

Object set

The available object set options vary according to the selected layer. "All visible objects" is the
preselected option for any layer.

Report options

The "Summary"” option generates a single report which aggregates the data for the selected object
set. The "Individual" option generates a report for each object in the object set.

Default titles

This option is preselected to print default titles that name the study area and object set. Unmark this
option to enter your own titles. After clicking "OK," you are prompted to enter them.

Print preview

This option is preselected to open the Excel "Print Preview" dialog and display the report before
printing.

Save

Allows you to save multiple reports, each identified by a four-character code you specify and a
sequence number that is automatically assigned. After clicking "OK," you will be prompted to enter
the code.

Exit on completion
Close the dialog and quits Excel.
Report setup
Allows you to add to or remove the available report formats for the selected layer.
Printer setup
Allows you to change your printer settings.
OK



Accepts your selections and displays the necessary prompts before printing the report(s).
Cancel
Discards your selections, closes the dialog, and quits Excel.

See Also
"Task Center."

Printing a map or report



Build Gravity Model task

Execute this task by choosing "Build gravity Model" from the bottom of the Tasks menu or from the "Task
Center." This task runs an Excel macro that builds a Huff gravity model for up to 80 locations you specify.
The Huff gravity model calculates the likelihood of customer patronage based on a store's distance from
and attractiveness to customers. Attractiveness is based on the store size. Distance is calculated from
the store locations to the areas from which consumers come to a store, for example, the MicroGrids within
a two-mile trade area.

Before choosing the task, you must use the "Copy Distance..." to calculate the required distances. When
you choose the task, Excel is initialized and the "Scan/US Gravity Model Builder" dialog is opened. To
build the model, first click "Paste Distances and Build Model" to paste the data into an Excel spreadsheet
and to build the model. Next, click "Exit" to save the file. You can load this file and analyze the data in a
thematic view. The results show you the likely areas of strong to weak customer patronage for each
store.

You can do the following in the "Scan/US Gravity Model Builder:"
Launch Scan/US
Allows you to start-up Scan/US when you have run the macro from Excel.

Paste Distances and Build Model

Click this button to paste the copied distances into the Excel spreadsheet and to build the gravity
model for the distance data. The "Enter Gravity Variables" dialog is opened. You must enter the
store size for each location as a measure of its attractiveness.

Factor Enter a weight factor which indicates how much ease of access to a store figures in a
consumer's decision to patronize a store. 1.5 is a commonly used factor and is the preset value.

If you are analyzing less than 20 locations, they are all shown in a single dialog; more than 20
locations, a dialog is opened for each location. "Next" and "Previous" buttons are provided so you
easily move between dialogs.

OK Builds the model. You are prompted to save the file and the Excel "Save As" dialog is opened
for you. Save the data in C:\SCANUS\USERDATA unless you defined a different user data directory
when you installed the product.

Exit
Quits the macro and Excel.

See Also
Help
"Task Center."

User's Guide
"Analyzing retail competition using gravity modeling"



Tile... & Tile All (Window menu)

Shortcut Ctrl-T (for Tile...)

The "Tile..." and "Tile All" commands arrange the open windows to fit the screen. "Tile All" arranges all
the windows; "Tile..." opens a dialog in which you select the windows you want tiled.

When the windows are tiled on the screen, you can work in each one as you would normally. To activate
a window simply click on it. You can also move the windows and rearrange them, or resize them. If you
maximize a window, it becomes the active one. The other windows remain open and available; you can
activate them by selecting their names from the bottom of the Windows menu.

Tiling windows is a helpful way to see the maps and adjust their colors to meet your presentation needs.
Or, you can tile windows of a study area and its thematic views and compare the different analyses.

"Tile Windows" dialog options

When you select the "Tile..." command, the "Tile Windows" dialog is displayed and lists all the windows.
You must select two or more windows from the list. To select a window, click on its name. To undo a
selection, click again on the name.

You have the following options for filtering the list:
All windows

The preset option which lists all the windows.
Study areas only

Lists only windows containing study area maps, including the opening map.
Views of study area

Lists only the current study area window and all its view windows.
OK

Is active only when you've selected at least two windows. Click the button to tile the windows.
Cancel

Closes the dialog and does not tile any windows.

Tip When windows are tiled and Select mode is active, you can add features to a map window by
dragging-and-dropping from the active layer in one window to another window. The feature is added to a
map in the order that most closely matches the order of features in the "Features Directory." Be sure to
check the feature order and rendering of any map to which you add features--check that the objects of
one feature are not obscuring another.

See Also

The display window
About windows

Working with map features



View Variables... (Views menu)
Shortcut Ctrl-v

Choose this command to analyze the data in the active study area in a thematic view. To create the view
in its own window, use the "New Thematic..." command. It provides all the same options.

Show layer variables

Tells Scan/US to display the analysis on a layer. The option is preset to be checked for all layers in
the view. Clear the check box for all layers whose data are not required for the analysis. The
variables remain selected but are not analyzed in the map.

Layer name

Displays the currently selected layer. Clicking on the arrow button displays a list of layers to choose
from. lcons next to the layer name indicate the following:

Data is attached.

. Groups are present on the layer.

LT The layer has been selected for a thematic view.

vl Only groups on the layer are being analyzed in the thematic view.
Variable name drop-down list

Displays the variable currently selected for a layer. The first variable in the active datalist is
preselected.

To select other variables, click on the scroll arrow to display a list to choose from. Click to select a
variable; Shift-Click to select more than one variable in sequence; Ctrl-Click to select multiple
variables not in sequence. When multiple variables are selected the text box displays the number of
variables.

Shortcut Double-clicking on a variable name selects it, closes the dialog, and renders the variable
with the preset thematic presentation.

You can toggle the following buttons:

Expands an array variable so you can select its cell variables.

Closes the array.

Data for the count variable is analyzed as a count value.

Data for the count variable is analyzed as a percentage of a base variable.
All objects

The preselected option which tells Scan/US to analyze all objects on the layer.

Note The visibility of objects as defined in the "Object Manager" remain the same in thematic
views. If an object is not visible, it will be analyzed but remain invisible until its visibility is toggled on.

Grouped objects in grouping

This option is active when groups are present on the layer. Check this option to analyze only the
data for grouped objects. When the map is displayed, only the grouped objects are thematically
rendered; unassigned objects retain their original rendering.

When this option is active, you can select the desired grouping. The arrow button is inactive if only
one grouping is present on the layer.
Note This option is not applied to objects with a pie chart or bar chart presentation. You can

selectively display these chart presentations in Select--Graphic submode, the "Object Manager"

dialog or with the chart visibility options in the "Scan/US Gallery" dialog.

+ "Data Center" button
Opens the "Data Center" dialog. You can choose another datalist for the selected layer and analyze
a different set of variables in the thematic map.

* "Strata Manager" button
Opens the "Strata Manager" dialog, the key analytical tool in Scan/US for examining your data.



Note The button is dimmed when data is not attached to the currently selected layer.

You can do the following:

Change the preset strata ranges.

Use the strata ranges to group objects.
Show or hide null objects, objects excluded from the analysis.
Change a variable's thematic presentation.

Display statistics on the variables.

"Gallery" button

On the face of this button is a sample of the thematic presentation Scan/US preselects for your data
selections. (The sample you see in the dialog may be different from the one shown here.) Clicking
the button opens the "Scan/US Gallery" dialog from which you can choose another presentation.

See Also

Help

New Thematic... (Views menu)
"Data Center..." (Data menu)
"Scan/US Gallery" dialog

"Strata Manager" dialog
Working with thematic views

User's Guide
"Creating thematic views"

Reference Manual
"View Variables..."




"Scan/US Gallery" dialog

L

Clicking the "Gallery" button" in the "View Variables" or "New Thematic" dialogs opens the "Scan/US
Gallery." The button shows a sample of the preset thematic presentation Scan/US chooses for your data
selections. (The sample you see in your dialog may be different from the one shown here.)

The "Scan/US Gallery" displays a selection of thematic presentations to choose from. A sample of each
presentation is framed in the dialog. Scan/US provides the presentation choices according to the type of
features (area/polygon, point, line, or buffer area) and the type and number of variables selected for
analysis.

Presentation samples

Choose another presentation by clicking it. Use the scroll arrows to see the other choices.
Scan/US displays a brief description of each presentation when it is selected.

Chart visibility
When the selected presentation includes thematic charts you can choose to display them for "All"
objects, "None" or no objects, or for the "Current" set of objects whose chart visibility settings are
turned on in the "Object Manager."
If you choose "None," all charts are hidden. You can show them for individual objects in Select-
Graphic submode.

Variables list

Preceding each variable is an indicator of its rendition using the currently selected presentation.
Change a variable's rendition by changing its order in the list--drag-and-drop the variable to a new
position.

Not rendered using the current presentation.
The following indicate the variable's stratification will be rendered in the view:

Density fill
Stratum fill
Transparency fill
Stratum symbol

Stratum fill for grid objects
The following indicate the variable's data value for an object will be rendered in the view:

Bar chart (not yet active for MicroGrids)
Box graph

Pie chart (not yet active for MicroGrids)
Dot density fill

Grid dot density

Proportion marker

Data value
Tip You can also change a variable's rendition in the "Strata Manager" dialog. As you modify a
variable's stratification, you may need to change its rendition so that each stratum is displayed correctly.
You can also change the symbol sizes used for dot density and proportion markers.

[
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See Also
Help
New Thematic... (Views menu)
View Variables... (Views menu)

'Strata Manager" dialog
Working with thematic views
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"Strata Manager" dialog

* (Clicking this button in the "View Variables" or "New Thematic" dialogs opens the "Strata Manager"
dialog, the key analytical tool in Scan/US for examining your data.
Variable name box
Shows the name of the currently selected variable. The icon preceding its name indicates its
rendition in the view. To change the rendition, you must close the dialog and return to the "Scan/US
Gallery."
Strata panel
L
Displays the selected variable's stratification. The preset ranges divide the variable's values into
quintiles. The strata panel is also divided by limit bars reflecting each stratum's limits. A selected limit
bar is highlighted with white-filled squares instead of black.

For each stratum, Scan/US displays an optional presentation icon, the number of objects in each stratum,
and the stratum limit values.

in Toggles displaying the number of objects as a count value or a percentage of the total number of
objects. The count value is preselected.

* Displays the number of strata. Clicking the plus (+) or minus (-) button increases or decreases the
number. You can define up to twelve strata. Changing the number of strata automatically changes each
stratum's limits.

]

=l Increases or decreases a selected stratum's limit values.

Select a stratum limit by clicking inside the strata panel, selecting its limit bar in the panel, or by selecting
the value. Then, click the buttons to change the values. See "Modifying a variable's stratification" for
more information.

Presentation icons

If the variable's stratification is being rendered, a presentation icon is shown next to each stratum:

|:| Sample of a stratum fill rendition. All objects in this stratum are rendered yellow.
(m | Sample of a stratum symbol rendition. All objects in this stratum will show this symbol.
. Indicates a hidden stratum. Objects will not be rendered in the view. Click to toggle between

the shade and the presentation icon.
Presentation buttons

As you modify a variable's stratification, you may need to change its rendition so that each stratum is
displayed correctly. You can also change the symbol sizes used for dot density and proportion markers.

+ "Palette” button
Displayed for renditions using fill colors, patterns, transparencies, or symbols. Opens the "Palette
Selector" dialog from which you create or edit palettes used to render a stratification or thematic charts.
* "PropMarker" button
Opens the "Proportional Marker" dialog in which you define two sizes and a color to represent the lowest
and highest values. Based on them, Scan/US determines the symbol sizes that best render the
remaining values.
* "Dot Density" button
Opens the "Dot Density" dialog in which you choose a dot size and color. Data values are represented
by filling a polygon or buffer area surrounding a point with random dots of the same size.
* "QuickStats" button
Displays summary statistics about the data variable being analyzed. You can copy them to the
clipboard with the "Copy Variable..." command.

Null

Clicking the looped-arrow = button toggles between hiding and showing null objects in the thematic
view. When shown, null objects are displayed in their original rendering.




Save As Groups

Uses the stratification of the current variable as a grouping tool. Clicking the button automatically
displays the "New Grouping" dialog showing the variable name as the suggested name for the
grouping.

When you click "OK" to save the grouping, a group is created for objects in each non-hidden stratum.
Objects in hidden strata are automatically placed in the 'Unassigned' group. To display the groups,
choose the grouping name from the list at the bottom of the Groups menu.

Qtiles

Divides the data according to the indicated number of strata, and each stratum contains an equal
number of objects.

Scale
Displays the stratification to meet the following criteria:

. Equal intervals between the strata limits

. Strata limits are 'nice' numbers such as simple decimal numbers or numbers which are divisible
by 2, 5, or 10 without a remainder.

See "Using a scale stratification" for more information.

Reset

Redisplays the preset stratification of five quintiles using the maximum and minimum values for the
set of objects selected for the analysis.

Library...

Opens the "Stratum Limits Library" dialog from which you can save and reload different sets of strata
and their limits.

See Also
Help
New Thematic... (Views menu)
View Variables... (Views menu

Modifying a variable's stratification
Using a scale stratification
"Stratum Limits Library" dialog
Working with thematic views

User's Guide
"Creating thematic views"

Reference Manual
"View Variables..."



"Proportional Marker" dialog

* Clicking this button in the "Strata Manager" opens the dialog.
You define two symbol sizes and a color to represent the lowest and highest values. Based on them,

Scan/US determines the symbol sizes that best render the remaining values.



"Dot Density" dialog

* Clicking this button in the "Strata Manager" opens the dialog.
In a dot density presentation, data values are represented by filling a polygon with random dots of the
same size. You can choose a dot size and color, and the number of units a single dot represents.
Number of units

Enter the number of data units you want a single dot to represent.

Scan/US initially calculates the number of units based on the object with the highest density for the
selected variable. Decreasing the number means more dots to represent a data value.

Dot style

Click on the desired size. To change the dot color, click the down arrow button to display a palette,
then click on the desired color.

Set default

Saves the dot style. It will be selected for all subsequent dot density presentations until you choose
a different style or set a different default.

Render objects transparent

Hides the objects display attributes--borders, fill colors, patterns, or transparencies. Equivalent to
hiding the feature.

See Also
Help
"Scan/US Gallery" dialog
View Variables... (Views menu)
Working with thematic views




"Stratum Limits Library" dialog

Open this dialog by clicking the "Library..." button in the "Strata Manager" dialog. This dialog lets you
save and reload a stratification set.

Name text box

Shows the name for the current set of strata. The box displays 'unnamed' when the strata set has no
name.

The names of other strata sets to choose from are displayed below the text box. To select another
set, click on its name.

To name or rename a strata set, type its name in the edit box.--Do not type names with square
brackets [], these are reserved for internal Scan/US use.

Load

Clicking this button loads the selected strata set from the library.
Save

Click this button saves the current strata set with the name you assigned and adds it to the library.
Delete

Removes the set from the library.

Note The values of the strata limits are dimmed because they cannot be edited in the dialog. You must
load a set, modify its limits in the "Strata Manager" dialog, then re-save it.

See Also
Help
"Strata Manager" dialo

Modifying a variable's stratification
New Thematic... (Views menu)

View Variables... (Views menu)
Working with thematic views
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Modifying a variable's stratification

The preset stratification for a selected variable is five strata, each stratum containing the same number of
objects (a quintile division). The maximum and minimum values are the variable's highest and lowest for
all objects across the layer. If you are analyzing grouped objects, the values are the highest and lowest
for the grouped objects. You can modify the stratification by:

. Changing the number of strata.
. Changing the limit values.
. Hiding strata

Changing the number of strata

Click the plus (+) or minus (-) buttons to increase or decrease the number of strata. You can have up
to twelve strata.

Changing a stratum limit
You must first select a limit then change its value. Select a limit by doing one of the following:

. Clicking on its limit bar.

. Clicking in its section in the strata panel.

. Select the limit value.

Next, change the value by doing one of the following:
. Click these

# buttons to increase or decrease a limit.

. Drag the limit bar upward or downward.

. Type a new value and press Enter.

Note that if you select the limit bar for the lowest value, the down arrow button is dimmed, or for the
highest value, the up arrow button is dimmed.

Changing the lowest and highest values for the stratification excludes objects from the analysis. These
are null objects.

Hiding strata

Only strata that are being rendered can be hidden. A presentation icon is show next to each stratum.
Click on the icon to display a shade. Objects whose values fall into a hidden stratum are not
thematically rendered. To show a hidden stratum, click on the window shade.

See Also
Help
New Thematic... (Views menu
View Variables... (Views menu

'Strata Manager" dialog

'Stratum Limits Library" dialog
Working with thematic views

User's Guide
"Creating thematic views"

Reference Manual
"View Variables..."



Using a scale stratification

Clicking the "Scale" button in the "Strata Manager" dialog displays the stratification to meet the following
criteria:

. Equal intervals between the strata limits

. Strata limits are 'nice' numbers such as simple decimal numbers or numbers which are divisible
by 2, 5, or 10 without a remainder.

To meet these criteria, Scan/US may change the minimum and maximum values of the stratification, and
the number of strata. For example, if four strata are defined and the minimum and maximum values are
15 and 75, clicking the "Scale" button changes the limits to seven strata with 10, 30, 50, 70, and 90 as the
strata limits. The strata do not contain equal numbers of objects.

Because Scan/US looks for the best fit to the current number of strata, some strata may have zero
objects in them or be rendered the same way. If necessary, change the thematic presentation of the
strata by modifying the palette or choosing another.

See Also

Help
Modifying a variable's stratification

'Strata Manager" dialog
Working with thematic views

User's Guide
"Creating thematic views"

Reference Manual
"View Variables..."



Zoom In (Map menu)

Shortcut Ctrl-Z
Use "Zoom In" to magnify a selected object or defined area so that it fills the screen.

In Erame--Zoom submode, you must draw a framing rectangle to define the area, then choose the
command from the menu, or double-click inside the rectangle.

In Select--Object submode, select an object then choose the command.

Scan/US displays the zoom window with scroll bars. Scrolling is like moving a magnifying glass over the
entire study area.

If you selected an object, the zoom window includes a preset buffer of three miles surrounding the
selection rectangle that highlights the object. You may change the buffer size to include more or less
area as desired. For more information, see the "Feature Radius" dialog.

Note Because of the buffer size, zooming in on an object in small study areas (such as 6 miles x 4
miles) may not give you a magnified view.

See Also

Zoom Out (Map menu)

Frame--Zoom In submode




Zoom Out (Map menu)
Shortcut Ctrl-X

After you "Zoom In," use this command to reduce the magnification and see more of the map surrounding
the selected area. Reducing the magnification ten percent is the least amount. The more you reduce
the magnification, the more you see of the map surrounding the area. Reducing the magnification 100%
closes the zoom window and displays the study area window.




Annotation mode

L

This capability is inactive and will become available in a future version of Scan/US.

Use the Annotation mode to add text annotation to your map.

When you activate the Annotation mode, a toolbox is provided to allow you to specify the type, point size,
color and text alignment to be used on the next text annotation you enter.

To enter an annotation, click on the map and type. Press Enter to start a new line. Press Alt-Enter to
define the text as an annotation object.

When an annotation is selected, its bounding rectangle is marked by a sizing handle at each corner. The
remaining handles are pointer handles which allow you to draw a pointer from the annotation to a point on
the map (to which the annotation pertains).

You can change how text wraps by dragging the sizing handles to resize the bounding rectangle.
Dragging the cursor from a pointer handle to a point on the map will draw a pointer.

The toolbox lets you modify the appearance of text and pointers. You can expand the toolbox to make
available other formatting options such as drawing a styled box around the text annotation.

Annotations are placed on a layer above the topmost layer in the map. When Annotation mode is not
active, you can drag any annotation to reposition it. The annotations layer can be temporarily hidden by
toggling the Annotations command in the Options menu. The Show Annotations command is toggled on
when you activate Annotation mode.



Annotation toolbox

This capability is inactive and will become available in a future version of Scan/US.

Clicking the right mouse button in Annotation mode toggles a toolbox which lets you modify annotations
on the map.



Edit mode

L

Use the Edit mode to create new objects or to modify the definition of an existing object on an editable
layer.

When you activate Edit mode, the submode corresponding to the feature type is activated if the current
layer is editable--Locations submode for creating or modifying point objects; Lines submode for creating
or modifying line objects; Polygons submode for creating or modifying polygon objects, and Areas
submode for creating or modifying ring buffer areas. Each of the submodes are also activated by
choosing the corresponding option of the "New Layer..." command in the Objects menu.

If the current layer is not editable, you must create a new layer by activating the submode appropriate to
the type of objects you want to create.

Because the layer is like a transparency on which you draw objects, no visible change occurs in the map
when the layer is created. However, the layer name is active in the windows layer list box and is also
added to the Features Directory and Map Features dialogs with an edit icon # next to is name.

Editable features can be treated like any other features. You can change their display attributes, copy
and group them, hide or show them, analyze them in a thematic view when data are attached, and add
them to other study areas. Editable features are saved in ASCII text files. Saving the Features
Directory will make the features automatically available in future sessions.

See Also
Working with objects



Edit--Locations submode

This capability is inactive and will become available in a future version of Scan/US. However, .LOC files
can be created and loaded. See "About Features"

When you activate this submode, you can create or edit location objects on their own layer. To create a
point object or location, click on the desired position on the map. A symbol and key are displayed for the
object, and the object is selected. Move a point by dragging it to another location. Selecting a point
object with the right mouse button activates a popup menu of commands. You can choose to rename the
object, delete it, or save all locations on the layer in an ASCII text file.

See Also
Edit mode

Working with objects
About features



Edit--Lines submode

This capability inactive and will become available in a future version of Scan/US. However, .PLN files
can be created and loaded. See "About Features"

When you activate this submode, you can create or edit line objects on their own layer. To create a line
object, press the mouse button at its starting position on the map, then drag from point to point,
temporarily releasing the mouse button at each point, until the ending point of the line. The line is drawn,
and the object selected, each point marked by a handle.

To modify a line object, select it to display its handles. Move a point by dragging its handle to another
position. Extend the line by Shift-Clicking on an end point handle, then drag to additional points.
Selecting a line object with the right mouse button activates a popup menu which stays open until you
close it. You can choose to rename the object, delete the object, add an intermediate point, or delete a
point.

See Also
Edit mode

Working with objects
About features



Edit--Polygons submode

This capability is inactive and will become available in a future version of Scan/US. However, .PGN files
can be created and loaded. See "About Features"

When you activate this submode, you can create or edit polygon objects on their own layer. To create a
polygon object, press the mouse button on the first point of the polygon, then drag the cursor from point to
point, temporarily releasing the mouse button at each point, until the last point of the polygon. The
polygon is drawn and the object selected, each point marked by a handle. Scan/US automatically
connects the first and last points to complete the polygon.

To modify a polygon object, select it to display its handles. Move a point by dragging its handle to
another position.

Selecting a polygon object with the right mouse button activates a popup menu which stays open until you
close it. You can choose to rename the object, delete the object, add an intermediate point, or delete a
point.

See Also
Edit mode

Working with objects
About features



Edit--Areas submode

This capability is inactive and will become available in a future version of Scan/US. However, .BUF files
can be created and loaded. See "About Features"

When you activate this submode, you can create and ring area objects on their own layer. To create a
ring area, click on its desired center position on the map. To add a ring area band, drag from the center
outward to the desired radius.

To modify a ring area or band, select it to display handles at its four points of compass. Dragging a handle
inward decreases the radius; outward increases the radius.

Aring area can be divided into sectors. A sector handle is always displayed above the outermost rings
north handle at zero degrees (0°). To create the first sector, Shift-Click on the sector handle and drag
clockwise to the desired sector position.

When the ring area is selected, sector handles are placed just beyond where the sector lines intersect the
outermost ring. Create additional sectors by Shift-dragging from any sector handle. Reposition a sector
line by dragging a sector handle.

Selecting a ring area object with the right mouse button to activates a popup menu of commands. You
can choose to rename the object, delete the object, mark the center with a symbol, and delete a ring or
sector.

See Also
Edit mode

Working with objects



Frame mode

Frame mode helps you to create a new study area or zoom in on a portion of the active study area. Its

two submodes are New Study Area and Zoom which also have equivalent commands in the Map menu,
"New Study Area...," "Zoom In," and "Zoom Out."




Frame toolbox

Width: |5 [2]

Clicking the right mouse button in Frame mode # toggles the display of this toolbox. You can change
the color and width of the framing rectangle. Click a down arrow button to display a selection of colors or
widths (in pixels) to choose from.

See Also
Framing an area



Frame--New Study Area submode

L

L

When New Study Area submode is active, you create a study area by framing an area.

Position the cursor at the center of interest and drag outward. As you drag, a framing rectangle is
displayed showing you the boundaries of the desired area. Release the cursor when the desired area is
enclosed. Double-click inside the rectangle to display the "New Study Area" dialog, and click "OK" in the
dialog to create the study area.

A new study area is always defined within a zone map--United States, Hawaii--or an existing study area.
Zone maps are the largest regions whose boundaries cannot be contained within another study area.

See Also
New Study Area vs. Zoom modes

Framing an area

Using the framing rectangle




Frame--Zoom submode

When Zoom submode is active, you can magnify a framed portion of a study area.

Position the cursor at the center of interest and drag outward. As you drag, a framing rectangle is
displayed showing you the boundaries of the enclosed portion. Release the cursor when the desired
portion is enclosed. Double-click inside the rectangle to zoom-in.

The enclosed portion is magnified and scroll bars are displayed in the window. Move the scroll bars to
view other parts of the study area.

To zoom out, choose the "Zoom Out" command from the Map menu and the amount you want to reduce
the magnification. The more you reduce the magnification, the more you see of the map surrounding the
enclosed area. Reducing the magnification 100% closes the zoom window and redisplays the study area
window.

Tip When you are zoomed in, only the portion shown in the window is allotted to a new study area when
you choose "New Study Area...," or saved when you choose "Save Study Area..."

See Also
New Study Area vs. Zoom modes
Working with study areas
Zooming into the study area



New Study Area vs. Zoom modes

In New Study Area submode, you are creating another study area window which can be named and
saved, and its data analyzed in a view. If you close a study area window, all associated views are also

closed.

In Zoom submode, you are getting a close-up of a map portion in the same study area--another study
area has not been created. While zoomed-in you can still perform the same tasks such as naming and
saving a study area, creating views, and closing the study area, but these tasks are done for the entire
study area not just the zoomed-in portion.

A quick way to tell the difference is to look for scroll bars in the window. These are only displayed when
you are zoomed in on a map.

See Also
Working with study areas



Group mode

L

Group mode supports a fundamental capability in Scan/US--the classification of objects on a layer into
distinct subsets. Objects assigned to a subset/group are rendered the same way, and in general,
selected to be operated on as a unit. For example, you can copy and paste, hide and show, or
aggregate the data for the objects in a single group.

A classification of objects into groups is called a grouping. Because objects can be classified in any
number of ways, you can define any number of groupings on a layer. For example, you might have a
grouping that reflected your sales territories, another grouping that showed target areas for future
expansion, or a third grouping that showed your market penetration in a certain area.

You can activate any of its submodes, By Selection, By Ring, and By Polygon to assign objects to
groups using point-and-click-operations on the map.

When you create groups using commands from the Groups menu, Group mode is automatically activated,
allowing you to take advantage of the point-and-click operations to modify group assignments.

See Also
Working with groups



Group--By Selection submode

[ ]

[ ]

When this submode is active, you assign an object to a group by clicking on the object, then clicking the
‘'okay' * button. Or, as a shortcut, double-click on an object.

When you create a group, the "New Grouping..." dialog is opened if a grouping is not present on the layer.
The New Group dialog is opened if no groups are present in the grouping. If a grouping is active, the
objects you select are automatically assigned to the current group.

To start a new group assignment, choose the "New Group..." command before selecting the objects. To
start a new grouping, choose the "New Grouping..." command.

See Also
Working with groups



Group--By Ring submode

When this submode is active, you group objects by positioning the cursor and dragging outward to display
aring. Drag inward to make the ring smaller. When you release the cursor, all object centroids that fall
within the ring are assigned to the same group.

When you create a group, the "New Grouping..." dialog is opened if a grouping is not present on the layer.
The New Group dialog is opened if no groups are present in the grouping. If a grouping is active, the
objects you select are automatically assigned to the current group.

To start a new group assignment, choose the "New Group..." command before selecting the objects. To
start a new grouping, choose the "New Grouping..." command.

The ring you draw to group objects is automatically sent to the clipboard when the group is created. You
can use the ring definition to group objects on another layer by immediately activating the layer and
choosing the "Group By Object" command after creating the group. Activating an editable layer and
choosing "Paste Objects" places the ring or polygon as an object on the layer.

See Also
Working with groups



Group--By Polygon submode

In this submode, you create groups by dragging the cursor to draw a polygon. When you release the
cursor, all object centroids that fall within the polygon are assigned to the same group.

When you create a group, the "New Grouping..." dialog is opened if a grouping is not present on the layer.
The New Group dialog is opened if no groups are present in the grouping. If a grouping is active, the
objects you select are automatically assigned to the current group.

To start a new group assignment, choose the "New Group..." command before selecting the objects. To
start a new grouping, choose the "New Grouping..." command.

The polygon you draw to group objects is automatically sent to the clipboard when the group is created.
You can use polygon definition to group objects on another layer by immediately activating the layer and
choosing the "Group By Object" command after creating the group. Activating an editable layer and
choosing "Paste Objects" places the ring or polygon as an object on the layer.

See Also
Working with groups



Select mode

[ ]
Use the Select mode to:

. Highlight an object in the map.
. Hide and show objects, labels or thematic charts
. Move a label or thematic graphic to a new position.

You must activate Select mode and the desired submode--Object, Label, and Graphic--to complete an
operation. Object submode is automatically activated when you click the Select button.




Select--Object submode

[ ]

[ ]

When you activate this submode, you can select an object by clicking on it. The object is framed by a
gray rectangle and its name shown in the status bar. The layer corresponding to the object is activated.
If data are available on the layer, double-clicking on an object opens the "QuickLook" window and
displays data for the object. If the "QuickLook" window is already open, selecting an object automatically
displays its data.

Selecting an object with the right mouse button displays a popup with the following options:

Hide Object
Show Label
Hide Chart
QuickLook
Copy Object

Hide Object Hides the selected object on the map. If an object is already hidden, you can display it
using the "Object Manager." Oir, if a hidden object's label is displayed, you can switch to Select--Label
submode to show the object.

If thematic graphics are displayed, hiding an object also hides the graphic. Thematic graphics can only
be shown on visible objects.

Hide Label and Show Label Hides the label of the selected object. If the label is already hidden,
selecting "Show Label" displays it.

Hide Chart and Show Chart If thematic charts are displayed, "Hide Chart" hides the thematic chart on
the map. If the thematic chart is already hidden, "Show Chart" displays it.

QuickLook Opens the "QuickLook" window and displays data for the selected object.
Copy Object Copies the selected object's spatial definition to the clipboard.
When an object is selected in the map, you can also do the following:

. Copy the objects spatial definition to the clipboard with the "Objects--Copy Objects" command.

. Group objects on another layer using the selected objects spatial definition in the clipboard with
the "Groups--Group by Object" command.

. Paste the object into an editable layer using its spatial definition in the clipboard with the
"Objects--Paste Objects" command.

. Export data associated with the object to another application with the "Data--Copy Data"
command.

. Export the distance from the selected object to objects on the same layer or other layers on the
map to another application with the "Objects--Copy Distance" command.

. Create a study area enclosing the object plus a buffer surrounding the object with the "Map--New
Study Area" command.

. Add features to a map--when map windows are tiled, you can add the feature the selected object

represents to another window by dragging from the selected object to the window. Use the "Tile" and
"Tile All" commands to tile windows.

. Zoome-in on the selected object to get a close-up view.
See Also
Help

Select--Label submode

Select--Graphic submode
Zooming into the study area
Working with groups
Working with objects
Working with data






Select--Label submode

[ ]
[ ]
When you activate this submode, you can show, hide or move labels on the active layer. If an object's
label is hidden in the "Object Manager," clicking on an object shows it and turns ON the visibility setting in
the "Object Manager."
You can move a label by dragging it to a new position. If the "Draw Ties" option is active in the "Label
Style Selector" dialog, a thread is drawn between the object center and label.
Note When the label of a polygon or line object is hidden, clicking on the object displays the label at the
point clicked. This becomes the new reference point for the label, from which a thread is drawn when the
label is moved.
Note Street labels have two forms, horizontal and rotated. Horizontal labels are the same as labels
shown for points or polygons, and are handled the same way. Rotated labels cannot be dragged away
from the street object, instead you click to move them to a different position along the street. Choosing
"Show Ties" (described below) switches a rotated label to a horizontal one so you can drag it to a new
position and display a tie.
Selecting a label with the right mouse button displays a popup with the following options:
B
Hide Object
Hide Label
Hide Chart
Hide Tie
Reset Position
Label Style...

Hide Object and Show Object "Hide Object" hides the object on the map. If the object is already
hidden, "Show Obiject" displays it.

Hide Label Hides the selected label. Clicking on its object shows it. If both the object and label are
hidden, you can turn on their display in the "Object Manager."

Hide Chart and Show Chart If thematic charts are displayed, "Hide Chart" hides the thematic chart on
the map. If the thematic chart is already hidden, "Show Chart" displays it.

Hide Ties and Show Ties "Hide Ties" hides the threads drawn between the labels you moved and their
objects. If the ties are already hidden, "Show Ties" displays them.

Choosing "Show Ties" for a rotated label switches it to a horizontal label which you can drag to a new
position, away from the street object.

Reset Position Returns a moved label to its original position at the object center.

Label Style... Opens the "Label Style Selector" dialog which lets you change the label display for the
active layer.

See Also

Select--Object submode
Select--Graphic submode
Object Manager... (Objects menu

"Label Style Selector" dialog



Select--Graphic submode

[ ]

[ ]

When you activate this submode, you can reposition thematic graphics on the active layer. Unlike other
thematic presentations, thematic graphics are rendered independently of their objects.

You move a graphic by dragging it to a new position. The label, if visible, is shown below the graphic and
moves with it.  If the "Draw Ties" option is active in the "Label Style Selector" dialog, a thread is drawn
between the object center and graphic.

Thematic charts, a subset of thematic graphics, can also be hidden or shown in this mode. They are
initially displayed according to chart visibility settings in the "Scan/US Gallery." If an object's thematic
chart is hidden in the "Object Manager," or hidden when the thematic analysis is displayed, clicking on an
object shows it.

Selecting a graphic with the right mouse button displays a popup with the following options:

Hide Object
Hide Label
Hide Chart
Hide Tie
Reset Position

Hide Object and Show Object "Hide Object" hides the object and its thematic graphic on the map.

Choosing "Show Object" immediately after hiding displays the object. If a hidden object's label is still
displayed, you can switch to Select--Label submode to show the object and its graphic. Or, you can

show the object and graphic using the "Object Manager."

Hide Label Hides the label of the selected graphic. If the label is already hidden, selecting "Show
Label" displays it. If both the object and label are hidden, you can turn on their display in the "Object
Manager."

Hide Chart and Show Chart Hides the selected chart. Clicking on its object shows it.

Hide Tie and Show Tie "Hide Tie" hides the thread drawn between the graphic you moved and its
object. If the tie is already hidden, "Show Tie" displays it.

Reset Position Returns a moved graphic to its original position at the object center.

See Also

Select--Object submode
Select--Label submode

"Scan/US Gallery" dialog
Object Manager... (Objects menu



Tour mode

L

When Tour mode is active, Scan/US calculates the distance between points you specify on the map. You
specify the points by simply clicking and dragging from one point to the next. As you drag from point to
point, a line is drawn between each point, and a symbol marks each point. The lines drawn to connect
the starting point and ending point are called the four. The line between one point and the next is called
aleg.

As you create the tour, the distance of the current leg is shown in the status bar, as well as the
accumulated distance between the starting point and each subsequent point.

The tour lines and point symbols have preselected display attributes. You may choose a different line
style and symbol shape using the "Preferences..." command.

When a tour is defined, you can choose the "Copy Tour" command and send to the clipboard the location
coordinates and the distance between them. You can also paste this information into an editable layer
for line objects and modify the tour, or paste it into other applications.



Data parcels
For detailed information on parcels, please read About Parcels.

[areas]
[ciobjref]
[crossreference
[data]
[datalists]
[distance]
frames
[grids]
[groupdata]
[groupings
[grouplist]
[groups]
[groupset]
[layers]
[lines
[locations]
[objectlist]
[polygons
[aldata
[strata]
[stratlist]
[tour]

VIEWS



About parcels

A parcel is a structured collection of Scan/US information loaded into the clipboard or otherwise exported.
Various Scan/US commands, menu and command interface (Cl), create parcels in the clipboard to help
you export data to other applications or to move data between parts of Scan/US itself. Parcels may be
loaded into the clipboard from other applications as well as imported into Scan/US. Some parcels are
used solely to format SEND command output.

A parcel consists of one or more data packets, each identified by a keyword enclosed in square []
brackets as the first value of its first record. The parcel itself is identified by the keyword of the first
packet it contains. The parcel's data packets are mostly formatted as ASCII text in a clipboard global
block of type CF_TEXT ("Text"). Besides its own text content, a parcel may imply additional data being
simultaneously loaded into the clipboard in formats other than CF_TEXT, such as bitmaps, metafiles or
internal Scan/US data.

Data parcels exchanged between Scan/US and other applications via DDE links are formatted either as
CF_TEXT block or, if the other application supports it, as an MS Excel Fast Table (XITable) block. The
XlTable format is the preferred Scan/US format for DDE data interchange.

When sent to the clipboard, parcels are organized into one or more records separated by the carriage
return/line feed sequence (CRLF). Records are lists of values separated by the tab character [09hex].
The entire parcel is terminated by a zero byte [00nex].



[areas] parcel

Contains the geometric description of one or more area objects, such as ring areas, buffer areas, or the
ring drawn in "group by radius" assignment. Output by Objects--Copy Objects command.

The parcel header indicates the number of areas.
Following the packet header are one or more records needed to describe the type of area.

Ring Areas: Aring areas entry consists of an area description record, followed by one or more records
corresponding to a radius subarea, and optionally followed by one or more records corresponding to a
sector specification.

An area description record contains the following:

Object key

Rings identifier

Latitude of center (xx.xxxxx)

Longitude of center (Xxx.Xxxxx)

Number of radius records that follow
Number of sector record that follow
Metric (m for miles or km for kilometers)
Object caption

A radius record contains:

. Radius (in m or km)
. Subarea weight (x.xxxx)

A sector record contains:

Direction (degrees, xxx)
. Subarea weight (x.xxxx)



[ciobjref] parcel

A single-record parcel that contains the status of seven flags which indicate whether a type of object
selection is available on the current command interface layer. 1 means the object selection is available;
0 not available. Output by SEND.CIOBJREF command only.

Selected Object flag

Object Manager List flag
Objects in Selected Groups flag
Grouped Objects flag

Filtered Obijects flag

Visible Objects flag

All Objects flag



[crossreference] parcel

Contains a table relating objects on a target layer to objects on a source layer. For each target layer
object, the table lists whole or fractional source layer objects corresponding to it. Output by Object--Copy
CrossReference, COPY.CROSSREFERENCE).

The parcel header contains the following information:

Number of target layer objects

Number of cross-reference entries

Target layer caption

Target layer object type

Target layer arealist name

Target layer grouping caption. Indicates 'no groups' if none are present.
Source layer caption

Source layer object type

Source layer arealist name

Following the packet header is a cross-reference entry which contains a record for each target layer
object, followed by a record for each corresponding source layer object.

A record for a target layer object contains:

. Object key
. Group key, or 0 if groups are not present
. Object caption, if available

A record for a corresponding source layer object contains:

> (arrow indicating correspondence)
Object key

Weight (x.xxxx)

Object caption, if available



[data] parcel

Contains a table made up of all items, or an arbitrary selection of items, from a single datalist for selected
objects on a layer. Any number of data tables may be concatenated on output into the clipboard.
Output by Data--Copy Data, QuickLook--Copy to Clipboard button, COPY.DATA, SEND.DATA.

Also provides a format for hot-linking a spreadsheet database into a layer (Data--Paste Link, LINK.DATA).
The parcel header contains the following (on output from Scan/US only):

Number of objects

Table number

Table part number

Number of table parts

Source datalist name: caption
Index of first item in table
Number of items in table
Object type

Source arealist name
Grouping name from which objects were selected. Indicates 'no groups' if all objects are
selected.

This packet header is followed by a record of column headings and by a record for each object in the
table. Each record contains the following:

Object key

Group key

Object caption

Up to 250 consecutive item values

The group key identifies the group to which the object belonged at the time the [data] parcel was created
provided a grouping was selected on the object's layer; otherwise the group key is zero.

If there are more than 250 items in the table datalist, the table is split into consecutive table parts.
Column headings corresponding to data items are in the format of the first row of an Excel database
suitable for linking into Scan/US (i.e. item name terminated by a colon (:) if an optional item caption
follows the name).

On input (linking via the Data--Paste Link command), the group key must be present but is currently
ignored.

On input, any values following the [data] keyword in the packet header are ignored.



[datalists] parcel
Lists the datalists on the current or specified layer. Output by SEND.DATALISTS command only.
The header contains the following information:

. Number of datalists
. Layer handle
. Active window handle

Following the packet header is a record for each datalist on the layer identified by handle. A datalist
record contains the following:

Datalist handle

Datalist name

Datalist caption

Datalist type

Number of items in the datalist.



[distance] parcel

Contains the distance from one or more source objects to one or more target objects on the same layer or
another layer. Output by Objects--Copy Distance, COPY.DISTANCE.

The parcel header contains the following information:

Number of source (‘from') objects

Source layer name (feature caption)

Source arealist name

Source object type

Distance unit of measure (m for miles; km for kilometers)

Following the header is a record for each source (‘from') object which contains the following:

Object key

Latitude of point (xx.xxxxx)
Longitude of point (xx.xxxxx)
Object caption

[to] packet
Following the [distance] packet is a [to] packet which lists the target ('to') objects and their distance from
the source objects

The packet header contains the following:

Number of target ('to') objects

Target layer name (feature caption)

Target arealist name

Target object type

Distance unit of measure (m for miles; km for kilometers)

This packet header is followed by a record for each target ('to') object whose format depends on the
number of source ('from') objects.

For a single source object, the record consists of:

Object key

Object caption

Distance in specified metric
Orientation in degrees

For multiple source objects, the record consists of:
. Object key

. Object caption
. Vector of distance measures to each of the source objects



[frames] parcel
Lists study area view windows. Output by SEND.FRAMES command only.

The header contains the following:

. Number of study areas view windows
. Active window handle

Following the packet header is a record for each study area view window currently open (shown or
hidden). A study area record consists of:

. View window handle

. Study area handle. A study area handle is the window handle of the first view of the study area.
. View window caption.



[grids] parcel

Contains a geometric description of one or more grid feature objects.

The parcel header contains the number of grid objects.
Following the header is a record for each grid object that contains:

Object key

Latitude of grid centroid (xx.xxxxx)
Longitude of grid centroid (xx.xxxxx)
Area of grid (in sq.miles or sq.kms)

Output by Objects--Copy Objects.



[groupdata] parcel

A table containing values of a specified datalist summarized over an object set. Output by
SEND.GROUPDATA command only.

The parcel header contains the following:

. Number of dataitems
. Datalist name or handle
. Object set selection code

Selection codes are:

2 Obijects selected in the Object Manager
3 Objects in selected groups

4 Grouped objects

5 Filtered objects

6 Visible objects

7 All objects.

This packet header is followed by 3 columns: the first and second columns contain the dataitem name
and caption respectively, and the third column contains corresponding values summarized over the set of
selected objects.

The first four values in the third column contain the following (corresponding positions in first and second
column are empty):

Number of objects in the set

Caption representing the selection mode
Source arealist name

Object type

These are followed by a column of the summarized values of the datalist, with corresponding item name
and caption placed in the first two columns.



[groupings] parcel
Lists groupings on the current or specified layer. Output by SEND.GROUPINGS command only.
The parcel header contains the following:

. Number of groupings
. Layer handle
. Handle of grouping selected into the layer or 0

This packet header is followed by one record for each grouping on the layer identified by handle. A
grouping record consists of:

. Grouping handle
. Grouping caption
. Number of groups in the grouping



[grouplist] parcel

Lists objects and their group assignment. Output by Groups--Copy Groups, Groups--Paste Groups,
COPY.GROUPLIST, PASTE.GROUPS.

Also provides a format for hot-linking grouping information in a spreadsheet into a layer (Groups--Paste
Link, LINK.GROUPS).

The parcel header contains the following:

Number of objects

Layer name (feature) caption
Source arealist name

Object type

Grouping caption

This packet header is followed by as many object group assignment records as there are objects on the
layer. An object group assignment record consists of an object key followed by the group key and possibly
other identifying names depending on object type. Object records are ordered on object key.

A [grouping] packet may optionally follow the [grouplist] records.

[grouping] packet
Contains a table of different groups.

The packet header contains the following:

Number of groups

Layer name (feature caption)
Source arealist name

Object type

Grouping caption

Following the packet header is a record for each group that consists of:

. Group key
. Number of objects in the group
. Group caption.

On input (linking via the Groups Paste Link command), any values following the [grouplist] keyword in the
packet header are ignored.



[groups] parcel
Lists groups in a specified grouping. Output by SEND.GROUPS command only.
The packet header contains the following:

. Number of groups
. Grouping handle
. Index of current group

This packet header is followed by one record for each group in the grouping identified by handle. A group
record consists of:

. Group index
. Group caption
. Number of objects in the group



[groupset] parcel

Lists objects by group, each group forming a [group] packet. Output by Groups--Copy Groups, Groups--
Paste Groups.

The parcel header contains the grouping caption and the number of [group] packets that follow.
The parcel header is followed by the indicated number of [group] packets.

[group] packet

The packet header contains the following:

. Group key
. Number of objects
. Group caption

Following the packet header is an object name record for each object in the group. An object name
record consists of an object key with additional identifying names depending on object type. Object name
records are ordered on object key.



[layers] parcel
Lists feature layers in the current or specified study area. Output by SEND.LAYERS command only.
The parcel header contains the following:

Number of layers
View window handle
Study area handle
Active layer handle

This packet header is followed by one record for each layer in the study area identified by handle. A layer
record consists of:

Layer handle

Layer caption

Number of objects on the layer
Number of datalists on the layer



[lines] parcel

Contains the geometric description of one or more line feature objects. Output by Objects--Copy
Objects.

The packet header contains the number of line objects.

Following the packet header is the indicated number of line object records. Each record containing the
following:

. Line name
. Number of coordinate points describing the line
. Indicated number of latitude/longitude points.

If multiple names are supplied for a line object, they are concatenated using slash [/] symbols. A line
object represents either a single line segment or multiple consecutive line segments: line segments may
be identified by including <segment_id> in front of any point which is the first point of a segment. Internal
segment _ids are generated for unlabelled segments.



[locations] parcel

Contains the geometric description of one or more point feature objects. Output by Objects--Copy
Objects.

The packet header contains the number of point objects.
This packet header is followed by the indicated number of point object records, each containing:

Object key

Latitude of point (xx.xxxxx)
Longitude of point (xx.xxxxx)
Object caption



[objectlist] parcel
Lists objects on a layer. Output by Objects--Copy List, COPY.OBJECTLIST.
The packet header contains the following:

Number of objects

Layer name (feature caption)
Source arealist name

Object type

Following the header is an object name record for each object on the layer. An object name record
consists of an object key with additional identifying names depending on object type. Object name
records are ordered on object key.



[polygons] parcel

Contains a geometric description of one or more polygon feature objects (output by Objects--Copy
Objects), or the polygon drawn in "group by polygon" assignment.

The parcel header indicates the number of polygons.

Following the header is an entry for each polygon. Polygon objects may be made up of one or more part
polygons (holes and islands).

A header describes the polygon as a whole and contains the following:

Object key

Number of polygon part entries that follow
Object caption

Area of total polygon (in sg.miles or sq.kms)
Metric (m for miles; km for kilometers)
Latitude of centroid (xx.xxxxx)

Longitude of centroid (xxx.xxxxx)

Each polygon part is preceded by its header record that contains the following:

. < part ID > (the ID is negative for holes)
. Number of vertex coordinates to the part
. Area of part polygon (in sq.miles or sq.kms)

Following the header are the vertex coordinates, formatted five latitude-longitude pairs per record.



[qldata] parcel

A data table made up of all items corresponding to the current contents of the "QuickLook" window.
Output by QuickLook--Copy to Clipboard button, SEND.QLDATA.

The parcel header contains the following:

Number of columns (=3 or =4)

Number of data items

Source datalist name: caption

"all" or "selected" (keywords to indicate inclusion of all or selected items)

The next four records contain the following in the third column:

0 (zero) if object record or count of group members if group record
Object or group combined key-caption

Source arealist name

Object type

These records are followed by 3 or 4 columns corresponding to the contents of the "QuickLook" window.
The first and second columns contain the data item name and caption. The third and fourth columns
contain item values for the "QuickLook" base and benchmark records respectively. If only base data are
shown, the fourth column is omitted.



[strata] parcel

Lists objects by variable stratum. Each set of stratum objects forms a [stratum] packet. Output by
(Views--Copy Variable, Groups--Paste Groups, COPY.STRATA).

The parcel header indicates the following:

Number of [stratum] packets that follow
Layer name (feature caption)

Source arealist name

Object type

Variable name/caption

Source datalist name

This packet header is followed by the indicated number of [stratum] packets.
[stratum] packet
The packet header contains the following:

. Stratum number
. Number of objects
Stratum range

Following the packet header is an object stratum assignment record for each object in the stratum. Each
record consists of an object key followed by the stratum code and the variable value. Object records are
ordered on object key.



[stratlist] parcel

Lists objects and their stratum assignments. May optionally include a [stratatable] packet and
[varstatistics] packet. Output by Map--Copy Variable, Groups--Paste Groups, COPY.STRATLIST,
PASTE.GROUPS.

The parcel header contains the following:

Number of objects

Layer name (feature caption)
Source arealist name

Object type

Variable name/caption
Source datalist name

Following the header is an object stratum assignment record for each object on the layer. Each record
consists of an object key, followed by the stratum code and the variable value. Object records are
ordered on object key.

[stratatable] and [varstatistics] packets may optionally follow this packet.
[stratatable] packet
The packet header contains the following:

Number of strata

Layer name (feature caption)

Source arealist name

Object type

Variable name/caption

Source datalist name

Following the header is a stratum description record for each stratum. Each record consists of the
stratum code, count of objects in the stratum, and the range of variable values in the stratum.

[varstatistics] packet
The packet header contains the following:

Number of records that follow
Layer name (feature caption)
Source arealist name

Object type

Variable name/caption
Source datalist name

Following the packet header are the indicated number of records. Each record consists of a caption
followed by a value.



[tour] parcel
Lists of consecutive segments (i.e. legs) of a tour. Output by Map--Copy Tour, COPY.TOUR.
The parcel header indicates of the number of segments that follow

This packet header is followed by a record of column headings and by as many segment data records as
there are consecutive segments in a tour. Each record of segment data includes:

Segment number

Latitude from (xx.xxxxx)

Longitude from (xxx.Xxxxx)

Latitude to (xx.xxxxx)

Longitude to (xxx.xxxxx)

Length (in miles or km)

Metric (m for miles; km for kilometers)

Direction (degrees, xxx.x)

Cumulative length from start of tour

Horizontal displacement (in m or km) from first point
Vertical displacement (in m or km) from first point



[views] parcel
Lists views of study area. Output by SEND.VIEWS command only.
The parcel header indicates the number of views in a study area and the active window handle.

The header is followed by one record for each view window in a specific study area. A view window record
consists of its window handle and the window caption.
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1-Unit, Detached

Is a 1-unit structure that is detached from any other house.



1-Unit, Attached

Is a 1-unit structure that has one or more walls extending from the ground to the roof separating it from
adjoining structures.



2 or More Units

Are structures containing 2 or more housing units.



Age

The age classification is based on the age of the person as of April 1, 1990.



Aggregate Income

Is defined as the total money income, expressed as millions of dollars, for all persons in an area
regardless of household status.



American Indian, Eskimo or Aleut

Includes persons who classified themselves as such in one of the following race categories: American

Indian, American Indian Tribe (Iroquois, Sioux, Colorado River, Flathead), Eskimo (Arctic Slope, Inupiat
and Yupik), or Aleut (Alutiiq, Egegik and Pribilovian).



Ancestry

The data on ancestry represent self-classification by people according to the ancestry group(s) with which
they most closely identify. Ancestry refers to a person's ethnic origin, descent, "roots", heritage, or the
place of birth of the person or the person's parent or ancestors before their arrival in the United States.



Asian

Includes Chinese, Filipino, Japanese, Asian Indian, Korean, Viethamese, Cambodian, Hmong, Laotian,
Tai, Other Asian.



Average Family Size

Is calculated by dividing the number of persons in families by the number of families. Any person in a
household who is related to the householder is considered a member of the family.



Average Household Income

The average or mean income is obtained by dividing total household income by the total number of
households. Because the average is influenced strongly by extreme values in the distribution, it is
especially susceptible to the effects of sampling variability.



Average Household Size

Is calculated by dividing the number of persons in households by the number of households.



Black

Includes persons who indicated their race as "black or Negro" or reported entries such as African
American, Afro-American, Black Puerto Rican, Jamaican, Nigerian, West Indian, or Haitian.



Blue Collar

Blue collar occupations include private household service workers, those in protective and other services,
in farming, forestry, fishing, precision production, craft, and repair occupation -- together with machine
operators, assemblers, and inspectors: transportation and materials moving workers; and helpers,
handlers, and laborers.



Business By Major Industry

This table corresponds to the first nine Standard Industrial Classification (SIC) Major Industry Divisions as
developed by the Statistical Policy Division of the Office of Management and Budget. The nine major
industry classifications are: (1) agriculture, forestry and fishing; (2) mining; (3) construction; (4)
manufacturing; (5) transportation, communication, electric, gas, and sanitary services; (6) wholesale
trade; (7) retail trade; (8) financial, insurance, and real estate; (9) services.




Business classification
Business classifications are based on the Standard Industry Classification (SIC) and were developed to
show the patterns of land and space use by businesses. To create the classifications, establishments
were grouped based on their size (number of employees) and 4-digit SIC codes.




Child

Is a son or daughter by birth, a stepchild, or adopted child of the householder, regardless of the child's
age or marital status. The category excludes sons-in-law, daughters-in-law, and foster children.



Class of Worker

Refers to the same job as a respondent's industry and occupation, and categorizes persons according to
the type of ownership of the employing organization. The class of workers are defined as:

Private Wage and Salary Includes all persons who worked for wages, salary, tips and commissions for
an employer (profit or not) plus all self-employed persons in incorporated businesses.

Government Workers Includes persons who were employees of any local, state, or federal
governmental unit.

Self-Employed Workers Includes persons who worked for profit in their own unincorporated business,
profession, or trade, or who operated a farm.

Public Administration Under industry, is limited to regular government functions such as legislative,
judicial, administrative, and regulatory activities of governments. Other government organizations such
as schools, hospitals, liquor stores, and bus lines are classified by industry according to the activity in
which they are engaged.



Consumer Spending Potential

A Scan/US data product that estimates the annual expenditure per household for groceries,

entertainment, restaurants, clothing, personal care, etc. See also '93 Consumer Spending Potential
Data



Contract Rent

Is the monthly amount, regardless of utilities, furnishings or fees, meals, or services that may be included.
For vacant units, it is the monthly rent asked for the rental unit at the time of the enumeration.



Durable Goods
Is a retail classification encompassing the following kind-of-business classifications:

Building materials and mobile home dealers.

Automotive dealers except for gas stations.

Furniture, home furnishing, and equipment stores.

Miscellaneous stores dealing in such durable goods as books, jewelry, sporting goods,
photographic equipment, and luggage.



Educational Attainment

Data are tabulated as attainment for persons 25 years old or over. Persons are classified according to
the highest level of school completed or the highest degree received.



Employed

All persons 16 years old and over who were either (1) "at work" -- those who did any work at all during the
reference week as paid employees (2) were "with a job but not at work" -- those who did not work during
the reference week but had jobs or businesses from which they were temporarily absent.



Employment

Employment is derived from the ZIP-level County Business Patterns (CBP/ZIP) file. The CBP/ZIP file
reports data on approximately 75% of all employed persons and virtually 100% of all employees on
private non-agricultural payrolls. Scan/US' estimates of employment agree substantially -- on all levels of
reported geography -- with those issued by the U.S. Department of Labor, Bureau of Labor Statistics in its
publication "Employment and Earnings."



Employment Status

The employment status data shown in this tabulation relate to persons 16 years old and over.



Establishments

The individual physical locations where business is conducted or where services or industrial operations
are performed.



Examples of Noninstitutional Group Quarters

Rooming Houses, Group Homes, Religious Group Quarters, College Quarters Off Campus, College
Dormitories, Military Quarters, Agricultural Workers' Dormitories, Other Workers' Dormitories, Emergency
Shelters for Homeless Persons (with sleeping facilities) and Visible in Street Locations, Dormitories for
Nurses and Interns in General and Military Hospitals, Crew of Maritime Vessels, Staff Residents of
Institutions, Other Non Household Living Situations, Living Quarters of Victims of Natural Disasters.



Family Household

A family consists of a householder and one or more other persons living in the same household who are
related to the householder by birth, marriage or adoption. Families are also cross tabulated by type of
family by race and Hispanic origin.




Family Income

Is the sum of money income of all family members 15 years old and over.



Family Type

Families are classified by type as either a "married-couple” family or "other family" according to the sex of
the householder and the presence of relatives.



Floor Space

Floor space is the estimated number of square feet of building space per business classification. Floor
space excludes landscaped grounds, access roads, railroad spurs, parking spaces, vacant space, or
common areas in shared structures.




GAF Stores

GAF stores are those which specialize in the type of merchandise normally sold in department stores.
Included are:

General merchandise stores

Apparel and accessory stores

Furniture, home furnishings, and equipment stores
Miscellaneous specialty shopping goods stores



Group Quarters

All persons not living in households are classified by the Census Bureau as living in group quarters.
Group quarters are further classified as either institutional or noninstitutional and by age of persons in the
group quarter (under 18 years old and over 65 years old).



Group Quarters: Noninstitutional

Includes all persons who live in group quarters other than institutions. Persons who live in the following
living quarters are classified as "other persons in group quarters" when there are 10 or more unrelated
persons living in the unit; otherwise, these living quarters are classified as housing units: rooming
houses, group homes, dormitories for nurses and interns in general and military hospitals, crews of
maritime vessels, staff residents of institutions, other non-household living situations, living quarters for
victims of natural disasters.



Group Quarters: Types Of Institutions

Correctional institutions:
prisons, federal detention centers, military stockades, jails, local jails and other confinement facilities,
police lockups, halfway houses, other types of correctional institutions;
Nursing homes
Mental (psychiatric) hospitals
Hospitals for chronically ill
Schools, hospitals, or wards for the mentally retarded
Schools, hospitals, or wards for the physically handicapped
Hospitals and wards for drug/alcohol abuse
Wards in general and military hospitals for patients who have no usual home elsewhere
Juvenile institutions
Detention centers



Hispanic Origin

Persons who classified themselves in one of the specific Hispanic origin categories listed on the
questionnaire -- "Mexican," "Puerto Rican"™ or "Cuban" -- as well as those who indicated that they were of
other Spanish/Hispanic origin which includes those whose origins are from Spain, the Spanish-speaking
countries of Central or South America or the Dominican Republic, or they are persons of Hispanic origin
identifying themselves generally as Spanish, Spanish American, Hispanic, Hispano, Latino, and so on.

Origin can be viewed as the ancestry, nationality group, lineage, or country of birth of the person or the
person's parents or ancestors before their arrival in the United States. Hispanic origin refers to origin not
race. Persons of Hispanic origin may be of any race.



Household

A household includes all the persons who occupy a housing unit. See also Family Household and
Nonfamily household




Household Income

Includes the income of the householder and all other persons over 15 years of age, whether they are
related to the householder or not.



Household Language

Households where one or more persons (age 5+ years) speak a language other than English, the
household language assigned to all household members is the non-English language spoken by the first
person with a non-English language. As a result, persons who speak only English may have a non-
English household language assigned to them in tabulations of persons by household language.



Household Type

Household type is classified by the presence of relatives and the number of persons living in a housing
unit. Family households include married couples and other families-- female householder with no spouse
present, male householder with no spouse present, etc.



Householder

In most cases, this is the person, or one of the persons, in whose name the home is owned, being bought
or rented. If there is no such person in the household, any adult household member 15 years old and
over could be designated as the householder.



Housing Units

Housing units may be vacant or occupied, seasonally or year round. Includes houses, mobile homes or
trailers, apartments, a group of rooms or a single room occupied as separate living quarters or, if vacant,
intended for occupancy as separate living quarters.



Housing Units: For Seasonal, Recreational, or Occasional Use

These are vacant units used or intended for use only in certain seasons or for weekend or other
occasional use throughout the year. Seasonal units include those used for summer or winter sports or
recreation, such as beach cottages and hunting cabins. Seasonal units also may include quarters for
such workers as herders and loggers. Interval ownership units, sometimes called shared-ownership or
time-sharing condominiums, also included here.



Housing Value

Is the owner's estimate of the value of the property if it were for sale. Not included are mobile homes,
one-family houses on more than 10 acres of land, houses with a business or medical office.



Income

Is the total money income for the calendar year 1989 from all persons 15 years old and over. Money
income is the sum of wages and salary income, self-employment income, interest and dividends,
retirement or disability income, social security income, public assistance and other types of income
including child support, alimony and unemployment compensation.



Industry

Describes the type of business that is conducted by a person's employer. The 1990 census
classifications were developed from the 1987 edition of the "Standard Industrial Classification (SIC)
Manual," published by the Office of Management and Budget, Executive Office of the President.



Institutionalized Persons

Includes persons under formally authorized, supervised care or custody in institutions at the time of the
enumeration. Such persons are classified as "patients or inmates" of an institution.



Journey To Work

See Means of Transportation to Work, Time Leaving Home to Go to Work, Travel Time to Work.




Labor Force

All employed and unemployed civilians plus members of the U.S. Armed Forces on active duty.



Linguistically Isolated

A household in which no person aged 14 and older speaks English, or speaks it well enough to
communicate with English-speaking groups such as government agencies or most employers.



Male Householder, No Wife Present

A family with male head of householder with no spouse present.



Marital Status

Refers to the status at the time of the enumeration and is tabulated only for those persons 15 years old
and over. All persons were asked whether they were "now married," "widowed," "divorced," "separated,",
or "never married." Couples who live together were allowed to report the marital status they considered

the most appropriate.



Married-Couple Family

A family in which the householder and his or her spouse are enumerated as members of the same
household.



Means of Transportation to Work

Refers to the principle mode of travel the person used to get from home to work. Persons who used
more than one means of transportation were asked to report the one used for the longest distance during
the work trip.



Median Age

This measure divides the age distribution into two equal parts: one-half of the cases falling below the
median value and one-half above the median value.



Median Income

The median represents the middle of the income distribution, dividing the income distribution into two
equal parts, one having incomes above the median and the other having incomes below the median.
Median income is calculated for both household income and family income distributions.




Nonfamily Household

Is a housing unit occupied by a group of unrelated persons or a single person living alone. The group of
unrelated persons can be between 2 and 9 persons. Nonfamily households with 10 or more persons are

considered group quarters, not as a housing unit.



Nonfamily Householder

A householder living alone or with nonrelatives only.



Not In Labor Force

All persons 16 years old and over who are not classified as members of the labor force. The category
consists mainly of students, housewives, retired workers, seasonal workers enumerated in an 'off' season
who were not looking for work, institutionalized persons, and persons doing only incidental unpaid family
work.



Occupation

Describes the type of work that a person performs while on the job. The classifications were developed
to be consistent with the 1980 Standard Occupational Classification (SOC) Manual.

Occupation data are for employees working in the study area, whether or not they are residents within its
boundaries.



Occupation: Unclassified

Unclassified occupations are of workers employed in the establishments that are not classified by SIC
code, usually new businesses that could not be classified in any major industry group due to insufficient
information.



Occupied Housing Unit

A housing unit is classified as occupied if it is the usual place of residence. If all persons staying in the
unit at the time of the census have their usual place of residence elsewhere, the unit is classified as
vacant.



Per Capita Income

Is defined as the average money income per man, woman, and child regardless of age, labor force status,
or group quarters status.



Other Race

Includes all other persons not included in the White, Black, American Indian, Eskimo or Aleut and Asian or
Pacific Islander race categories. See also Hispanic origin



Owner Occupied

A housing unit is owner occupied if the owner or co-owner lives in the unit, even if it is mortgaged or not
fully paid for.



Pacific Islander

Includes persons who indicated their race by classifying themselves into one of the following groups or
identifying themselves as one of the Pacific Islander groups of Polynesian, Micronesian, or Melanesian:
Hawaiian, Samoan, Guamanian, Other Pacific Islander.



Payroll

Is an annual figure that includes all forms of compensation subject to income tax withholding, such as
salaries, wages, commissions, bonuses, vacation allowances, sick leave pay, and the value of payments
in kind (such as free meals and lodging) paid during the year to all employees. When reported to
employers, tips and gratuities are also included.



Period Of Military Service

Veterans are classified according to the most recent wartime period that they served (WW |, WW I,
Korean Conflict, Vietham Era). The period of service categories shown in this tabulation are mutually
exclusive.



Person Per Family

Is calculated by dividing the number of persons in families by the total number of families.



Persons Per Household

A measure obtained by dividing the number of persons in households by the number of households.



Population

Number of residents in an area as of April 1, 1990. For the census update data, the number of residents
is estimated for the current year and projected 5 years based on the monthly P-25 series population

estimate.



Race

The data for race represents self-classification by people according to the race with which they most
closely identify.



Reference Week

Reference week is the calendar week preceding the date on which respondents completed theeir
questionnaires or were interviewed by census enumerators. The week is not the same for all
respondents since the census enumeration was not completed in one week.



Renter Occupied

All occupied housing units that are not owner occupied.



Retail Businesses

The industry classification used for retail business is that of the Office of Management and Budget in its
1987 edition of the "Standard Industrial Classification Manual." Included are the more traditional "over-
the-counter" type retailing that usually takes place in stores and showrooms, together with such semi-
industrial retail categories as lumber yards, plant nurseries, mobile home dealers, gas stations, mail order
houses, fuel and ice dealers, and bottled gas dealers.



Spouse

Includes a person married to and living with a householder, This category includes persons in formal
marriages, as well as persons in common-law marriages.



Stability

Is the percent of the population who have lived in the same housing unit during the period of 1985-1990.
Excluded are persons 5 years of age or younger.



Standard Industrial Classification (SIC) Code

A four-digit numeric code established by the U.S. government in conjunction with U.S. businesses to
designate various industries as defined by their functions and products. The SIC is intended to cover the
entire field of economic activities, namely: agriculture, forestry, fishing, hunting and trapping, mining,
construction, manufacturing, transportation, communication, electric, gas, and sanitary services,
wholesale and retail trade, finance, insurance, and real estate, personal, business, repair, and other
services, and public administration. The SIC codes employed by Scan/US are from the 1987 "Standard
Industrial Classification Manual."

SIC codes are used by direct marketers to segment lists and to target promotions. The government uses
them to report and track business-related census data. The first two digits indicate a major industrial
classification; the second two digits, an industrial subclass. For example, SIC code 2300 represents a
manufacturer of clothing; code 2352, a manufacturer of hats and caps. What the code cannot tell the
direct marketer is whether a business is engaged only in the activity defined by the SIC code, or whether
the code represents a primary business activity. In the latter case, there may be other marketing
opportunities not identified by the SIC code. Note, however, an analysis using Scan/US business
classifications may help uncover these opportunities.



TBA Dealers

Tire, battery and accessory dealers.



Tenure

The classification of all occupied housing units as either renter or occupied. Tenure is also cross
tabulated by age of the householder, race and Hispanic.




Time Leaving Home to Go to Work

The departure time refers to the time of day that the person usually left home to go to work during the
reference week.



Total Employed Population

Total employed population is the male and female civilian employed population. Includes all civilians who
were at work' or with a job but not at work' during the reference week.



Total Workers

Total workers is tabulated differently and not equivalent to the total employed population. Total workers
as the journey-to-work base includes those in the armed forces but excludes those with a job but not at
work' during the reference week.




Travel Time to Work

The total number of minutes that it usually took the person to get from home to work during the reference
week.



Unemployed

All civilians 16 years old and over are classified as unemployed if they (1) were neither "at work" nor "with
a job but not at work" during the reference week, and (2) were looking for work during the last 4 weeks
and (3) were available to accept a job.



Units In Structure

In determining the units in structure, all housing units, both occupied and vacant, are counted. Stores
and office space are excluded. A structure is a separate building that either has open spaces on all sides
or is separated from other structures by dividing walls that extend from the ground to the roof.



Vacancy Status

Vacancy status and other characteristics of vacant units were determined by enumerators obtaining
information from landlords, owners, neighbors, rental agents and others. Vacant units are also classified
as "For Rent," (vacant unit could be offered for rent or for sale), "For Sale Only," "Rented or Sold, Not
Occupied," "For Seasonal, Recreational, or Occasional Use," "For Migrant Workers" and "Other Vacant."



Vacant Housing Units

A housing unit is vacant if no one is living in it at the time of enumeration, unless its occupants are only
temporarily absent.



Vehicles Available

Includes passenger cars, vans, and pickup and panel trucks of one-ton or less kept at home and available
for the use of household members. Vehicles rented or leased for more than one month or more , company

vehicles and police and government vehicles that are kept at home and are used for non-business
purposes.



Vehicles per Household

Is computed by dividing the aggregate vehicles available by the number of occupied housing units.



White

Includes persons who indicated their race as "White" or reported entries such as Canadian, German,
Italian, Lebanese, Near Easterner, Arab, or Polish.



White Collar

White collar occupations include executives, managers, administrators, professionals, technologists and
technicians, sales workers, clerks, and administrative support workers.



Year Householder Moved Into Unit

This data refers to the latest time of occupancy by the householder.



Year Structure Built

Was asked at both occupied and vacant housing units and refers to when the building was first
constructed, not when it was remodeled, added to or converted.
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Areas of Dominant Influence (ADI)

Are media areas defined by the Arbitron Company, usually consisting of one or more whole counties.



Block

Small areas bounded on all sides by visible features such as streets, roads, streams, and railroad tracks,
and by invisible boundaries such as cities, towns, townships, county limits, property lines, and short,
imaginary extensions of streets and roads.

Blocks are numbered uniquely within each census tract or block numbering area. A block is identified by
a three-digit number, sometimes with a single alphabetical suffix. In the example below, '301' is the block
number.

Example: 1011.02 301  See also Block Group



Block Group (BG)

A cluster of blocks having the same first digit of their three-digit identifying numbers within a census tract
or block numbering area (BNA).

For example, BG 3 in census tract 1011.02 includes all the blocks numbered between 301 and 397. BGs
generally contain between 250 and 550 housing units, with the ideal size being 400 housing units.
Geographic BGs never cross census tract or BNA boundaries.



Block Numbering Area (BNA)

Small statistical subdivisions of a county for grouping and numbering blocks in nonmetropolitan counties
where local census statistical area committees have not established census tracts. State agencies and
the Census Bureau delineated BNAs for the 1990 census using guidelines similar to those for the
delineation of census tracts. BNAs do not cross county boundaries.



Census County Division (CCD)

Subdivisions of a county that were delineated by the Census Bureau, in cooperation with state officials
and local census statistical area committees, for statistical purposes. CCDs were established in 21
states where there are no legally established minor civil divisions (MCDs).

CCD boundaries usually follow visible features and, in most cases, coincide with census tracts or block

numbering area boundaries. The name of each CCD is based on a place, county, or well-known local
name that identifies its location. The 21 states where CCDs have been established are as follows:
Alabama, Arizona, California, Colorado, Delaware, Florida, Georgia, Hawaii, Idaho, Kentucky, Montana,
Nevada, New Mexico, Oklahoma, Oregon, South Carolina, Tennessee, Texas, Utah, Washington, and
Wyoming.



Census Designated Place (CDP)

Delineated for the decennial census as the statistical counterparts of incorporated places. CDPs

comprise densely settled concentrations of population that are identifiable by name, but are not legally

incorporated places.

To qualify as a CDP for the 1990 census, an incorporated community must have met the following criteria:
1). In all states except Alaska and Hawaii, the Census Bureau (in cooperation with State agencies

and local census statistical area committees) uses three population size criteria to designate a
CDP. These criteria are:

a. 1,000 or more persons if outside the boundaries of an urbanized area (UA) delineated for the
1980 census or a subsequent special census.

b. 2,500 or more persons if inside the boundaries of a UA delineated for the 1980 census or a
subsequent special census.

c. 250 or more persons if outside the boundaries of a UA delineated for the 1980 census or a
subsequent special census, and within the official boundaries of an American Indian reservation

recognized for the 1990 census.

2). In Alaska, 25 or more persons if outside a UA, and 2,500 or more persons if inside a UA
delineated for the 1980 census or a subsequent special census.

3) In Hawaii, 300 or more persons, regardless of whether the community is inside or outside a UA.

All places in Hawaii are CDPs.



Census Region and Census Division

Census Divisions are groupings of states that are subdivisions of the four Census Regions. There are
nine divisions, which the Census Bureau adopted in 1910 for the presentation of data. The Census
Regions (in bold), Census Divisions (underlined) and their constituent states are as follows:

Northeast
New England Division: Maine, New Hampshire, Vermont, Massachusetts, Rhode Island,
Connecticut

Middle Atlantic Division: New York, New Jersey, Pennsylvania

Midwest Region
East North Central Division: Ohio, Indiana, lllinois, Michigan, Wisconsin

West North Central Division: Minnesota, lowa, Missouri, North Dakota, South Dakota, Nebraska,
Kansas

South Region
South Atlantic Division: Delaware, Maryland, District of Columbia, Virginia, West Virginia, North
Carolina, South Carolina, Georgia, Florida

East South Central Division: Kentucky, Tennessee, Alabama, Mississippi
West South Central Division: Arkansas, Louisiana, Oklahoma, Texas

West Region
Mountain Division: Montana, Idaho, Wyoming, Colorado, New Mexico, Arizona, Utah, Nevada

Pacific Division: Washington, Oregon, California, Alaska, Hawaii



Census Subarea

Statistical subdivisions of boroughs and census areas (county equivalents) in Alaska.



Census Tract (CT)

Small, relatively permanent statistical subdivisions of a county with boundaries not crossing county
boundaries. Census tracts usually have between 2,500 and 8,000 persons and, when first delineated,
were designed to be homogeneous with respect to population characteristics, economic state, and living
conditions. The spatial size of census tracts varies widely depending on the density of settlement.
Census tract boundaries are delineated with the intention of being maintained over a long period of time
so that statistical comparison can be made from census to census.

Census tracts are delineated for all metropolitan areas (MA's) and other densely populated counties by
local census statistical area committees following Census Bureau guidelines. Six States -- California,
Connecticut, Delaware, Hawaii, New Jersey, Rhode Island and the District of Columbia -- are entirely
tracted.

Census tracts are identified with a four-digit number and may have a two-digit suffix; for example 1011.02.
Census tract numbers range from 0001.00 through 9499.99 and are unique within a county (numbers in
the range of 9501-9989.99 denote a block numbering area (BNA).

The suffix .99 identifies a census tract that was populated entirely by persons aboard one or more civilian
or military ships. Suffixes in the range .80 and .98 usually identify census tracts that either were revised
or were created during the 1990 census data collection activities. Some of the revisions may have
resulted in census tracts that have extremely small land area and may have little or no population or
housing. For data analysis, such census tracts can be summarized with an adjacent census tract.




Consolidated Metropolitan Area

See Primary Metropolitan Statistical Area.




County

The primary political division of most states are termed "counties". In Louisiana, these divisions are
known as "parishes."

In four states--Maryland, Missouri, Nevada, and Virginia--there are one or more cities that are
independent of any county organization and thus constitute primary divisions of their States. These cities
are known as "independent cities" and are treated as equivalent to counties for statistical purposes.

Each county and county equivalent is assigned a three-digit Federal Information Processing Standards
(FIPS) code that is unique within a state. These codes are assigned in alphabetical order of county or
county equivalent within states, except for the independent cities, which follow the listing of counties.



County Subdivision

The primary subdivisions of counties and their equivalents for the reporting of the decennial census data.
They include census county divisions, census subareas, minor civil divisions, and unorganized areas.




Designated Market Areas (DMA)

Media areas defined by A.C. Nielsen, usually consisting of one or more whole counties.



Federal Information Processing Standards (FIPS) Code

Codes assigned for a variety of geographic entities, including American Indian and Alaska Native area,
congressional district, county, county subdivision, metropolitan area, place and state.

The structure, format, and meaning of FIPS codes used in the census are shown in the 1990 census
"Geographic Identification Code Scheme" publication. More information about FIPS and FIPS code
documentation is available from the National Technical Information Service, Springfield, VA 22161.



Hierarchical Order of Census Geography
United States (1)
Census Regions (4)
Census Divisions (9)
States (50)
Counties (3,141)
County Subdivisions (35,298)
Places (23,435)
Census tracts/block numbering area (64,000)
Block groups (224,000 with population; total 300,000)
Blocks (4.5 million with population; total 7 million)



Metropolitan Area (MA)

The general concept of a metropolitan area is one of a large population nucleus, together with adjacent
communities that have a high degree of economic and social integration with that nucleus. Some MA's
are defined around two or more nuclei.

MA's are designated by the Federal Office of Management and Budget. Each MA must contain either a
place with a minimum population of 50,000 or a Census Bureau-defined urbanized area and a total MA
population of at least 100,00 (75,000 in New England). An MA comprises one or more central counties
and may also include one or more outlying counties that have close economic and social relationships
with the central county. In New England, MA's are composed of cities and towns rather than whole
counties.

MA's are classified as a metropolitan statistical area (MSA) or as a consolidated metropolitan statistical
area (CMSA) that is then further divided into primary metropolitan statistical areas (PMSAs).




Metropolitan Statistical Area (MSA)

Relatively freestanding metropolitan areas (MA's) and are not closely associated with other MA's. These
areas are typically surrounded by nonmetropolitan counties.




MicroGrid

a geographic feature for small area analysis unique to Scan/US. MicroGrid objects are rectangles in one
minute (of latitude and longitude), 1/2 minute, or 1/4 minute sizes, depending on population density. The
higher the density, the smaller the rectangle used to thematically present the neighborhood
demographics. No population in an area is represented by the absence of objects. In areas where the
population is densest, a MicroGrid is the size of six city blocks.



Minor Civil Division (MCD)

The primary political or administrative division of a county.

The Census Bureau recognizes MCDs in the following 28 States: Arkansas, Connecticut, lllinois, Indiana,
lowa, Kansas, Louisiana, Maine, Maryland, Massachusetts, Michigan, Minnesota, Mississippi, Missouri,

Nebraska, New Hampshire, New Jersey, New York, North Carolina, North Dakota, Ohio, Pennsylvania,
Rhode Island, South Dakota, Vermont, Virginia, West Virginia and Wisconsin.

The District of Columbia has no primary divisions, and the entire area is considered equivalent to an MCD
for statistical purposes.



Parish

County equivalents in the state of Louisiana.



Place

For the purpose of reporting the decennial census data, places include census designated places and
incorporated places. Each place is assigned a four-digit census code that is unique within a state. The
census assigned place codes are assigned based on the alphabetical order within the state.



Primary Metropolitan Statistical Area (PMSA)

If an area that qualifies as a metropolitan area (MA) has more than one million persons, PMSAs may be
defined within it. PMSAs consist of a large urbanized county or cluster of counties that demonstrates
very strong internal economic and social links, in addition to close ties to other portions of the larger area.
When PMSAs are established, the larger areas of which they are component parts is designated a
consolidated metropolitan area (CMSA).

The title of a PMSA may contain up to three place names, provided that the additional places meet
specified levels of population, employment, and commuting, or up to three county names, sequenced in
order of population. Generally, a city with a population of 250,000 or more is in the title, regardless of
other criteria.



State

The primary governmental division of the United States. The District of Columbia is treated as a
statistical equivalent of a state for census purposes.



TCA

A group of one or more contiguous counties whose boundaries do not cross any state or any MSA
boundaries. TCA stands for TIGER County Aggregate. TCAs were designed to sell maps and data in
metro-region sized chunks so that customers can reduce their data costs.



TIGER system

Topologically Integrated Geographic Encoding and Referencing system--a project originally launched by
the Census Bureau to automate the mapping and other geographic activities required to support its
censuses and surveys. TIGER is the most up-to-date map and geographic database for the entire
country (3.6 million square miles). Because TIGER is a digital database, it allows a user to topologically
integrate map features with other data (demographic, economic, etc.) by means of suitable applications
software.



United States

The United States comprises the 50 States and the District of Columbia.



Unorganized Territory

In nine States (Arkansas, lowa, Kansas, Louisiana, Maine, Minnesota, North Carolina, North Dakota, and
South Dakota), some counties contain territory that is not included in a minor civil division recognized by
the Census Bureau. Each separate area of unorganized territory in these States is recognized as one or
more separate county subdivisions for census purposes.




Urban and Rural

The Census Bureau defines "urban” for the 1990 census as compromising all territory, population, and
housing units in urbanized areas and in places of 2,500 or more persons outside urbanized areas.

Territory, population, and housing units not classified as urban constitute "rural". In the 100-percent data
products, rural is divided into "places of less than 2,500" and "not in places".



Urbanized Area (UA)

The Census Bureau delineates urbanized areas (UAs) to provide a better separation of urban and rural
territory, population, and housing in the vicinity of large places. A UA comprises one or more places
("central place") and the adjacent densely settled surrounding territory ("urban fringe") that together have
a minimum of 50,000 people.



ZIP Code

Administrative units established by the United State Postal Service (USPS) for the distribution of mail.
ZIP codes serve addresses for the most efficient delivery of mail, and therefore generally do not respect
political or census statistical area boundaries. ZIP codes usually do not have clearly identifiable
boundaries, often serve a continually changing area, are changed periodically to meet postal
requirements, and do not cover all the land area of the United States. ZIP codes are identified by five-
digit codes assigned by the USPS. The first three digits identify a major city or sectional distribution
center, and the last two digits generally signify a specific post office's delivery area or point.

There are approximately 29,000 ZIP codes covering the population and city delivery areas. The ZIP
code in these files are current as of June 1993.
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Scan/US Regions
A Scan/US region is a group of one or more contiguous states. Regions are used to sell maps and data
in smaller chunks so that customers can reduce their data costs.

Each region is listed below with its code name and member states.

CT, ME, MA, NH, RI, VT
New York

NJ, PA

DC, DE, MD, VA, WV
GA, SC

AL, MS, TN
lllinois

KY, OH

IN, Ml

MN, WI

Texas

OR, WA
California

AR, LA, OK
KS, MO

1A, NE

AZ, NM

AK, HI

North Carolina
Florida

ID, MT, WY
ND, SD

CO, NV, UT
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Scan/US TCAs

A Scan/US TCA is a group of one or more contiguous counties whose boundaries do not cross an state or
any MSA boundaries. TCAs (TIGER County Aggregate) are designed to sell maps and data in metro-
region sized chunks so that customers can reduce their data costs.

Each TCA is listed below with its code name and its member counties sorted alphabetically.

Alabama
50 Cherokee, Colbert, Cullman, DeKalb, Franklin, Jackson, Lauderdale, Lawrence,
Limestone,Madison, Marion, Marshall, Morgan, Winston

51 Blount, Calhoun, Cleburne, Etowah, Fayette, Jefferson, Lamar, St.Clair,
Shelby, Tuscaloosa, Walker

52 Autauga, Bibb, Chambers, Chilton, Clay, Coosa, Dallas, ElImore, Greene, Hale, Lee,
Lowndes, Macon, Montgomery, Perry, Pickens, Randolph, Sumter, Talladega,
Tallapoosa

53 Baldwin, Barbour, Bullock, Butler, Choctaw, Clarke, Coffee, Conecuh, Covington,
Crenshaw, Dale, Escambia, Geneva, Henry, Houston, Marengo, Mobile, Monroe, Pike,
Russell, Washington, Wilcox

Alaska



HO All of Alaska

Arizona
GO Apache, Gila, Navajo

G1 Coconino, Mohave, Yavapai
G2 Maricopa, Pinal
G3 Cochise, Graham, Greenlee, La Paz, Pima, Santa Cruz,Yuma

Arkansas
DO Clay, Craighead , Crittenden, Cross, Fulton, Greene, Independence, Izard, Jackson,
Lawrence, Mississippi, Poinsett, Randolph, St. Francis, Sharp

D1 Baxter, Benton, Boone, Carroll, Crawford, Franklin, Johnson, Logan, Madison, Marion,
Montgomery, Newton, Polk, Pope, Scott, Searcy, Sebastian, Stone, Washington, Yell

D2 Arkansas, Cleburne, Conway, Faulkner, Garland, Grant, Hot Spring, Jefferson, Lee,
Lonoke, Monroe, Perry, Pike, Prairie, Pulaski, Saline, Van Buren, White, Woodruff

D3 Ashley, Bradley, Calhoun, Chicot, Clark, Cleveland, Columbia, Dallas, Desha, Drew,
Hempstead, Howard, Lafayette, Lincoln, Little River, Miller, Nevada, Ouachita, Phillips,
Sevier, Union

California
CO Del Norte, Humboldt , Lassen, Modoc, Plumas, Shasta, Sierra, Siskiyou, Tehama,
Trinity
C1 Butte, Colusa, Glenn, Lake, Mendocino, Napa, Solano, Sonoma, Yolo
C2 Alameda, Contra Costa, Marin, San Francisco, San Mateo
C3 Monterey, San Benito, Santa Clara, Santa Cruz
C4 Kern, Kings, Tulare
C5 Alpine, Inyo, Mono, San Bernardino, San Luis Obispo, Santa Barbara, Ventura
C7 Imperial, Riverside
C8 Los Angeles
C9 Orange, San Diego
CA Amador, Calaveras, El Dorado, Nevada, Placer, Sacramento, Sutter, Tuolumne, Yuba
CB Fresno, Madera, Mariposa, Merced, San Joaquin, Stanislaus

Colorado
MO Archuleta, Chaffee, Delta, Dolores, Eagle, Garfield, Gunnison, Hinsdale, Jackson,
Lake, La Plata, Mesa, Mineral, Moffat, Montezuma, Montrose, Ouray, Pitkin, Rio
Blanco, Routt, San Juan, San Miguel, Summit

M1 Adams, Arapahoe, Boulder, Clear Creek, Denver, Douglas, Elbert, Gilpin, Grand,
Jefferson, Larimer, Park, Weld

M2 Baca, Bent, Cheyenne, Crowley, Kiowa, Kit Carson, Las Animas, Lincoln, Logan,
Morgan, Otero, Phillips, Prowers, Sedgwick, Washington, Yuma

M3 Alamosa, Conejos, Costilla, Custer, El Paso, Fremont, Huerfano, Pueblo, Rio Grande,
Saguache, Teller

Connecticut
00 All of Connecticut

Delaware
30 All of Delaware

District of Columbia
31 All of Washington, D.C.

Florida



JO

J1

J2
J3
J4
J5
J6

Bay, Calhoun, Dixie, Escambia, Franklin, Gadsden, Gilchrist, Gulf, Hamilton, Holmes,
Jackson, Jefferson, Lafayette, Leon, Liberty, Madison, Okaloosa, Santa Rosa,
Suwannee, Taylor, Wakulla, Walton, Washington

Alachua, Baker, Bradford, Citrus, Clay, Columbia, Duval, Flagler, Levy, Marion, Nassau,
Putnam, St. Johns, Sumter, Union

Lake, Orange, Osceola, Polk, Seminole

Charlotte, Hernando, Hillsborough, Manatee, Pasco, Pinellas, Sarasota

Collier, De Soto, Glades, Hardee, Hendry, Highlands, Lee, Monroe, Okeechobee
Broward, Dade, Palm Beach

Brevard, Indian River, Martin, St. Lucie, Volusia

Georgia

40

41

42

43

Hawaii
H1

Idaho
KO

K1
K2
Illinois
60
61

62

63

Banks , Burke, Catoosa, Chattooga, Columbia, Dade, Dawson, Elbert, Fannin, Floyd,
Franklin, Gilmer, Glascock, Gordon, Greene, Habersham, Hall, Hancock, Hart,
Jefferson, Lincoln, Lumpkin, Mcduffie, Murray, Oglethorpe, Pickens, Rabun, Richmond,
Stephens, Taliaferro, Towns, Union, Walker, Warren, Washington, White, Whitfield,
Wilkes

Barrow, Bartow, Butts, Carroll, Cherokee, Clarke, Clayton, Cobb, Coweta, De Kalb,
Douglas, Fayette, Forsyth, Fulton, Gwinnett, Haralson, Heard, Henry, Jackson, Jasper,
Madison, Morgan, Newton, Oconee, Paulding, Polk, Putnam, Rockdale, Spalding,
Walton

Baker, Baldwin, Bibb, Bleckley, Brooks, Calhoun, Chattahoochee, Clay, Colquitt, Cook,
Crawford, Crisp, Decatur, Dooly, Dougherty, Early, Grady, Harris, Houston, Jones,
Lamar, Lee, Macon, Marion, Meriwether, Miller, Mitchell, Monroe, Muscogee, Peach,
Pike, Pulaski, Quitman, Randolph, Schley Seminole, Stewart, Sumter, Talbot, Taylor,
Terrell, Thomas, Tift, Troup, Turner, Twiggs, Upson, Webster, Wilkinson, Worth

Appling, Atkinson, Bacon, Ben Hill, Berrien, Brantley, Bryan, Bulloch, Camden, Candler,
Charlton, Chatham, Clinch, Coffee, Dodge, Echols, Effingham, Emanuel, Evans, Glynn,
Irwin, Jeff Davis, Jenkins, Johnson, Lanier, Laurens, Liberty, Long, Lowndes, Mcintosh,
Montgomery, Pierce, Screven, Tattnall, Telfair, Toombs, Treutlen, Ware, Wayne,
Wheeler, Wilcox

All of Hawaii

Adams, Benewah, Bonner, Boundary, Butte, Clark, Clearwater, Custer, Fremont, Idaho,
Jefferson, Kootenai, Latah, Lemhi, Lewis, Madison, Nez Perce, Shoshone, Teton,
Valley, Washington

Ada, Blaine, Boise, Camas, Canyon, Cassia, Elmore, Gem, Gooding, Jerome, Lincoln,
Minidoka, Owyhee, Payette, Twin Falls

Bannock, Bear Lake, Bingham, Bonneville, Caribou, Franklin, Oneida, Power

Cook, Du Page, Lake, Mchenry

Boone, Carroll, De Kalb, Ford, Grundy, Iroquois, Jo Daviess, Kane, Kankakee, Kendall,
La Salle, Lee, Livingston, Ogle, Stephenson, Vermilion, Whiteside, Will, Winnebago

Adams, Brown, Bureau, Cass, Fulton, Greene, Hancock, Henderson, Henry, Knox,
Logan, Mcdonough, Macoupin, Marshall, Mason, Mercer, Morgan, Peoria, Pike,
Putnam, Rock Island, Schuyler, Scott, Stark, Tazewell, Warren, Woodford

Bond, Champaign, Christian, Clark, Clay, Coles, Crawford, Cumberland, De Witt,
Douglas, Edgar, Effingham, Fayette, Jasper, Mclean, Macon, Marion, Menard,
Montgomery, Moultrie, Piatt, Richland, Sangamon, Shelby



64

Indiana

80

81

82

83

lowa
FO

F1

F2

Kansas

EO

E1

E2

E3

Alexander, Calhoun, Clinton, Edwards, Franklin, Gallatin, Hamilton, Hardin, Jackson,
Jefferson, Jersey, Johnson, Lawrence, Madison, Massac, Monroe, Perry, Pope,
Pulaski, Randolph, St. Clair, Saline, Union, Wabash, Washington, Wayne, White,
Williamson

Adams, Allen, Blackford, De Kalb, Elkhart, Grant, Huntington, Jay, Kosciusko,
Lagrange, Noble, Steuben, Wabash, Wells, Whitley

Benton, Carroll, Cass, Fulton, Jasper, Lake, La Porte, Marshall, Miami, Newton, Porter,
Pulaski, St. Joseph, Starke, White

Boone, Clay, Clinton, Delaware, Fountain, Hamilton, Hancock, Hendricks, Henry,
Howard, Johnson, Madison, Marion, Montgomery, Morgan, Parke, Putnam, Randolph,
Rush, Shelby, Tippecanoe, Tipton, Vermillion, Vigo, Warren, Wayne

Bartholomew, Brown, Clark, Crawford, Daviess, Dearborn, Decatur, Dubois, Fayette,
Floyd, Franklin, Gibson, Greene, Harrison, Jackson, Jefferson, Jennings, Knox,
Lawrence, Martin, Monroe, Ohio, Orange, Owen, Perry, Pike, Posey, Ripley, Scott,
Spencer, Sullivan, Switzerland, Union, Vanderburgh, Warrick, Washington

Allamakee, Benton, Black Hawk, Bremer, Buchanan, Cedar, Chickasaw, Clayton,
Clinton, Davis, Delaware, Des Moines, Dubuque, Fayette, Henry, Howard, lowa,
Jackson, Jefferson, Johnson, Jones, Keokuk, Lee, Linn, Louisa, Muscatine, Scott, Van
Buren, Washington, Winneshiek

Appanoose, Boone, Butler, Cerro Gordo, Clarke, Dallas, Decatur, Floyd, Franklin,
Grundy, Hamilton, Hancock, Hardin, Jasper, Lucas, Mahaska, Marion, Marshall,
Mitchell, Monroe, Polk, Poweshiek, Story, Tama, Wapello, Warren, Wayne, Winnebago,
Worth, Wright

Adair, Adams, Audubon, Buena Vista, Calhoun, Carroll, Cass, Cherokee, Clay,
Crawford, Dickinson, Emmet, Fremont, Greene, Guthrie, Harrison, Humboldt, Ida,
Kossuth, Lyon, Madison, Mills, Monona, Montgomery, O'Brien, Osceola, Page, Palo
Alto, Plymouth, Pocahontas, Pottawattamie, Ringgold, Sac, Shelby, Sioux, Taylor,
Union, Webster, Woodbury

Cheyenne, Cloud, Decatur, Ellis, Ellsworth, Gove, Graham, Greeley, Jewell, Lane,
Lincoln, Logan, Mitchell, Ness, Norton, Osborne, Ottawa, Phillips, Rawlins, Republic,
Rooks, Russell, Saline, Scott, Sheridan, Sherman, Smith, Thomas, Trego, Wallace,
Wichita

Barber, Barton, Clark, Comanche, Edwards, Finney, Ford, Grant, Gray, Hamilton,
Harper, Haskell, Hodgeman, Kearny, Kingman, Kiowa, Mcpherson, Meade, Morton,
Pawnee, Pratt, Reno, Rice, Rush, Seward, Stafford, Stanton, Stevens

Atchison, Brown, Clay, Dickinson, Doniphan, Douglas, Franklin, Geary, Jackson,
Jefferson, Johnson, Leavenworth, Lyon, Marion, Marshall, Miami, Morris, Nemaha,
Osage, Pottawatomie, Riley, Shawnee, Wabaunsee, Washington, Wyandotte

Allen, Anderson, Bourbon, Butler, Chase, Chautauqua, Cherokee, Coffey, Cowley,
Crawford, Elk, Greenwood, Harvey, Labette, Linn, Montgomery, Neosho, Sedgwick,
Sumner, Wilson, Woodson

Kentucky

70

71

Bath, Bell, Boyd, Bracken, Breathitt, Carter, Clay, Elliott, Estill, Fleming, Floyd,
Greenup, Harlan, Jackson, Johnson, Knott, Knox, Laurel, Lawrence, Lee, Leslie,
Letcher, Lewis, Mccreary, Madison, Magoffin, Martin, Mason, Menifee, Montgomery,
Morgan, Nicholas, Owsley, Perry, Pike, Powell, Pulaski, Robertson, Rockcastle,
Rowan, Whitley, Wolfe

Adair, Anderson, Boone, Bourbon, Boyle, Bullitt, Campbell, Carroll, Casey, Clark,



Clinton, Fayette, Franklin, Gallatin, Garrard, Grant, Harrison, Henry, Jefferson,
Jessamine, Kenton, Lincoln, Marion, Mercer, Nelson, Oldham, Owen, Pendleton,
Russell, Scott, Shelby, Spencer, Taylor, Trimble, Washington, Wayne, Woodford

72 Allen, Ballard, Barren, Breckinridge, Butler, Caldwell, Calloway, Carlisle, Christian,
Crittenden, Cumberland, Daviess, Edmonson, Fulton, Graves, Grayson, Green,
Hancock, Hardin, Hart, Henderson, Hickman, Hopkins, Larue, Livingston, Logan, Lyon,
Mccracken, Mclean, Marshall, Meade, Metcalfe, Monroe, Muhlenberg, Ohio, Simpson,
Todd, Trigg, Union Warren, Webster

Louisiana
D4 Avoyelles, Bienville, Bossier, Caddo, Caldwell, Catahoula, Claiborne, Concordia, De
Soto, East Carroll, Franklin, Grant, Jackson, La Salle, Lincoln, Madison, Morehouse,
Natchitoches, Ouachita, Red River, Richland, Sabine, Tensas, Union, Webster, West
Carroll, Winn

D5 Acadia, Allen, Assumption, Beauregard, Calcasieu, Cameron, East Feliciana,
Evangeline, Iberia, Iberville, Jefferson Davis, Lafayette, Pointe Coupee, Rapides, St.
Landry, St. Martin, St. Mary, Vermilion, Vernon, West Feliciana

D6 Ascension, East Baton Rouge, Jefferson, Lafourche, Livingston, Orleans, Plaquemines,
St. Bernard, St. Charles, St. Helena, St. James, St.John The Baptist, St. Tammany,
Tangipahoa, Terrebonne, Washington, West Baton Rouge

Maine
01 Aroostook, Franklin, Hancock, Oxford, Penobscot, Piscataquis, Somerset, Washington

02 Androscoggin, Cumberland, Kennebec, Knox, Lincoln, Sagadahoc, Waldo, York

Maryland
32 Anne Arundel, Baltimore, Caroline, Carroll, Cecil, Dorchester, Harford, Howard, Kent,
Queen Anne's, Somerset, Talbot, Wicomico, Worcester, Baltimore City

33 Allegany, Calvert, Charles, Frederick, Garrett, Montgomery, Prince George's, St.
Mary's, Washington

Massachusetts
03 Berkshire, Franklin, Hampden, Hampshire, Worcester

04 Essex, Middlesex, Norfolk, Suffolk
05 Barnstable, Bristol, Dukes, Nantucket, Plymouth

Michigan
84 Alcona, Alger, Alpena, Baraga, Cheboygan, Chippewa, Crawford, Delta, Dickinson,
Emmet, Gogebic, Houghton, losco, Iron, Kalkaska, Keweenaw, Luce, Mackinac,
Marquette, Menominee, Missaukee, Montmorency, Ogemaw, Ontonagon, Oscoda,
Otsego, Presque Isle, Roscommon, Schoolcraft

85 Allegan, Antrim, Benzie, Berrien, Cass, Charlevoix, Clare, Grand Traverse, Huron,
Isabella, Kent, Lake, Leelanau, Manistee, Mason, Mecosta, Montcalm, Muskegon,
Newaygo, Oceana, Osceola, Ottawa, Van Buren, Wexford

86 Arenac, Barry, Bay, Branch, Calhoun, Clinton, Eaton, Genesee, Gladwin, Gratiot,
Hillsdale, Ingham, lonia, Jackson, Kalamazoo, Lenawee, Midland, Saginaw, St. Joseph,
Sanilac, Shiawassee, Tuscola, Washtenaw

87 Lapeer, Livingston, Macomb, Monroe, Oakland, St. Clair, Wayne

Minnesota
90 Aitkin, Beltrami, Cass, Clearwater, Cook, Crow Wing, Hubbard, Itasca, Kittson,
Koochiching, Lake, Lake of the Woods, Marshall, Pennington, Red Lake, Roseau, St.
Louis

91 Anoka, Benton, Carlton, Carver, Chisago, Dakota, Hennepin, Isanti, Kanabec,
Kandiyohi, Meeker, Mille Lacs, Morrison, Pine, Ramsey, Scott, Sherburne, Stearns,



Washington, Wright

92 Becker, Big Stone, Clay, Douglas, Grant, Lac Qui Parle, Mahnomen, Norman, Otter
Tail, Polk, Pope, Stevens, Swift, Todd, Traverse, Wadena, Wilkin

93 Blue Earth, Brown, Chippewa, Cottonwood, Dodge, Faribault, Fillmore, Freeborn,
Goodhue, Houston, Jackson, Le Sueur, Lincoln, Lyon, Mcleod, Martin, Mower, Murray,
Nicollet, Nobles, Olmsted, Pipestone, Redwood, Renville, Rice, Rock, Sibley, Steele,
Wabasha, Waseca, Watonwan, Winona, Yellow Medicine

Mississippi

54 Alcorn, Benton, Bolivar, Calhoun, Carroll, Chickasaw, Clay, Coahoma, De Soto,
Grenada, Itawamba, Lafayette, Lee, Leflore, Marshall, Monroe, Montgomery,
Oktibbeha, Panola, Pontotoc, Prentiss, Quitman, Sunflower, Tallahatchie, Tate, Tippah,
Tishomingo, Tunica, Union, Webster, Yalobusha

55 Attala, Choctaw, Claiborne, Clarke, Copiah, Hinds, Holmes, Humphreys, Issaquena,
Jasper, Jefferson, Kemper, Lauderdale, Leake, Lowndes, Madison, Neshoba, Newton,
Noxubee, Rankin, Scott, Sharkey, Simpson, Smith, Warren, Washington, Wayne,
Winston, Yazoo

56 Adams, Amite, Covington, Forrest, Franklin, George, Greene, Hancock, Harrison,
Jackson, Jefferson Davis, Jones, Lamar, Lawrence, Lincoln, Marion, Pearl River, Perry,
Pike, Stone, Walthall, Wilkinson

Missouri
E4 Adair, Andrew, Atchison, Audrain, Boone, Caldwell, Carroll, Chariton, Clark, Clinton,
Daviess, De Kalb, Gentry, Grundy, Harrison, Holt, Howard, Knox, Lewis, Lincoln, Linn,
Livingston, Macon, Marion, Mercer, Monroe, Nodaway, Pike, Putnam, Ralls, Randolph,
Saline, Schuyler, Scotland, Shelby, Sullivan, Worth

E5 Callaway, Cole, Crawford, Franklin, Gasconade, Jefferson, Maries, Miller, Montgomery,
Osage, Perry, Phelps, St. Charles, Ste. Genevieve, St. Francois, St. Louis, Warren,
Washington, St. Louis City

E6 Barton, Bates, Benton, Buchanan, Camden, Cass, Clay, Cooper, Henry, Hickory,
Jackson, Johnson, Laclede, Lafayette, Moniteau, Morgan, Pettis, Platte, Pulaski, Ray,
St. Clair, Vernon

E7 Barry, Cedar, Christian, Dade, Dallas, Dent, Douglas, Greene, Howell, Jasper,
Lawrence, Mcdonald, Madison, Newton, Oregon, Ozark, Polk, Shannon, Stone, Taney,
Texas, Webster, Wright

E8 Bollinger, Butler, Cape Girardeau, Carter, Dunklin, Iron, Mississippi, New Madrid,
Pemiscot, Reynolds, Ripley, Scott, Stoddard, Wayne

Montana
K3 Blaine, Chouteau, Daniels, Dawson, Fergus, Garfield, Hill, Judith Basin, McCone,
Petroleum, Phillips, Prairie, Richland, Roosevelt, Sheridan, Valley, Wibaux

K4 Big Horn, Carbon, Carter, Custer, Fallon, Golden Valley, Musselshell, Powder River,
Rosebud, Stillwater, Sweet Grass, Treasure, Wheatland, Yellowstone

K5 Cascade, Flathead, Glacier, Lake, Lewis and Clark, Liberty, Lincoln, Meagher, Mineral,
Missoula, Pondera, Powell, Sanders, Teton, Toole

K6 Beaverhead, Broadwater, Deer Lodge, Gallatin, Granite, Jefferson, Madison, Park,
Ravalli, Silver Bow, Yellowstone N.P.

Nebraska
F3 Burt, Butler, Cass, Cedar, Colfax, Cuming, Dakota, Dixon, Dodge, Douglas, Fillmore,
Gage, Jefferson, Johnson, Lancaster, Madison, Nemaha, Nuckolls, Otoe, Pawnee,
Pierce, Platte, Polk, Richardson, Saline, Sarpy, Saunders, Seward, Stanton, Thayer,
Thurston, Washington, Wayne, York

F4 Adams, Antelope, Blaine, Boone, Boyd, Brown, Buffalo, Clay, Custer, Dawson, Franklin,



Frontier, Furnas, Garfield, Gosper, Greeley, Hall, Hamilton, Harlan, Holt, Howard,
Kearney, Keya Paha, Knox, Logan, Loup, Merrick, Nance, Phelps, Red Willow, Rock,
Sherman, Thomas, Valley, Webster, Wheeler

F5 Arthur, Banner, Box Butte, Chase, Cherry, Cheyenne, Dawes, Deuel, Dundy, Garden,
Grant, Hayes, Hitchcock, Hooker, Keith, Kimball, Lincoln, Mcpherson, Morrill, Perkins,
Scotts Bluff, Sheridan, Sioux

Nevada
M4 Churchill, Douglas, Esmeralda, Lyon, Mineral, Storey, Washoe, Carson City
M5 Elko, Eureka, Humboldt, Lander, Pershing, White Pine
M6 Clark, Lincoln, Nye

New Hampshire
06 All of New Hampshire

New Jersey
20 Bergen, Essex, Hudson, Hunterdon, Middlesex, Morris, Passaic, Somerset, Sussex,
Union, Warren

21 Atlantic, Burlington, Camden, Cape May, Cumberland, Gloucester, Mercer, Monmouth,
Ocean, Salem

New Mexico
G5 Bernalillo, Colfax, Guadalupe, Los Alamos, Mora, Rio Arriba, Sandoval, San Miguel,
Santa Fe, Taos, Torrance, Valencia

G6 Catron, Cibola, Mckinley, Quay, San Juan, Socorro
G7 Chaves, Curry, De Baca, Eddy, Harding, Lea, Lincoln, Roosevelt, Union
G8 Dona Ana, Grant, Hidalgo, Luna, Otero, Sierra
New York
10 Bronx, Kings, Nassau, New York, Queens, Richmond, Suffolk

11 Chenango, Columbia, Delaware, Dutchess, Orange, Otsego, Putnam, Rockland,
Schoharie, Sullivan, Ulster, Westchester

12 Albany, Clinton, Essex, Franklin, Fulton, Greene, Hamilton, Herkimer, Lewis,
Montgomery, Oneida, Rensselaer, St. Lawrence, Saratoga, Schenectady, Warren,
Washington

13 Allegany, Broome, Cayuga, Chemung, Cortland, Jefferson, Madison, Onondaga,
Oswego, Schuyler, Seneca, Steuben, Tioga, Tompkins, Yates

14 Cattaraugus, Chautauqua, Erie, Genesee, Livingston, Monroe, Niagara, Ontario,
Orleans, Wayne, Wyoming

North Carolina

10 Bladen, Brunswick, Carteret, Columbus, Cumberland, Duplin, Jones, New Hanover,
Onslow, Pender, Robeson, Sampson

11 Beaufort, Bertie, Camden, Chowan, Craven, Currituck, Dare, Edgecombe, Gates,

Greene, Halifax, Harnett, Hertford, Hyde, Johnston, Lenoir, Martin, Nash, Northampton,
Pamlico, Pasquotank, Perquimans, Pitt, Tyrrell, Washington, Wayne, Wilson

12 Alamance, Caswell, Davidson, Davie, Durham, Forsyth, Franklin, Granville, Guilford,
Iredell, Orange, Person, Randolph, Rockingham, Stokes, Vance, Wake, Warren, Yadkin

I3 Alexander, Anson, Burke, Cabarrus, Catawba, Chatham, Gaston, Hoke, Lee, Lincoln,
Mecklenburg, Montgomery, Moore, Richmond, Rowan, Scotland, Stanly, Union

14 Alleghany, Ashe, Avery, Buncombe, Caldwell, Cherokee, Clay, Cleveland, Graham,
Haywood, Henderson, Jackson, Mcdowell, Macon, Madison, Mitchell, Polk, Rutherford,
Surry, Swain, Transylvania, Watauga, Wilkes, Yancey

North Dakota



LO Barnes, Benson, Bottineau, Burke, Cass, Cavalier, Eddy, Foster, Grand Forks, Griggs,
Kidder, Mchenry, Mcintosh, Nelson, Pembina, Pierce, Ramsey, Renville, Richland,
Rolette, Steele, Stutsman, Towner, Traill, Walsh, Ward, Wells

L1 Adams, Billings, Bowman, Burleigh, Dickey, Divide, Dunn, Emmons, Golden Valley,
Grant, Hettinger, La Moure, Logan, Mckenzie, Mclean, Mercer, Morton, Mountrail,
Oliver, Ransom, Sargent, Sheridan, Sioux, Slope, Stark, Williams
Ohio
73 Ashtabula, Carroll, Columbiana, Cuyahoga, Geauga, Holmes, Lake, Lorain, Mahoning,
Medina, Portage, Stark, Summit, Trumbull, Wayne

74 Athens, Belmont, Coshocton, Gallia, Guernsey, Harrison, Hocking, Jackson, Jefferson,
Lawrence, Meigs, Monroe, Morgan, Muskingum, Noble, Perry, Pike, Ross, Scioto,
Tuscarawas, Vinton, Washington

75 Ashland, Champaign, Crawford, Delaware, Fairfield, Fayette, Franklin, Hardin, Knox,
Licking, Logan, Madison, Marion, Morrow, Pickaway, Richland, Union, Wyandot

76 Allen, Auglaize, Darke, Defiance, Erie, Fulton, Hancock, Henry, Huron, Lucas, Mercer,
Ottawa, Paulding, Putnam, Sandusky, Seneca, Shelby, Van Wert, Williams, Wood

77 Adams, Brown, Butler, Clark, Clermont, Clinton, Greene, Hamilton, Highland, Miami,
Montgomery, Preble, Warren

Oklahoma
D7 Adair, Cherokee, Craig, Creek, Delaware, Mcintosh, Mayes, Muskogee, Nowata,
Okfuskee, Okmulgee, Osage, Ottawa, Pawnee, Rogers, Sequoyah, Tulsa, Wagoner,
Washington

D8 Atoka, Bryan, Carter, Choctaw, Coal, Garvin, Haskell, Hughes, Jefferson, Johnston,
Latimer, Le Flore, Love, Mccurtain, Marshall, Murray, Pittsburg, Pontotoc, Pushmataha,
Seminole, Stephens

D9 Alfalfa, Blaine, Caddo, Canadian, Cleveland, Comanche, Cotton, Garfield, Grady,
Grant, Kay, Kingfisher, Lincoln, Logan, Mcclain, Major, Noble, Oklahoma, Payne,
Pottawatomie

DA Beaver, Beckham, Cimarron, Custer, Dewey, Ellis, Greer, Harmon, Harper, Jackson,
Kiowa, Roger Mills, Texas, Tillman, Washita, Woods, Woodward

Oregon
B0 Clackamas, Clatsop, Columbia, Hood River, Lincoln, Marion, Multnomah, Polk,
Tillamook, Washington, Yamhill

B1 Benton, Coos, Curry, Douglas, Jackson, Josephine, Lane, Linn

B2 Baker, Crook, Deschutes, Gilliam, Grant, Jefferson, Morrow, Sherman, Umatilla, Union,
Wallowa, Wasco, Wheeler

B3 Harney, Klamath, Lake, Malheur

Pennsylvania
22 Butler, Clarion, Clearfield, Crawford, Elk, Erie, Forest, J